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Chapter 1 – Course Introduction 

Video: Course Introduction 

Toby: Hello and welcome to our course on Microsoft Project 2016. My name is Toby and I’m 

your instructor on this course. 

If you’ve studied Microsoft Project with Simon Sez IT before you will have used one of the 

courses that I prepared and presented. There’s a batch of four there. Project 2010, there’s a 

beginner and intermediate course and there’s an advanced course, and Project 2013, again a 

beginner and intermediate course and an advanced course. 

My background is in project management. Not only have I been a project management instructor 

for quite a few years but I worked in a major European university in the Center for Project 

Management preparing the first distance learning Master’s degree in Project Management. That 

was a few years ago now. I’ve taught Microsoft Project in classrooms many, many times. And 

my own experience extends to work in both the private and public sectors in the UK. So I’ve 

done a couple of major projects for the UK government as well as a number of projects for 

primarily financial institutions in the UK, a couple of the major banks, and also some projects for 

major retailers. 

I mentioned just now that you may well have studied Microsoft Project with Simon Sez IT 

before. I am going to assume on this course that you have pretty much no knowledge of 

Microsoft Project. This really is a course that is aimed primarily at people who are new to using 

Microsoft Project. If you have used it before you may find that some of the early sections involve 

material that you’re pretty familiar with. But particularly for the first two or three sections I do 

suggest that you go through them because in those I’ll cover some of the main aspects of Project 

2016 that may be different from the version of Project that you’re used to. And I’ll also cover 

things like what’s new in Project 2016. 

If you are completely new to Microsoft Project and I appreciate that many of you will be, I will 

be assuming that you’re familiar with Windows software. So you know how to do things like 

Copy and Paste. To some extent I’ll assume that you may have used the Microsoft Ribbon 

before, although I will explain it just in case you haven’t. And in particular I will assume that 

you have a good basic knowledge of project management itself. So you’ll know what I mean 

when I talk about things like Schedule and Resources and overallocation.  

If you don’t understand some of those basic concepts in project management you probably need 

to cover a bit of basic material on project management in general first before you go through this 

course because the course does very much rely on a reasonable knowledge of what’s involved in 

managing a project. 
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One thing I’m not going to do is to assume that we’re managing projects in a particular field. My 

field has always tended to be IT, one way or another. But in fact the main sample projects that 

I’m going to use on this course don’t really have anything to do with IT at all. We’re going to 

refit a bathroom, or rather you are, and I’m going to organize a wedding. Neither of those have 

anything in particular to do with IT. 

What you can see here is the Project Professional 2016 start screen. You may well never have 

seen this screen before. If you already have Microsoft Project 2016 installed, that is either the 

standard version or the professional version, and the professional version includes Project Pro for 

Office 365, but very importantly a desktop version. We’re not talking about Project Online. 

We’re talking about desktop software here. If you have one of those products installed as a 

desktop product on the device you’re going to use then you can skip the next section because 

what I’m going to cover in the next section is how to acquire Project 2016 if you don’t already 

have it.  

After we cover that in the next section, the section after that I’m going to talk about the structure 

of the course and in particular I’m going to start to talk about the projects that we’re going to 

work through as we’re working through the course. 

So if you already have Project 2016 installed you can skip the next section and go straight to the 

one after that where I’m going to talk about the structure of the course. For those of you who 

don’t have Project 2016 already you need to go through the next section with me and I’ll explain 

to you what the options are. 

That’s it for this section. I’ll see you then. 
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Video: Acquiring Project 2016 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section I want to talk about the versions of Microsoft Project that are available. And for 

those of you who don’t yet have Microsoft Project installed I recommend the version or versions 

that are most appropriate for use on this course. I’ll also talk briefly about acquiring and 

installing Project 2016. 

Now one thing that you’ll hear me say quite a bit on courses about Microsoft products is that I’m 

looking at a page on Microsoft.com here and it’s probably going to be different by the time you 

come to look at it. They change these pages on a very regular basis, which is in itself fine but it 

means that I need you to basically search for the equivalent of this page if you want to get the 

latest information.  

Now what’s important about this page is that it shows us the main project products. And two 

categories of products are really not relevant to this course. I don’t really cover these at all on the 

course. So at the time of recording this course if you look at the category on the left there, 14 

members, there’s a product called Project Light. Now that is not part of this course. It’s to do 

with people submitting time sheets, recording progress on tasks and so on. But it’s a very, as the 

name implies, light version of Microsoft Project. And we’re not going to look at that at all.  

On the right hand side there are two other products, Project Online and Project Server, and we 

don’t cover either of those on this course either. Project Online is, again as the name implies, an 

online version of Microsoft Project. It has at the moment considerably less functionality than the 

desktop products, although I do believe that over time its functionality will increase. And Project 

Server is a server based product that can be used for managing programs of work and for pulling 

together information and for resource management and so on across a whole batch, a whole 

portfolio of projects and programs.  

Now we don’t cover either of those on this course. What we’re covering on this course is desktop 

Microsoft Project. 

Now having said that and if you look at the center column there there appear to be two products. 

There’s Project Pro for Office 365 and Project Standard. Now in effect the top one there is really 

two products. It’s Project Pro for Office 365 and what we generally call Project Professional. 

And the difference is, and believe me it isn’t much of a difference, that Project Pro for Office 

365 is Project Professional which is effectively distributed using Office 365. And in fact on this 

course I’m going to be using Project Pro for Office 365. I have an Office 365 subscription that 

includes Microsoft Project. And with that I download a desktop version of Project Pro. And it’s 

that desktop version of Project Pro that I’m going to be using on the course. 
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There is another Microsoft Project product called Project Standard which is a sort of cut down 

Project Professional. Some people say that Project Professional is the professional version of 

Project Standard. I’m not sure it matters which way around you look at it really. But the 

important thing is this. As a basic to intermediate learner of Microsoft Project either Project 

Standard or Project Professional will do you absolutely fine.  

Now to be fair there are one or two things in Project Professional that aren’t in Project Standard 

that I will just sort of touch on on the course but they’re not enough to mean that you can’t get by 

perfectly well with Project Standard. 

So basically for this course you need Project Standard or Project Professional or Project Pro for 

Office 365 with Microsoft Project downloaded to your desktop. 

And if I had to recommend one of those products I’d recommend the last two because they’re 

pretty much the same, Project Professional and Project Pro for Office 365 and certainly as far as 

this course is concerned those two products are the same. 

Now let me talk briefly about acquiring one of these versions of Project. If I go to the Project Pro 

for Office 365 link first, in the UK you can add it to an Office 365 subscription. As far as I know 

you can add it to an Office 365 subscription anywhere that you can get and use an Office 365 

subscription. There may or may not be tax to pay, etcetera but that price which is equivalent 

including tax to about £20 per user per month in the UK. I think it comes out to about $30 in the 

U.S. including taxes. That’s a typical sort of monthly price for Project Pro for Office 365. Very 

importantly there is a Try for Free button, a Try Now option. It used to be the case with 

Microsoft Project that a free trial was a 60 day free trial. I think that generally at the moment it’s 

a 30 day free trial. But provided you can sort of devote enough time to it hopefully that will be 

enough time for you to work your way through this course to give you a chance to decide 

whether Project is for you and whether you’re prepared to start paying that amount of money. 

Let me go back and let’s now go to Project Standard. This is the purchase option for Project 

Standard. It’s actually quite an expensive product. That’s the Microsoft price. If you buy it from 

your local computer store, if they stock Microsoft Project, or buy from your favorite online 

retailer you may pay a slightly lower price than that but in my recent experience the pricing on 

legitimate copies of Microsoft Project doesn’t really vary that much. And Project Professional of 

course is more expensive than that. And in fact there is Project Professional 2016 on the UK 

store. 

So there are your choices for actually acquiring Microsoft Project. Before you get started on 

installing Microsoft Project, in fact ideally before you actually spend any money on it you do 

need to make sure that the system you’re going to try to run it on is capable of running the 

product. And there are various places on Microsoft.com where you can check the requirements, 

both hardware and software requirements. And for instance, for operating system you need to 

have Windows 7 or later. So that’s 7, 8 or 8.1, or 10. The list of the required operating systems is 
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there. And then you also need to check the hardware requirements as well. One of the things that 

I’m going to talk about a couple of times during the course is the use of touch. And increasingly 

people are using certainly some aspects of Microsoft Project using touch. So if you are planning 

to use it on a touch device you might like to read those multi-touch requirements there. But in 

any case check those requirements, make sure the device you’re planning to run Microsoft 

Project on is up to the job certainly before you spend money. 

And one other very important factor here which many people seem to overlook is the choice of 

either the 32 bit or 64 bit version of Project. There is a compatibility issue in terms of Project and 

all of the components of Office and mixing 32 bit and 64 bit versions is subject to some rules 

that are summarized in this page. Obviously you need to look for the current version of this page. 

And there’s a specific point on this page related to Project. If you’re working with files over 2 

GB in Project then you would need to use the 64 bit version. Now in terms of functionality in 

terms of this course either version is fine. I’m going to be running with the 32 bit version and 

that’s compatible with all of the other components of Office that I have installed. But again 

depending on what you already have installed on your device you may need to bear that in mind 

as well. 

Now in terms of installing Microsoft Project once you’ve acquired it that’s really between you 

and Microsoft. I’m not going to give you installation instructions. But once you have acquired 

the copy that you’re going to use and you’ve installed it you should get to the point where you 

can fire it up, you can start it and you’ll get that start screen that I showed you at the end of the 

previous section and that I’m going to show you again now. 

So there we are. There’s Project 2016 or to be more precise Project Pro for Office 365. I’m ready 

to start. I hope you are as well. Please join me in the next section. 
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Video: Course Review 

Toby: So we’re almost ready to start creating some projects but I’m afraid there’s still a couple 

of things to cover before we really get started. And in this section I’m going to give you an 

overview of the course and point out a couple of important things that you need to bear in mind 

when we’re working through the course, a couple of things that you may need to do before we 

start.  

Now first of all if you are going to use a touch device on this course and I’m basically not going 

to use a touch device. I’m going to use keyboard and mouse, although I will talk about touch 

devices a little as we go along. One of the first things you need to do is to enable Touch Mode in 

Project. Now you can work using a touch device without being in Touch Mode but unless you’ve 

got quite thin fingers you’re going to find it quite difficult. 

Given the Start screen what I’m going to do is sort of leap ahead a bit here and we’re going to 

click on the Blank Project button there, create a blank Project first of all, and then in the top left 

hand corner of the screen there is something called the Quick Access Toolbar. And on the Quick 

Access Toolbar there is a button. If I hover over it it’s called Touch/Mouse Mode. That’s what it 

says. Now if you don’t see that button there, if you move a little to the right there’s a dropdown 

arrow that says Customize Quick Access Toolbar. Click on that, Touch/Mouse Mode will be in 

the list, probably near the bottom like mine. And all you need to do if you can’t see it there will 

be no tick mark there. All we need to do is tick it, click it once and you will see that 

Touch/Mouse Mode button. 

Now once you can see that button there’s a little, tiny little arrow at the right of that and if you 

click on that it gives you a choice of Mouse Mode or Touch Mode. You need to go into Touch 

Mode if you’re going to use a touch device.  

Now as I point out later on I’m not greatly in favor of touch devices with Microsoft Project 

because I think some things are actually pretty difficult with a touch device. But I know that an 

increasing number of people are using touch. If you select Touch Mode what happens is the 

Ribbon, the bar with all those commands on it to the left and right of where I am now, the 

Ribbon, all of those buttons get spaced out much more and you’re going to find it much easier to 

work along with me using a touch device if you’re in Touch Mode. 

So if you need to be in Touch Mode do that straightaway and then you’re going to find 

everything becomes quite a lot easier. 

Now I’m going to go back into Mouse Mode and I’ve actually started a project here, Project 1 

it’s called. Note the name there, Project 1. So I’m going to click on the File button there and then 

I’m going to Close that project by clicking on the Close option. And then I’m back to being 

ready to start work on another project which we’ll come back to just a little bit later on. 
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So having showed you how to change into Touch Mode if you need to let me go back to talking 

about the structure of the course. 

Now I’ve arranged this in a sequence which should suit beginners very well. If you have used 

Microsoft Project before there may be sections that you can skip over but I will try to make it 

clear in each section towards the beginning of the section what we’re going to cover so that you 

can decide if you have used Project before whether you need to cover that particular topic or not. 

Now during the course I’m obviously going to demonstrate a number of tools and techniques and 

primarily I’m going to use a particular project for this. I’m going to arrange a wedding and then 

we’re going to go through the steps, the tasks leading up to the wedding and see the sort of thing 

that happens, the sort of problems that arise, and we’ll be looking at aspects of the wedding like 

costs and resources, the people and other resources that are needed in the wedding.  

I’ll be setting you a number of exercises to do during the course and your exercises are going to 

be based on your project which is to refit a bathroom. I’ll be telling you about both of those 

projects in some of the early sections of the course. 

Now so that you can work through all of the examples that I use on the course there is a course 

files folder and the contents of the folder should be very similar to the list that you can see in 

front of you here. And as you go through each section of the course you should be able to match 

it up to one of those files. You can open it up on your installation of Microsoft Project 2016 and 

work through it with me. 

And for the exercises in the course there’s another folder with my sample answers to those 

exercises as well. As well as some of the information that you’ll need in order to be able to try 

the exercises yourself.  

And for both of those sets of files make sure you know where they are. And I suggest that you 

keep a sort of backup copy as well in case anything goes wrong and you need to be able to start 

from scratch again with any of the files. 

And then a couple of other things to point out. One of them is that I will primarily be using U.S. 

locale for this course. And where costs are involved I will generally use the U.S. dollar as my 

currency. When I talk about cost and currency I will demonstrate one or two of the other options. 

If you’re working along with me or when you’re doing your exercise by all means use your own 

locale and your own local currency. It won’t significantly change any aspect of what you’re 

learning about Project 2016. 

I’m running Project here on Windows 10. But again if there is any point in the course where the 

fact that you’re running it on Windows 7 or Windows 8 or 8.1 makes a difference I will try to 

point that out to you. But I don’t anticipate anything that would actually cause you a problem. 
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I should also point out that I’m recording this widescreen. And because of the fact that it’s 

widescreen and because of the resolution on the screen exactly what you see at any time, not just 

on this start screen, but at any screen in Project 2016 yours may look quite different to mine. 

Everything from what fits on the Ribbon to how wide or how narrow any particular columns, 

how tall any rows are, any of these things can be affected by the size and resolution of the 

screen. But the content in general will be the same. It’s more a question of how much of it you 

can see at any one time.  

And the final thing to point out, just in case you’re wondering, I don’t cover any programming. 

There’s no VBA programming on this particular course. If you’ve looked at our earlier Project 

2010 and Project 2013 advanced courses you’ll see that in those courses we covered some VBA 

programming. 

So that’s it. That’s all you need to know about the course. We’ve got one other very short section 

next on what’s new in Project 2016, particularly aimed at those of you who have used earlier 

versions. If you haven’t used an earlier version it may well be that what’s new in Project 2016 

won’t mean much to you. But it’s a pretty short section so why don’t you watch it anyway. I’ll 

see then. 
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Video: What’s New in Project 2016 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section I’m going to take a quick look at what’s new in Project 2016. One of the reasons 

that it’s a quick look is that there isn’t really very much new in Project 2016 at all in terms of 

functionality that is specific to Project.  

I’m looking currently at one of the pages on Office.com, What’s New in Project 2016. Now as I 

pointed out before I normally say at this point you need to check the latest information. Well I 

don’t expect they’re going to put anything else new in Project 2016 so when you come to watch 

this video I don’t expect any other additions. But let’s go through the main points anyway.  

One of the things that we are going to be looking at a little bit later on in the course is more 

flexible timelines. If you haven’t used Project before you won’t necessarily have any idea of 

what Project’s Timelines are. In the past there has effectively been one timeline. So in Project 

2013 there was one timeline. You can now have a number of timelines and I’ll explain this to 

you later on in the course. 

One of the other big changes, better control over resource scheduling, really is quite a significant 

addition. However, it isn’t a change that is specific to Project 2016. It actually only affects users 

of Project 2016 if you’re using Project Online as well. And since we don’t cover Project Online 

in this course I won’t be covering this point. Now if at some point in the future you do start to 

use Project Online then it’ll be useful referring back to these notes about resource scheduling. 

But this new feature is not relevant if you are only using Project 2016. 

The third item on the list is do things quickly with Tell Me. This is actually a feature which is 

provided across the board in Office 2016 and if you use other components of Office 2016 you 

may already have come across this feature. But I am going to cover it during the course. And in 

particular I’m going to look at it round about the time that we look at Help. 

And the fourth topic is new Themes for Project. And I will cover the new Themes for Project 

when we look at the Project workspace in a section or two from now.  

So as you see that is the list. It’s not a very long list. So if you’ve used Project before and 

particularly if you’ve used Project 2013 before there’s not really a lot extra to talk about. If 

you’ve used a much earlier version then there were certainly a lot more additions in Project 2013 

and Project 2010 than there are in Project 2016. 

Now apart from that particular source for information there is another interesting blog that you 

can read. Now this is an Office blog by members of the Project team. And as you can see there it 

talks about resource engagements. And as I said before that’s one of the topics we won’t be 
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covering because it relies on Project Online. It talks about Timelines. Again, we will be covering 

that. And Tell Me, we will be covering that.  

Now there is one point in this blog that isn’t covered in that What’s New section. That’s the 

reason I pointed you in the direction of this blog. Read/Write Office Add-Ins. And basically 

these extensions and you can download them from the Office Store, enable third-party products 

to interact with effectively the Project database. Now exactly which third-party products are 

available and exactly what they can do I’m going to need you to check yourself in the Office 

Store. But it’s a good sign that you’re starting to see third-party products that can interact with 

Microsoft Project and that can give you additional functionality. 

And that’s it. That’s really what’s new in Project 2016. Some of it is only partly in Project 2016. 

And as with the last example there it’s actually third-party products. But the interaction between 

these third-party products and Project 2016 has been fully enabled in Project 2016. 

So that’s it. That’s what’s new in Project 2016. In the next section we’re actually going to get 

started on a project. So please join me for that. 
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Chapter 2 – Workspace, the Ribbon and Help 

Video: The Project 2016 Workspace 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section I’m going to take you on a tour of the Project workspace and we’re also going to 

start creating a very simple project. And I’ll use that very simple project to demonstrate key 

points concerning the Project workspace. 

You’ve already seen this Start screen and you’ll probably see this quite a few times during the 

course. Although as you’ll see a little bit later on you may want to disable the Start screen once 

you really get used to using Project 2016. You may decide that you can get along perfectly well 

without it. 

Now let me give you a quick tour of the Start screen itself.  

Over on the left we have an area which gives us links to existing projects. We have a Recent 

section. Currently this section is empty. As you can see the note there says you haven’t opened 

any projects recently. Once we start working on projects you’ll start to see a list of recent 

projects appear there. And then below that there is a link, Open other Projects, which gives us 

access to a Windows Browse Dialogue so you can browse your computer, you can browse any 

network locations you have access to and you can browse Cloud areas, such as your OneDrive 

storage. Now we’re going to start with a new project so we won’t be using that part of the Start 

screen on this occasion.  

In the top right we have some standard Windows buttons. The little question mark is Help. Note 

the Screen Tip there. Help and F1 is the keyboard shortcut for that. Then we have Minimize and 

we have Maximize or Restore, depending on whether your screen is currently maximized or not. 

And then we also have a Close button. Below that we have my name and the account under 

which I am currently running Project 2016. This is very important. If you’re the only person that 

uses this PC and you’re the only person that uses Project on this PC and you only have one 

account that you ever run Project under then this will always indicate that account. But if, for 

example, you sometimes use a work account and sometimes a personal account, if you share this 

PC with somebody else you may want to switch between accounts. Well the facility here, Switch 

Account, let’s you switch between those accounts. And I’ll demonstrate that to you a little bit 

later on. 

Now let me talk about the rest of the Start screen. And I’m going to say this once more. I won’t 

keep saying it. You may not see exactly the same as me. It will depend on a number of things. 

But almost certainly the first thing you will see here is a Blank Project thumbnail. I’m going to 

click on that in a little while and we’re going to create a blank project. So that’s an empty 

starting point for a project. But I’m going to run through some of these others first. 
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If you run projects that have an element of similarity, maybe you do building projects, marketing 

projects, then you may already have a project that you’d like to base a new one on. And the 

second thumbnail here, New from Existing Project, enables you to use an existing project as a 

starting point for a new one. The third thumbnail, New from Excel Workbook, let’s you create a 

project from an Excel workbook. And what this basically means is that you have perhaps a list of 

tasks on a worksheet in an Excel workbook and you want to make that list of tasks the starting 

point for a project. The fourth thumbnail, New from SharePoint Tasks List, is a pretty similar 

kind of thing but in relation to SharePoint. So if you have a list of tasks in Microsoft SharePoint 

and you want to use those as the basis for a project you can use that option. 

Now the other thumbnails all correspond to different standard project templates. So if I were 

working on a software development project I could use the first template there, Software 

Development Plan, and it would get me started on a typical set of tasks as a starting point for a 

software development project.  

Now you’ll see a whole list of these templates. These templates you may think of in the old 

terminology as boiler plates but nowadays we generally call them templates. And there are many 

there. So Residential Construction is there, for example. New Business Plan is another one. But 

there are available online many, many templates that you can base new projects on. 

And there is a Search facility at the top here. So if you wanted a project plan for a particular 

thing you could do a search here. In fact there are some standard searches, suggested searches as 

they called underneath. So Project Management, Project Plan, Project Themes, etcetera. Let’s 

suppose and this is definitely potentially going to be very useful, I wanted to look for a project 

plan for a wedding. Let me do a Search on wedding. This is of course an online facility so I need 

to be connected to the internet. Let’s try Wedding. And it comes up with a Wedding Planner. If I 

were to click on that wedding planner then it would let me see a little bit more detail about what 

this wedding planner is. So it shows me the first few tasks. It gives me a description. Wedding 

Planner provided by Microsoft Corporation. It tells me how big it is. It gives me a bit of a 

description about the wedding planner. And then I could use that to create a wedding plan. And 

in fact that’s not very far removed from what I’m going to do a little bit later on. But let me just 

close that for the moment and go back to this screen because apart from giving me potential 

Project Templates for a wedding there are search results from other Office applications. So it 

shows me potentially other useful artifacts related to other Office applications. Let’s look at 

PowerPoint for instance. There are seven found items related to PowerPoint. Now each of these 

is a template for a PowerPoint presentation. So there’s a wedding photo album, a wedding 

reception seating chart and a stylish photo cards template. Now there are other suitable wedding 

related artifacts that can be used in Word, Publisher, and Excel. So we’re not really going to 

cover that on this course but they can be very useful links to other artifacts that you can use with 

the other components of Office. 
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Having taken a look at that let’s go back to the Start screen. We just use the Back button there, 

the Browse Back button. It takes us back to the Start screen. And we’re going to create a blank 

project. Now as soon as I do this I want you to look in the bottom left hand corner of the screen 

because a little message will pop up for a few seconds that you’ll get used to seeing and after a 

while you’ll probably just ignore, but I need to explain it to you briefly now and then in a little 

bit more detail later on. So click on Blank Project, look down in the corner, New tasks are 

created in manually scheduled mode. As you’ll see later on there are two modes of scheduling. 

There’s manually scheduled and there’s auto-scheduled. Most of the time I tend to work in auto-

scheduled mode. And after you’ve been using Project for a while you will choose which mode 

you prefer. The fact that I currently have this in manually scheduled mode and you may or may 

not have it in manually scheduled mode really doesn’t matter at the moment. Don’t worry about 

that. We’ll come back to that a little bit later on. What we need to concentrate on here is the 

workspace overall. 

So first of all in the top left hand corner you have the Quick Access Toolbar that I mentioned 

earlier on in the course. You may not see quite the same buttons as me there but we’ll come back 

to that in a couple of sections time. And in the top right hand corner you have some standard 

Windows buttons. Let me just hover over those. So you have Minimize, Restore/Down and 

Close.  

The main Ribbon is this. So it’s a big block right across the screen, very near the top. I’m going 

to explain the Ribbon to you in quite a bit of detail again in a couple of sections from now. 

Above the Ribbon in the middle is the name of the current project. We’ve just created a project. 

By default it’s called Project 1. If we created another one by default it would be called Project 2 

and so on. 

Now below the Ribbon we have something called the Entry Bar. And the Entry Bar is something 

that we can use to enter and edit data into our project. You may or may not have that entry bar 

shown. If you don’t see that don’t worry. I’m going to show you in a while how to show that if it 

isn’t shown already. Basically the kind of thing we use the entry bar for is this. If I want to enter 

the name of the first task in my project I click in the Task Name Field there, first task name in 

the first row of my project. And then if I click in the Entry Bar I could call it Task 1. Having 

typed that I click on the tick mark to the left of task 1 and that is the name of my first task. If I 

click down to the next row and I intended to type Task 2, I could type Task 2, change my mind, 

click on the X to the left, the cross there, and that cancels what I’m typing. That’s the Entry Bar. 

More later. 

Below the Entry Bar we have the Timeline. I mentioned the Timeline much earlier on when I 

was talking about what’s new and the fact that you can have several timelines now in Project 

2016. You may or may not see the Timeline. If you don’t see it you can show it by, if you go up 

to the Ribbon, above the Ribbon there’s the word View. Click on View. Even if you don’t 
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understand the Ribbon just click on View. And roughly in the middle, just to the right of the 

middle of the commands immediately under there there’s one that says Timeline. And as you can 

see it’s checked. Mine is ticked. That means the Timeline is shown. If I uncheck it the Timeline 

disappears. Check it again, the Timeline is now shown. So that’s the Timeline. When I’ve got 

some tasks it will show those tasks on the Timeline. Now in fact I’ve just entered one task there. 

It hasn’t got any work in it. And the timeline can be set to run over a period of time. Now by 

default my new project is starting today, so that’s December the 14th. And because I haven’t got 

any tasks or work that involve anything in them the end date, the finish date, at the right hand 

end of the timeline is also December the 14th. So it’s not the most exciting project in the world at 

the moment. I’m not really doing much and therefore it’s one of those situations where I can 

safely say that my project is on time. 

Below the Timeline is the main project window. And by default on my installation I show a 

Gantt Chart. And a Gantt Chart actually comprises two parts. It comprises the list of tasks. It’s 

actually a table and we refer to this as the table. And on the right we have the chart itself which is 

normally a pictorial representation of the tasks in my project. Now you may or may not have a 

Gantt Chart shown. If you don’t have a Gantt Chart shown you will soon find out how to show a 

Gantt Chart there. And there will be situations when you’ll want to see one of the many other 

types of chart that you can show in the main body of the display there, the main window. 

Now just to give you a little bit more of an idea of how that’s going to look let’s go back to that 

first task, Task 1. I’m going to click in the duration column there in line with Task 1. And I’m 

going to say that this is a two day task. Click elsewhere and there is my Gantt Bar for a two day 

task. Now there are various things about that bar in terms of its color, its ends and so on that each 

have significance and we’re going to talk about those later on. But basically as we start to build 

up a schedule we’ll build up entries in the table on the left and each of those will be represented 

by a Gantt Bar or other appropriate symbol in the chart on the right. 

The next aspect of the workspace to look at is the Status Bar across the bottom of the project 

window. At the left hand end there are optional pieces of information. One of the ones that’s 

shown there now is New tasks are manually scheduled, which I mentioned earlier on in this 

section. And at the right hand end there are controls for the view. So we can do things like 

choose the view of the project we currently have and we can also use the Zoom controls, more 

on those later. 

And the last part of the workspace that I want to look at is what’s called the Backstage or 

Backstage View. Now what we’re looking at here is effectively a project. It’s a very simple 

project with one ask in it at the moment but this is where we work on the contents of our project. 

Administration of projects, doing everything from saving them to printing them to sharing them, 

this is all done in what’s called Backstage View or just Backstage. And to get to Backstage View 

you click on File which is above the left hand end of the Ribbon. So if I click on File it takes me 

into Backstage View. Backstage View has a load of options, Info, New, Open, Save, etcetera, 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

and we’ll be covering those as we go through the course. It’s also, for example, in Backstage 

View where we set up project information. When I’ve used Backstage View I get back to my 

project again using that Back button and that take me back into my project again. 

So there we are. That’s all the basics of the workspace for now. In the next section I want to take 

a quick look at Help. So please join me for that. 
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Video: Online Help 

Toby: Welcome back to our course on Project 2016. 

In this section I’m going to look at Help. And for those of you who have used Project before 

Help in 2016 is a little bit different in terms of how it works. And in line with virtually all other 

modern major software products you’re very much restricted on Help if you are not online. So 

I’m going to demonstrate Help offline in a little while but let’s start with online. And let’s start 

with how you access Help. 

Now as I pointed out earlier on in the course if you see this little question mark icon up here it’s 

a Help link. And you can either click on Help or use the F1 keyboard shortcut. In fact in Project 

2016 it’s probably a better idea to get used to using the F1 keyboard shortcut because quite often 

you don’t see the question mark icon. But let me click on the icon now anyway and that takes me 

to the Help Homepage. 

The Help Homepage has a list of what it calls the top categories. Each item in the list is 

expandable. So Get Started, for instance, if I click on that, gives me a number of options. So I’ve 

got what’s new in Project 2016, basic tasks, etcetera. Choose one of those, what’s new in Project 

2016 for example and that takes me either to another menu or in this case it takes me through to a 

Help page. 

Having arrived at this page there may well be links to other Help pages. And the Help is 

basically browser based. So I have options such as a Back button and then I also have a Home 

button which will take me home. So that’s back to the Homepage with the top categories listed 

again. And whichever topic I’m on I have the option to print that topic using that Print Button. 

And if you have a need for the text to be larger on a particular page this button enables you to 

change to a larger size of text in the Help or to reduce the size of the text. And very importantly 

within the Help system there is a Search facility. So if you want help on a particular topic, let’s 

suppose you want help on the topic Entry Bar. You want to know how to, for example, enable or 

disable the entry bar. Type in Entry Bar and there you see a list of topics related to the search 

term. The first topic has Entry Bar in it. Later topics will have either the word Entry or the word 

Bar together or separately. And like most of the search functions that we use nowadays it 

prioritizes them according to the closeness of match to the search term. 

Incidentally in this particular case you might like to just note that activate the entry bar to edit 

text in a field, F2. If you can’t see the Entry Bar in your installation of Project 2016 that’s how 

you bring it up. You use the F2 key. 

Now let’s go back home again. I’m not going to go through these Help topics now but I suggest 

that with Get Started you make a point of going through some of those basic topics. Obviously 

I’m going to cover these topics during the course. And in most cases I’ll be covering things in 

much more detail than the Help does but it’s always a good idea to get a different view on these 
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topics and of course to get the official Microsoft view. So do try to find some time to go through 

these Help topics. Perhaps going through them as we cover them on the course. 

Now when you’ve finished using Help all you need to do is to close the browser using the Close 

button in the top right hand corner there. 

Now there are some situations where you can access Help in different ways. And in some of 

these situations in the past I’ve referred to this as contextual help. And the principle there is that 

you ask for help in a particular situation and it goes straight to the relevant page of help. Now 

largely speaking in Project 2016 this doesn’t work in quite as contextual a way as it used to. Let 

me show you what I mean. I’m going to create a blank project. And if I go for a particular topic, 

let me go to the Report Tab on the Ribbon. And I’m going to click on Getting Started and the 

button there will bring up a dialogue. This is the Reports Dialogue that I can use to select a report 

on the progress of my project, for example. And that has indeed got a little question mark button. 

Now generally speaking if I click on one of these within a dialogue I would expect to be taken to 

the help about that particular dialogue. Largely speaking in Project 2016 Help links take you to 

that homepage. So largely speaking they are not contextual anymore. Now of course you can 

search for the particular report that you were thinking you might want to create and you can use 

Help in that way. But it doesn’t take you right there. 

Now a couple of other things to tell you about. One of them is what happens if you are not 

connected to the internet. Let me just show you that. I’m going to close Help and I’m going to 

disconnect from the internet. So I now no longer have an internet connection. I’m going to press 

the F1 key and rather disappointingly that’s all I get. Help is only available online. You aren’t 

connected to the internet. In previous versions of Project there was usually something there. I 

think in the case of Project 2013 it helped you to find items on the Ribbon. That wasn’t really 

much but it might help you in some situations. At the time of recording this if you’re offline you 

don’t get any help at all. 

So the last thing I want to show you about Help is the new feature, Tell me what you want to do. 

This as I understand it will improve and become more comprehensive over time. We’re very 

much dealing with an early version of this feature. But let me just give you a quick 

demonstration of it. 

Let’s suppose there’s something you want to do and you don’t remember where the command is 

that does it or perhaps you’re not quite sure how to do it. Let’s suppose that you want to set a 

baseline. Now setting a baseline may mean nothing at all to you at the moment. Let me just click 

in that box and type in Set baseline. Now as I do that it recognizes all or part of what I’m typing 

so it gives me their options, Set baseline, Show baseline, Set reminder, etcetera. As I do that I 

may say, “Ah Set baseline. That’s what I want to do.” And then there’s a little pop out menu 

there, Set baseline, Clear baseline. Now if that’s exactly what I want to do if I click on that 

option it brings up the relevant dialogue to do that. And if I know how to use that dialogue I can 
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actually go ahead and do it. Of course there is a Help link there as well. Note that some of these 

Help links have a button with the word Help in rather than the question mark. And in this case 

though if I click on it it is contextual. So some of there, some of them aren’t. Most of them 

aren’t. Close and we go back to where I was before.  

But the other point to mention here, let me just do that again. Apart from going to that dialogue if 

I’m still not sure, if I want to check something there is a link there to get help on Set baseline. So 

I wanted to get help on setting a baseline what it does is effectively a search on set baseline in 

Help and then it offers me a number of possible links. 

So that’s that new Tell me what you want to do or the Tell Me feature. As it evolves I think it 

could become a useful feature. I think we’re still at the fairly early stages of it with Project 2016. 

But please give it a try.  

That’s it on Help. I’ll see you in the next section. 
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Video: Ribbon and Toolbars 

Toby: Welcome back to our course on Project 2016. 

In this section we’re going to look at the Ribbon and Toolbars. If you’ve used other Microsoft 

software that uses the Ribbon and Toolbars it’s probably the case that you can skip this section if 

you want to. I will talk about one or two things that are quite specific to Microsoft Project but I 

think that if you’re an experienced user of the Ribbon you’ll be able to pick these up easily 

enough as we go along anyway.  

Now for those of you who aren’t so familiar with the Ribbon let me just explain. The Ribbon 

system was introduced well about eight or nine years ago now by step by step through the 

various components of Microsoft Office. And it’s now fairly fully and fairly consistently 

implemented in these components, including Project. As I pointed out already, it’s this rectangle 

with a number of tabs. And you select a tab. So for instance at the moment I have the Report Tab 

selected. You select a tab by clicking on the name. So this is the Task Tab, this is the Resource 

Tab, and so on. In most of Project there’s a whole bunch of tabs, Task, Resource, Report, 

Project, that you will see whenever you’re using Project. Now this can be changed by local 

settings but talking in general terms here.  

But there are some tabs that only appear in certain situations and these are what’s called 

contextual tabs. And we have a contextual tab here. It’s this Format Tab. And the Format Tab in 

this case is part of what’s called the Gantt Chart Tools. And this is contextual in that because we 

have a Gantt Chart shown here, note the lying its side label here, Gantt Chart. We see the Gantt 

Chart Tools Format Tab which enables us to format a Gantt Chart to change the styling, etcetera. 

If I changed the view, so instead of showing the Gantt Chart I’m going to show, for example, a 

Network Diagram. I now have Network Diagram View and I get a contextual tab for that. The 

Format Tab which is part of the Network Diagram Tools. We’ll see some other contextual tabs 

as go through the course but let me for the moment go back into Gantt Chart View. 

One each of the tabs there are a number of controls. And the controls can be all sorts of things. 

They can be command buttons, they can be dropdown lists, they can be sets of radio buttons, 

etcetera. And they’re arranged into groups. So for instance on the View Tab here the group on 

the left is the Task Views Group and there are five controls here: Gantt Chart, Task Usage and 

these other three. Each of these controls can be a single control or for instance as in here it can 

give access to a whole menu of other options.  

Now I should point out here something that I did point out earlier on and that is that depending 

on the size of your screen, depending on the resolution of your screen, depending on whether 

you’re in mouse mode or touch mode exactly what you see on each tab may well vary. You may 

see more or less controls in each of the groups than I do on this screen. I’m recording this course 

on a PC with quite a high resolution. If you have a smaller resolution PC, perhaps running it on a 
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laptop with much less space on the screen, you may well see less than me. But you should pretty 

much see the same groups even if exactly what you can see in each group is a little bit different 

from what I see.  

So let’s now try to execute a command or two. I’m going to go to the Task Tab. And one thing 

you will notice is that some of the commands are grayed out. So for instance, in the Clipboard 

Group on the Task Tab you have a Cuts command, a Copy command and something called a 

Format Painter that are not grayed out. So you could do those things at the moment. Whereas 

you can’t use the Paste command. It’s grayed out because we don’t have anything copied to the 

Clipboard. And as with Windows applications in general, of course graying out indicates that a 

particular command is not available.  

Let me type a name of a task into this Task Name box for the first task in this little project. I 

could use the tick next to the Entry Bar or just press the Enter key. And I now have Task 1. If I 

select that particular task name by clicking on the box you can see that the box has a border 

around it so it’s selected. If I wanted to make that bold I could use the Bold command in the Font 

Group on the Task Tab. Text of that is now bold. I could make it Italic and I could change the 

font from Calibri to say Blackoak Standard and I could make it a larger font size, for example. 

So that’s basically how you can use the commands on the Ribbon. 

Now we’re not restricted to styling text. If you take that particular task you could do all sorts of 

things to it. For instance, you could record progress on that task using the commands on the 

Ribbon. But more of that later. 

Now slightly at the danger of getting ahead of ourselves here one thing you’ll notice, particularly 

as your projects get bigger, is that the Ribbon does take up a lot of space. And particularly if 

you’re using a small screen it takes up a disproportionately large amount of space. You can hide 

the Ribbon. And there’s a little up arrow over here at the right hand end. It says Collapse the 

Ribbon. And if you click on Collapse the Ribbon the Ribbon is hidden. Now you may say well 

that certainly gives me a bit more space but how do I use the commands? The answer to that is 

that provided you’ve got a reasonable idea of where a command is. So for instance, if I wanted to 

change the size of that Task 1 font back to 10 or 11 point, if I know the commands on the Task 

Tab all I have to do is go back to the Task Tab, click on the name and the Ribbon reappears. So 

if I then say okay it’s 18 and I want to put it back to 11. And then if I want to execute another 

command, so for instance I want to change the font. Once I finish, click back in my project 

again, then the Ribbon is hidden again. Now when I describe that to you I said if I know where 

the particular command is on the Task Tab in that case, if you don’t know where it is you can 

still click on any one of the tabs and you can click around until you find the particular command 

that you want. If you get to a point though at which you think well actually I need the Ribbon 

available all the time again. I don’t want it collapsed anymore. If I just right click in there again, 

notice Collapse the Ribbon is ticked. Just click to untick it and the Ribbon will be there all of the 

time now and you can see all of the contents of the Ribbon all of the time. 
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One other thing I’d like to point out here is that you can customize the Ribbon. And in particular 

you can create your own Ribbon tabs. And you might be wondering about these two tabs here, 

Reporting and Team. You may be looking at your installation of Project and thinking why 

haven’t I got those? Well these are two custom tabs that I have made for specific purposes. I’m 

not going to cover customization of the Ribbon here but I am going to briefly look at 

customizing the Quick Access Toolbar a little bit later on in this section and that should give you 

a pretty clear idea of how to set about customizing the Ribbon. 

Let’s now turn our attention to the Quick Access Toolbar that we looked at earlier on in the 

course. And as you can see mine has about five or six commands currently shown. One of them 

we talked about was the Touch/Mouse Mode command. And then we have Undo and Redo and 

Save. You may be a little bit mystified by these two symbols here. These are two commands that 

I’ve put on the Quick Access Toolbar. They’re actually custom commands. I’ll come back to 

those in just a moment. But as I explained earlier on if you want to change what’s shown on the 

Quick Access Toolbar there is a standard pool of commands. So if I wanted the Quick Print 

command shown I’d select it from the menu here, click it, and Quick Print is now shown. 

Now apart from switching on and off those standard commands you can customize the Quick 

Access Toolbar. And if I click on More Commands here it takes me into a page of the Project 

Options. Now Project Options we’re going to look at in two or three sections from now but what 

we have open here is the Quick Access Toolbar page which we can use to customize the Quick 

Access Toolbar. And let’s suppose that I want to add a button to the toolbar which will enable 

me with one click to make something bold. What I need to do is to find the Bold command in the 

list on the left and then add it to the toolbar. Now the list on the left is controlled by this 

dropdown. And first of all we have the Popular Commands and they’re in alphabetical order. I 

can’t see Bold there. So if instead of Popular Commands I say All Commands I have access to 

the literally hundreds of commands that are available in Microsoft Project. And I want to find 

Bold. There it is. So I select Bold. I click on the Add button between the two lists and it’s now 

added to my Quick Access Toolbar. If I want to put it in a different position I can select it and 

use the up and down arrows here to change its position in the list. And those two custom 

commands I’m going to remove both of those. I don’t need those at the moment so I’m going to 

remove them. And that’s it. Click on OK and my Quick Access Toolbar will be customized. If at 

some stage you make a mistake and you want to go back to the default, the settings as they were 

originally, there’s a Reset button there. So click on OK and there is my Bold command on the 

Quick Access Toolbar. And with the cell, with the task name Task 1 selected I can switch Bold 

on and off using that command. 

It may well be that after you have been using Project 2016 for a while you will find it very useful 

to customize the Quick Access Toolbar. Also some people customize it to do particular jobs. So 

for example, if a project manager is doing a weekly update of status he may put various 

commands associated with task status on the Quick Access Toolbar or indeed create a custom tab 

for the Ribbon for that purpose. 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

One other thing about the Quick Access Toolbar that some people fine useful. It’s right up in the 

top left hand corner there and you have to sort of go across the Ribbon to get to it. You can 

actually position it below the Ribbon. It’s very simple. Just click on the dropdown there. Show 

below the Ribbon and it appears down here. It’s quite a bit easier to get to when you’re doing 

perhaps a long or repetitive task within the body of a project. And then of course you do pretty 

much the opposite to put it back again. 

Now there’s one other type of toolbar that I want to point out to you now. And it’s one that pops 

up all over the place. We’re going to be using this type of toolbar in many places in the course. If 

you take Task 1 here, select it here. If I right click within that cell I get what’s called a 

Contextual Menu. And it’s contextual in that the commands that are available there although 

they’re all also available from various places on the Ribbon, these are deemed to be the ones that 

you are most likely to want to use in the situation that you’re in. And above that contextual menu 

there is a mini toolbar. And again this deemed to be contextual, to contain the commands that are 

appropriate to where you are in Project and what you’re doing. So these work pretty much on the 

principle I’m sure you’d expect them to. You click on things and they either execute commands 

or bring up other menus or bring up dialogues or whatever. So we have these contextual menus 

like this one and then we have mini toolbars like this one. And as I say, we’ll be using these at 

various points during the course. 

That’s the end of this section. I’ll see you in the next one. 
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Video: Status Bar 

Toby: Welcome back to our course on Project 2016. 

In this section I’d like to take a quick look at the Status Bar. Now I’m going to deal with it in two 

parts, the left part and the right part. But importantly if you right click anywhere on the Status 

Bar you will see a list of potential contents. And whatever’s ticked is currently shown. Note the 

header there, Customize Status Bar.  

Now you might be surprised to see quite so many ticks but actually not very much information 

on the Status Bar at all. And the reason for this is that apart from the bottom two entries, View 

Shortcuts and Zoom Slider which are the things that are shown at the right hand end of the Status 

Bar, the things on the left correspond to optional pieces of information you can show but which 

very often don’t show anything at all. So for example, if you look at the item fourth down the list 

there, Filter, it’s ticked. And what that means is that if a filter is being applied to the current view 

show the name of the filter there. Now in this case no filter is being applied and therefore you 

don’t see anything. So with quite a few of these items even though they’re ticked most of the 

time you won’t see anything unless you’re using that particular feature. 

Now there are a couple of things shown at the left hand end. One of them is Ready which is the 

Cell Mode. If I click Cell Mode so that that’s not shown you’ll see the effect. It no longer says 

Ready because I’m not showing the Cell Mode. The other thing that’s shown is whether new 

tasks are manually scheduled or auto-scheduled. If I tick that it will no longer show that currently 

they’re manually scheduled by default. 

Now the other items although they’re ticked there’s nothing to see. One of them that isn’t ticked 

is this one which is the Macro Recording indicator. We’re currently not recording a macro. 

That’s a sequence of steps that we can replay automatically. If I check that you’ll see the little 

icon that indicates that we’re not recording. If I started recording a macro and left this checked 

then you would see a different icon whilst we were recording. And in fact that icon would give 

you a way of stopping the recording. We’re not going to be covering macro recording anytime 

soon so let’s check that off. And let’s concentrate on the right hand end of the Status Bar. 

Now the bottom two options there, View Shortcuts. The first one corresponds to this set of 

buttons that I can use to enable different views of my project. So let me just click away there. I 

currently have Gantt Chart View. But if I go to this one, this is Task Usage View. And if I go to 

this one it’s Team Planner View and so on. I’ll be covering all of these later on in the course. 

And the fact that that second to bottom option is ticked means that those buttons are there to 

enable me to easily switch between those views. As an alternative to those I can select the view I 

want from the View Tab on the Ribbon. And in fact there are many more options on the View 

Tab on the Ribbon. 
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The very bottom option, Zoom Slider, gives me access to this control that I can use to zoom in 

and out of the current view. And this basically zooms by time. So as I zoom out I get a broader 

view of time. So now you can see in that view that I’m looking at quarters. If I zoom in by 

clicking on the plus button there I’m down to months, then weeks, then eventually I get down to 

individual days. Now again I can either use that. It’s quite a course control but I can use that. Or 

on the View Tab on the Ribbon there is a Zoom Group that lets me be much more accurate and 

much more flexible about how much I’m zoomed in on the current view. 

So that’s it. That’s the Status Bar. Please join me in the next section. 
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Video: Keyboard Shortcuts and Key Tips 

Toby: Welcome back to our course on Project 2016. 

In this section we’re going to look at keyboard shortcuts and Key Tips. If you don’t use keyboard 

shortcuts and you are not interested in finding out how to use them then you certainly can skip 

this section. I do know that many people like to use keyboard shortcuts. They can be particularly 

useful if you have repetitive jobs to do and you don’t like moving the mouse around all day. 

You’d much rather just go straight to what you need to do using the keyboard. And for some 

people the use of the keyboard is a necessity either because of an injury or some kind of 

impairment and the use of the keyboard is much preferable to trying to use a mouse or some 

other approach. 

In Project 2016 keyboard shortcuts are very well supported. And in this section I’m going to take 

you through the main options for using them. 

Now of course the main problem with keyboard shortcuts for most people is knowing what they 

are. And I must confess that I don’t really use keyboard shortcuts a lot. And the main reason is 

because I have great trouble remembering them. I use a lot of different pieces of software in a 

typical working day and I would just get confused if I tried to remember the hundreds of 

keyboard shortcuts that might ultimately make my life a little bit quicker and simpler but which 

would be very difficult to remember. 

Having said that the common keyboard shortcuts, certainly as far as Microsoft Office are 

concerned I use quite a bit. So things like Cut, Copy and Paste I use quite a bit.  

If I go to a tab on the Ribbon. Let’s go to the Task Tab. If you wanted to know the keyboard 

shortcut for Cut and you couldn’t remember it. If you hover over the Cut button it tells you that’s 

Cut and it gives you the keyboard shortcut in brackets afterwards, Control plus X. Similarly for 

copy Control-C. Format Painter, now unfortunately there isn’t one. And the problem is that for 

many commands there is not an equivalent keyboard shortcut. So if you know a keyboard 

shortcut already that’s fine and it’s supported in Project that’s fine. If not, if you hover over the 

ribbon and the particular command you’re interested in you’ll soon find out whether there’s a 

keyboard shortcut for it or not. 

So the next option is is there a list of keyboard shortcuts? Well there is. If I press the keyboard 

shortcut F1 to bring up online Help and go to that Getting Started section that we looked at 

before, one of the options there is Keyboard Shortcuts for Project 2016. And that gives us a nice 

list of all of the keyboard shortcuts. Now of course you can print this out. I know some people 

print this out and stick it on the wall. The keyboard shortcuts are basically arranged in two sort of 

categories here. There’s the Microsoft Office basics which takes you through to all of the 

standard keyboard shortcuts that you’ll use with Microsoft Office. So this includes things like 

moving around in text or cells. So one character to the left is left arrow, one line up is up arrow, 
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moving to the end of the line is End. So all of the standard shortcuts. But then you also have the 

ones that relate specifically to Microsoft Project. So you’ve got keyboard shortcuts for using a 

Network Diagram, navigating views and windows and so on. So there’s a list there. And if 

you’re pretty good at remembering those things or as I say if you want to stick that on the wall 

that’s a very good source for finding keyboard shortcuts. 

So that’s a couple of ways of finding out what keyboard shortcuts are. There is another way and 

that’s the use of Key Tips. And I’m going to demonstrate that to you now. 

I’ve got the task name Task 1 selected in that single task in my current schedule. And I want to 

underline the name and I can’t remember the keyboard shortcut to do underlining. So let me 

demonstrate Key Tips. 

First of all just tap the Alt key on the keyboard and it brings up some one and two character 

codes for accessing the commands on the Quick Access Toolbar and the tabs on the Ribbon. 

Now if I can’t remember which Ribbon tab it is I could step through these one at a time. But I do 

know that what I want is on the Task Tab so I press the H key. That’s the access key for the Task 

Tab. So I press H. And now the commands on the Task Tab on the Ribbon are each presented to 

me with their various other letter or number codes. Now number three would give me access to 

the Underline command. But let me just be a little bit more flexible than that. I want to bring up 

the dialogue which gives me all of those formatting, font formatting commands. So I’m going to 

do F and N. F then N. That brings up the Font dialogue. Now to go through the commands on the 

Font dialogue I successively press the Tab key until I get to the one that says Underline. When 

Underline is selected I press the Space Bar to enable Underline and then to okay that, if you look 

at the top right hand corner of the dialogue you’ll see that the OK button is selected. So if I press 

the Enter key that will be underlined. And as you can see Task 1 is now underlined. 

Now you can bring up those Key Tips at any time by pressing the Alt key and you can switch 

them off again by pressing the Alt key again. 

That’s the end of this section. I’ll see you in the next one. 
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Chapter 3 – Using Touch 

Video: Overview of Principles 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section I’m going to look at using Project 2016 using a touch screen device in a little bit 

more detail. If you don’t use a touch device and have no desire or need to use a touch device you 

can pretty much ignore this section, skip straight on to the next one. 

Now Touch Mode in Project 2016 is an interesting thing in a way because it is supported and you 

can do a lot of things using a touch device in Project 2016. But my feeling is that some things 

don’t really lend themselves very well to the use of touch. But that is to some extent a personal 

opinion and if you’re using a touch device with Project 2016 you may find that you can do pretty 

much everything you need to do using touch. 

Now the first thing I need to say is that with Microsoft products and particularly Microsoft 

Office related products nowadays there do tend to be two or more versions of various products. 

And when I’m looking at the use of touch here and in particular in relation to Project I’m talking 

about touch as it’s used on a desktop product. And Microsoft themselves still say that their 

desktop products are intended for use and are optimized for use with mouse and keyboard. So 

they’re recommended way of using Project 2016 is still mouse and keyboard.  

Having said that, as I say, if you want to use a touch device or need to use a touch device that’s 

really what I’m going to do in this section. I’m going to give you a pretty quick overview of the 

key points you need to be aware of. 

Now before I demonstrate a bit of use of touch let me refer you to a document. Now as usual this 

may change between the time that I record this and the time that you work your way through it. 

But if you go to the Office.com site there is a particular page there that explains how to turn 

Touch Mode on or off. Now I’ve already shown you how to do that. I’m not going to go through 

it again. 

But towards the bottom of that page there is a section, More Touch Tips, that gives a link to the 

Office Touch Guide. And if you go to the Office Touch Guide it actually refers to Windows 8 

here and of course I’m running here on Windows 10. And this Office Touch Guide really relates 

to Office 2013, not 2016. But pretty much what is here is still totally relevant to what we’re 

doing in Project 2016. 

So it explains tap and pinch and stretch and slide. Now you may be very familiar with all of these 

things and you may be familiar with them in relation to Office products. But if you’ve got any 

doubts or uncertainties I suggest you have a look through those because it will tell you a lot 

about general aspects of using touch with a Microsoft Office desktop product. Now there are 
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specifics there in relation to Excel and PowerPoint but just stop if you like at the end of the 

general points, working with shapes and objects, and I think you may find this document a pretty 

useful introduction to the use of touch that you can extend into your use of it with Project 2016. 

So let me do a little bit of work on a project using touch. I’ve started that project. I’m just going 

to use my fingertips from now on. I already have the Touch/Mouse Mode button visible on the 

Quick Access Toolbar. So I’m going to tap on the dropdown and I’m going to choose Touch 

Mode. Now as you saw earlier when I go into Touch Mode everything is spaced out more. It 

certainly makes it easier to use with my fingers. And also as I mentioned earlier depending on 

which tab on the Ribbon you’re using you may find that you get a few less commands shown. 

And this will of course depend on the size and resolution of your screen, etcetera.  

Now when it comes to adding details of a task, in theory all I have to do, for instance, is to tap 

here in the Task Name field and depending on how my system is setup I may automatically get 

an onscreen keyboard or I may need to invoke a keyboard myself. Now in this case I’m going to 

invoke the keyboard by tapping on the keyboard down here on my Task Bar towards the bottom 

right, up comes my keyboard. Now I’m going to start to type. When I’ve finished if I press the 

Enter key it’ll take me down to the next task. So far so good. Let me put in a second task. Now 

whatever point I finish using the keyboard of course I can close it again. 

Let me go back to one of those tasks, tap it to select it. Note how in the case of using touch the 

selection marker has those two little circles on the corners. This enables me to extend the 

selection. For instance in this case I’m going to select the bottom right hand handle there and 

drag it down so that I’ve got both of those tasks or their task names anyway, selected. So I’ve 

now extended that selection to those two tasks. 

Now let’s suppose that I want to do one of the things that I did earlier on. I want to make those 

two bold. All I need to do is to tap on the Bold command in the Font Group on the Task Tab on 

the Ribbon. Now those names are bold.  

If I want to do something a little bit more sophisticated shall we say, what I showed you earlier 

on when we were using mouse and keyboard was how to a right click to get a contextual menu. 

Well in the case of touch that’s a case of tap and hold. So you tap and then when you get the 

rectangle around the point where you’ve tapped you release in order to see the contextual menu. 

Now in this case you may say well what contextual menu? All I can see is a mini toolbar. In fact 

it’s almost a maxi toolbar really. It’s a lot bigger than the mini toolbars that we saw before. Now 

in fact it is a mini toolbar. It’s one that’s optimized for touch. And the contextual menu actually 

hangs off the right hand end of that mini toolbar. So if I tap on the little arrow at the right hand 

end there is my contextual menu.  

So there I’ve covered the basics of using touch. Clearly a lot of the other aspects of using touch 

will come as you learn more and more about Project 2016. And I will point out key aspects of 

using touch where they’re appropriate or significantly different from the way that you would do 
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things using mouse and keyboard. But the points that I’ve demonstrated here already are going to 

be some of the key points that you need to be aware of if you’re using a touch device. 

Let me just demonstrate one other thing. Again as a sort of general example. Let me just tap 

somewhere else to remove the contextual menu and the mini toolbar that we had there. You saw 

a couple of sections ago how to use these Zoom Slider. Well if you’re using touch you can also 

do things like zooming the time scale with your fingers using pinch and stretch. So let me do a 

bit of pinch and stretch on the right there. So I’m not using the zoom slider. But interestingly 

note that as I do that with my fingers the zoom slider moves in response as well. So these tools 

all integrate with each other. And in many I think a good way to think of using touch with 

Project 2016 is that it’s an additional way of doing things rather than necessarily an alternative 

way. And if you’re using a touch device and you become comfortable with it it can be quite 

convenient in some situations. 

On the other hand if I wanted to enter a duration for Task 1 I have quite a bit of trouble with my 

fingers actually using those tiny little roller controls on the right there. You may have smaller 

fingers than me or a bigger screen. With a bit of practice I can just about do it. But I do prefer to 

just click on those rollers with the mouse. 

That’s it for this section. I’ll see you in the next one. 
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Chapter 4 – Project Options 

Video: Overview of Project Options 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section we’re going to take a look at Project Options. And to a large extent Project 

Options represent your own personalization of your installation of Project and in the way that 

you use Project on your projects. Some of these options you need to have set correctly before 

you start to create and work on any kind of substantial project. And in fact as we’re going to get 

started on our exercise project in the next section very important that you go through this one 

carefully. Even if you’ve used Microsoft Project before I suggest that you follow this section 

through because I’m going to make sure that we cover all of the essential options so that when 

you start working on the exercise you won’t finish up having to sort of go back and redo things 

later on. 

So to access Project Options the normal way is to go into Backstage View and right at the bottom 

you have Options and that brings up the Project Options dialogue. You’ve seen this already 

because there are various points where you get taken to this dialogue, often to a specific page on 

this dialogue and you are given the opportunity there to change something or set something. So 

you may well recall when we were looking at Quick Access Toolbar, for example, we went to 

this Quick Access Toolbar page and used the controls on this page to add a button to the Quick 

Access Toolbar, that Bold button. In fact I think I’ll remove that Bold button now. And we also 

removed a couple of other buttons that we didn’t need. 

Now what we’re going to do in this section is go systematically through these pages and look at 

the options that we need to get set straightaway.  

Now in order to demonstrate the way that many of the options work I’m going to do a quick 

demo in relation to what’s called Screen Tip Style. The very top entry on the first page, the 

General page of options, User Interface Options, Screen Tip Style, Show Feature Descriptions in 

Screen Tips. If I click on the dropdown here there are three options: Show feature descriptions in 

Screen Tips, Don’t show feature descriptions in Screen Tips, Don’t show Screen Tips. Now at 

the moment with that first option selected, let’s go back to that. Just click on OK. If I hover over 

one of the buttons on the Ribbon I get a Screen Tip, Move Task, Move the selected task forward. 

You can also move the task to when the resources are available, etcetera. Now let me go back 

into the Options and let me change that to Don’t show feature descriptions, click on OK. OK 

generally saves any changes that I’ve made. Let me hover over Move again. And now all I get is 

Move Task. So that’s the name of the command but not a description of what it does. If I go back 

into Options again, obviously if I chose the third option, Don’t show Screen Tips, I wouldn’t 

even see the Screen Tip with the name of that particular command. So let me put that back at its 
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previous setting, the original setting, and that’s really the principle on which many of these 

options work.  

Now let’s look at some of the other key ones on this General page. The default view for me is 

Gantt with Timeline. I pointed that out to you a couple of times. That’s the default view when I 

open up Project, particularly start working on a new project that’s what I see. And I also can 

choose here my default Date Format which is the short form of the day of the week with and then 

month, day, year. Various other Date Formats to choose from Choose the one that you prefer. 

My User Name is here with my initials. Now you may think well what difference does that 

make? If you’re collaborating with other people on projects, if you’re sharing projects and so on 

you may do things like Comment on projects. You may make certain other changes to projects 

which are identified as being by you. And having your user name and initials set correctly here 

enables other people to track that it was you that made that change or made that comment.  

Now if you remember right back near the beginning of the course I talked about the fact that one 

of the new features in Project 2016 was the availability of some alternative Office Themes. And 

this is where you can choose the Office Theme. Now I’ve currently got Colorful. If I selected 

Dark Gray, clicked on OK. It’ll basically change my Office Theme to that Dark Gray Office 

Theme. I think that’s probably quite difficult for you to see the video so I’m just going to go 

back in and change it back to the way that it was. But again you might want to experiment with 

that to see which of those Themes you prefer.  

And something else that I mentioned earlier on in the course is that you can suppress the 

showing of the Start Screen. And you do that by unchecking this box. If I uncheck that, click on 

OK to save the change. Next time I start Project I won’t see the Start Screen. Again, that’s 

something for you to try out to see if you are happier with that arrangement. 

Whatever changes are made, as always, I click on OK to save them. 

And just incidentally while I talked about that particular change, most changes that you make in 

Project Options are activated when you click OK to close the Project Options dialogue. There are 

a small number of changes where you do need to restart Project for them to take effect. But when 

it is necessary to restart Project it does actually tell you that you need to restart Project for the 

change to take effect. 

The next page I want to look at is the Display page and there are two important options here at 

this stage. First of all for each project that you work on you can set the currency options. At the 

moment we only have Project 1 here and the dropdown here lets me choose from the available 

projects. So there’s only Project 1. And I can set a symbol, the decimal digits, the currency, and 

so on here.  
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And the second option on this page, again going back to something that I mentioned earlier on, if 

don’t see the Entry Bar it’s probably because this option down here for Entry Bar is unchecked. 

Make sure that’s checked and you’ll see the Entry Bar between the Ribbon and the Timeline. 

Now the next page is the Schedule page and there are a couple of very important settings here 

which I’m afraid I’m going to have to ask you to set based on trusting what I’m telling you at the 

moment. I’m going to explain these settings to you a little bit later on in the course. But at the 

outset I’d like you to have them set in a particular way.  

Now there are some very straightforward settings on this page. So for instance, the week starts 

on a Sunday, the fiscal year starts on January. You may be tempted to do things like change the 

default start time and end time for working days where you work, hours per day, hours per week, 

etcetera. By all means set those if you want to. I will be talking about those and calendars in 

general in a bit of detail later on. At this stage it’s not really that important that you get them 

quite right just at the moment.  

Two settings I do want you to set in a particular way though are these, first of all. New task 

created manually scheduled. I’ve mentioned that before. I’ve currently got New task created 

manually scheduled. I want you to set that to auto-scheduled. And it’s very likely that for most of 

you this will be the way to leave this settings set in the longer term. And what this basically 

means is that when you create a task in a project it becomes auto-schedule which means that as 

you schedule the project or in many cases as Project 2016 schedules the project this one is 

automatically scheduled according to all of the constraints, dependencies, resource availability, 

all the other factors that come into force this task will be scheduled accordingly. If you leave this 

set at manually scheduled for new tasks then each task that created is manually scheduled and 

each task that you create either has to individually be changed to auto-schedule or you have to 

manually schedule each task. There may be situations in which manually schedule is what you 

want and I’ll talk about that later on. But for the moment I want you to make sure that’s set at 

auto-schedule. 

The other setting that I want you to make sure is set in a particular way is down here where it 

says Calculation. Calculate project after each edit on or off. Now I’d like you to make sure that is 

set to On, which means that each time we make a change to the schedule Project 2016 will 

automatically calculate the effects of that change without you having to take a separate 

calculation stop. Now I’ll explain more of the significance of that setting later on in the course as 

well. But basically for the moment just bear in mind that Project 2016 has to do a lot, particularly 

in a large project, to work out how to schedule things and each time you make a change you 

really need to see the affects that change has had potentially on whole parts of the project. And if 

you don’t have that set to On you have to separately and as a manual exercise tell Project 2016 to 

calculate the project, i.e., to reschedule it. So for the moment I’d like you to set that to On as 

well. And as I say with both of those settings I’ll explain more later on. 
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The next page is the Proofing page and that relates to Spellchecking and Auto-Correction as 

you’re typing. I’m not going to go through this at this stage. But if you’ve used the Proofing 

facilities in other components of Microsoft Office such as Microsoft Word I’m sure you’ll be 

able to go through there and make the appropriate settings for you. 

Now we come to the Save page and there are a couple of very important settings here. One of 

them is the default file location. And this is the location where any Project files that you save 

will be saved to by default. It’s set when you install Project 2016 to one of the folders within in 

your personal Windows directory. You may want to leave it set there or you may want to save 

your Project files by default somewhere else, entirely your decision. Mine is currently set to save 

in the default location. 

The next option is the AutoSave option. And if you’ve used other components of Microsoft 

Office you might be tempted to switch AutoSave on. And that will cause Project 2016 to save 

your work at regular intervals according to the number of minutes selected in this box. Now you 

may well be tempted to switch that on but I don’t and there is a good reason for that. Unlike 

other components of Microsoft Office you have AutoSave switched on each time AutoSave 

occurs it clears your Undo history. So once an AutoSave happens you cannot then Undo. Now 

for some people they’re quite happy to work on that principle. Perhaps they don’t use Undo very 

much or perhaps they’re very careful. You can in fact use this option for a prompt to warn you 

when an AutoSave is about to happen. But in my case I prefer to leave AutoSave switched off. 

But ultimately it’s your choice.  

The next page also has very important settings. And this page determines the language that 

you’re using to work in Microsoft Project. Now you can have more than one language installed 

and you can select different ones for different situations. I have English (United States) and 

English (United Kingdom) as the two languages that I use. They are sufficiently different to 

warrant being described as two different languages. My default is set at English (United States). 

If you need to add an additional language it’s very straightforward. There’s a dropdown here 

which gives you access to many, many, many more languages. And in a particular case with a 

particular project most people find that their default language is the one they use most of the 

time. But if you do work in more than one language, even if the two languages are two versions 

of English, you do need to be aware of this language setting. And when you’re working on a 

project make sure that you have the appropriate language selected. 

Now let me quickly run through the remaining pages of Project Options. There are no settings on 

the Advanced page that you need to worry about now. We will be looking at one or two settings 

from here later on.  

Customize Ribbon is the equivalent of the customization page for the Quick Access Toolbar and 

it looks quite similar. The main difference is that rather than say selecting commands from the 

list on the left and adding them to what was the Quick Access Toolbar on the right what you 
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would normally do is create your own tab, add your own groups to it and then copy commands 

from the left hand list to your groups on your new tab. And then as in the example that I showed 

you earlier on with the two tabs on my Ribbon, Reporting and Team, you could build up your 

own custom tabs on the Ribbon. Now I’m not going to cover that now but by all means have a 

look at the help, give it a try and see how you get on with it. Don’t forget you can always click 

the Reset button to put things back how they were if things go horribly wrong. 

Quick Access Toolbar page you’ve already seen and you’ve seen me use it. Add-Ins are out of 

scope for this course. And the Trust Center is sort of out of scope for this course. There’s one 

thing I would like to say about it. In Project 2016 mainly the Trust Center is concerned with the 

fact that one way that people can get malicious content onto your computer is to get you to run 

macros. And macros can be included within Microsoft Project files. Make sure that you have the 

setting here for macro settings at Disable all macros with notification. And then if you open a 

Project file from somebody else and it says, “I want to run a macro.” I you know who the person 

is that you’ve got the Project file from and you absolutely trust the source you can let the macro 

run, but if not you can say, “Nope, I’m not going to let that macro run.” 

So that’s it. That’s the basics, the overview of Project Options. And we’re going to be looking at 

quite a few others as we go along. Please make sure that you’ve got set the ones that I said you 

should have set. That’s it for this section. I’ll see you in the next one. 
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Chapter 5 – Task Basics 

Video: Entering Tasks 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section I’m going to start work on the project plan for a wedding. Now of course different 

people would have very different opinions on what might be part of the arrangements for a 

wedding. So what I’m going to try to do is to come up with a project plan for a wedding that has 

enough detail in it to be reasonably realistic but which will also reflect the different styles of 

wedding that you may get in different parts of the world, in different cultures and so on. Having 

said that the style of wedding that I’m planning here is not one that’s associated with any 

particular religion, for example. 

Now what you’re going to be doing from very soon onwards is planning the refit of a bathroom 

in a domestic house. So what I’m going to try to show you while I’m doing this wedding plan is 

some of the ideas that I want you to incorporate into building up the plan for the bathroom refit.  

You may well find when you’re looking at either of these projects that they don’t really reflect 

how you would set about doing them but really that’s not the point. You’re learning the tools in 

Microsoft Project to do these things and you’re not actually learning how to either plan a 

wedding or refit a bathroom. 

Another important point to make here is that we’re building these things up in layers. I’m not 

going to go deep into the detail straightaway. We will certainly get to the detail but we will do it 

one layer at a time and I’ll explain the tools and techniques associated with Project 2016 as we 

go. 

So first of all I’ve made a list of the main aspects of this wedding plan. Let’s take a look at that 

first.  

Now I’m sure this isn’t going to be quite right but I’ve made this list. It’s actually in the course 

file folder if you want a copy of this list. And it’s planning attire, and by attire I mean basically 

the clothes that people are going to wear but it’s probably a little bit broader than that. Guests, 

venue, catering, flowers, memories, details, the wedding day itself, and the honeymoon. So 

they’re going to be my main headings. And the first thing I’m going to do is to start adding each 

of those to my project plan. So let’s take the first one, planning, and set that one up first. 

So I’ve created a new blank project and in the task name I enter Planning. Now a couple of 

things to point out here. I’m using Gantt Chart View. And I did show you briefly earlier on in the 

course a couple of ways of switching to Gantt Chart View if you’ve not got Gantt Chart View on 

already. One way is to use one of the buttons down towards the right hand end of the Status Bar 

but you can also go to the View Tab and select Gantt Chart View there. Another thing to bear in 
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mind is that you should have new tasks set at auto-scheduled or what I’m going to do next won’t 

work for you. So having entered Planning as the task name I press the Tab key and a number of 

fields are filled in for my first task. One of them is the duration. And by default a task has a 

duration of one day with a question mark, normally. Now what the question mark means is that 

this is an estimated duration. And what one normally does is to leave the duration as an estimate 

until you have actually got a reasonably reliable duration for that task. Now at this stage I’m not 

going to worry about durations at all. I’m just going to get all of those tasks in. But bear in mind 

those question marks are a good way of reminding myself that that’s just an estimate of the 

duration. And believe me planning a wedding is a lot longer than a one day task. 

Ignore work for the moment and let’s look at start. And you can just about see that the start date 

is Thursday, December the 17th. Now one thing that may already be annoying you is being able 

to see the contents of all of these fields. So let’s deal with that first. 

If you need to make these columns wider or narrower, if you hover over the header, the gray part 

here, and go to the vertical line between two fields you’ll see the cursor change to a double 

arrow. If you click with the mouse at that point and drag one way or the other you can make the 

columns wider and narrower. Now in that way you can make sure that you can see the contents 

of any particular column at any particular time. We’ll do a little bit more work on how to format 

Gantt Charts, how to lay them out more neatly later on. But for the moment that’s probably one 

of the most important things you need to be able to do. So just practice making those columns 

narrower and wider so that you can see things a little bit more conveniently.  

And also there is a bar, a vertical dividing line between the table on the left and the chart on the 

right. If you hover over that anyway you get a slightly different double arrow and you can 

change that divider so that you can see more or less of the table, more or less of the chart. And 

again you need to get used to adjusting those to suit your specific requirements. 

Now let’s go back to this start date, Thursday, December 17th. Now by default new tasks are 

created either on project start date or on the current date. Now in this case both of those are 

today. You can check which it’s set to by looking at Project Options on the Schedule page. I 

suggest you have a quick look at that now. It’s immediately under where you said new tasks are 

auto-scheduled. And you’ll see in this case that it says Project start date. So what is the project 

start date?  

By default project start date is the date I create the project. And I created this project today so it’s 

today, Thursday, December the 17th. If you click on the Project Tab on the Ribbon in the 

Properties Group normally the first button there is Project Information. Click on Project 

Information and one of the basic pieces of project information is the start date. And that is the 

start date, Thursday, December 17, 2015. It will also tell you in this case what the finish date is. 

Now of course I haven’t really got much work scheduled on this project at the moment so it 
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means that I can start planning this wedding today and I can actually have the wedding today as 

well because I’ll be ready. Believe me that situation will not last much longer. 

And going back to what I was just saying now about Project Options, you can see here that we’re 

scheduling from project start date. Some projects might be scheduled from the project finish 

date. Now it’s very conventional to start a project and say when will I be ready, but it also pretty 

often happens that you know when you’ve got to be finished by and what you really need to 

know is when should you start. You can do both of those types of scheduling in Project 2016 but 

it’s very important to know at any time whether you’re scheduling from the start date or to the 

finish date. The approach we’re taking now with planning this wedding is that we are starting at 

a start date and when we’ve done all the planning and got all the other activities in we’ll know 

when we can be ready by. So we haven’t got a date for the wedding yet. We need to do a lot of 

work, to do a lot of planning first, but we will find out when we would be ready to have the 

wedding by. 

So let me cancel this dialogue for now and I’m going to put in a couple more of the tasks in my 

project. 

Okay I’ve got three tasks in there now. You may be slightly surprised by how my plan looks but 

there are very good reasons for it. At the moment I have not told Project 2016 much about these 

tasks at all. I haven’t, for instance, said that Attire must happen after Planning or that Guests 

must happen after Attire. So it has no reason to put these tasks in sequence. 

A very important point here as well is that you don’t actually have to enter the tasks of a project 

in chronological sequence. I could put all of these in any order that I wanted to. But the 

convention is that the tasks you expect to at least start first go first in the list. 

Now in the left hand column here you have something called a Task ID. And as you’ll see later 

on in the course Task IDs fulfill a very important purpose. But one way of looking at this is that 

generally speaking the convention is that the task with the lower IDs correspond to the tasks that 

are performed earliest in the project. Having said that and as you’ll see later on with this wedding 

plan the individual elements that make up each of these tasks, and bear in mind we’re going to 

break each of these tasks down as we go through, will overlap some of the things that we thought 

were going to be earlier on will be later on and so on. And in any case as the project progresses 

things will tend to change. So having the earliest tasks as the ones with the lowest ID numbers is 

more of a sort of general guideline than any sort of specific rule. 

The next thing I’m going to do is to put in the rest of those tasks. 

And there we are. I have all of those headings in. All of them have an estimated duration of one 

day which is clearly not the case. But we have a starting point for our plan. And having done that 

work the next most important thing to do is to save this plan and that’s what we’re going to do 

first in the next section. So I’ll see you then. 
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Video: Opening and Closing Projects 

Toby: Welcome back to our course on Project 2016. 

In this section I’m going to look at opening and closing projects. And before I do that the very 

first thing I need to do is to save the first version of the wedding plan. And I’m going to talk 

more about saving in a couple of sections time. For the moment I’m going to save this to the 

course file folder with a very straightforward file name and then we’re going to concentrate on a 

bit of opening and closing for now. And I’ll tell you more about Save later. 

So in order to save this project go to Backstage View, click on Save As. Save As brings up a 

Save As page. And exactly what you see here will depend on what Save As locations are 

available to you. I have SharePoint sites available to me. I have a couple of OneDrive locations 

available to me. And I have of course the PC that I’m working on. Now depending on how your 

defaults are set you will by default be offered one of the available options. On this occasion I’m 

not going to accept my default of saving to a SharePoint task list. I’m going to save it to my PC. 

And that’s what I want you to do as well whenever you save files. 

Now when I click on this PC I’ll normally see a list of folders that are either default folders or 

ones that I’ve used recently. Now I don’t actually want to use any of those folders so I’m 

actually going to the bottom here and I’m going to browse to the folder that I want. Once I’ve 

used that folder, and that’s the course file folder in my case, that will appear on this Save As list 

under this PC next time. So I’m going to click on Browse and then browse to the course file 

folder. 

Now at the moment the course file folder is empty as far as the Save As type that I’m using is 

concerned. And my default Save As type is set to MPP. That should be your default Save As 

type as well. So all I need to do now is to give my project file a name. So the extension will be 

MPP and the name I’m going to give it is SSI Wedding 01. Click on Save. Now when I’ve saved 

that file the file name appears in the header of Microsoft Project 2016 at the top there to remind 

me of what the name is. And if I would now to save this or any other project using the approach 

that I’ve just taken. So if I do again File, Save As and click on this PC that course files folder 

now appears in the list of Save As locations.  

Now there’s a couple of important things to note about these sort of lists of locations and lists of 

files and so on. And that is that as you work more and more with Project 2016 obviously these 

lists are going to tend to get longer and things will start to drop off the bottom of the list. Now 

there’s a little pin on the right here and if you click that you can pin items to the list. I anticipate 

that I’m going to be saving a lot of items to the course files folder. I don’t want it to drop off the 

bottom of any list so I’m going to pin it to this list to make sure that it stays there. There’s now a 

new category here of Pinned. So if you’re going to be working with a couple of folders, the 
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course file folder and the exercise file folder, you may well want to pin them to this and any 

other list that you finish up using. 

So having saved that project to that folder I’m now going to close it by clicking on the Close 

button here and I now have Project 2016 open with no files open. 

In a moment I’m going to look at some of the options for opening that wedding project again. 

But just before I do let’s go to Project Options, the Advanced page. And I did mention earlier on 

that we would be looking at some of these advanced options as we go through the course. There 

won’t be time to go through every single thing but I will point out a few of them as we go. And I 

do suggest that from time to time you take a browse through these options. For example, on the 

Advanced page in the Display section the first option, Show this number of recent projects. In 

that way you can control how many projects appear in the Recent list. And below that one of the 

options is Show this number of unpinned recent folders. So you have a number of options that 

you can experiment with and set to your own requirements there. I’m not going to change my 

setting at the moment. But what I am going to do is to exit Project altogether and sort of pretend 

it’s the next day and come back in and see what happens as I start up Project. 

Well when I start up Project I can of course see the wedding project in my recent projects list. 

But I’m not going to open that at the moment. What I’m going to do is to start a new blank 

project. And whilst I’m working on my new blank project I decide that I need to look at the 

wedding project. Now I don’t need to close this project. I can have more than one project open at 

once. So I’m going to go to File, Open, and of course there in my Recent files list is the wedding 

project. I might choose to pin it to that list. Remember what I pinned before was the folder not 

the individual project. Now I’m not going to pin this on this occasion but I am going to select the 

wedding project, open it now. Obviously if I needed to use Browse or this PC or go to any other 

location that’s fine. And that gives me many options for opening existing projects. So I click on 

Wedding 01 and I’ve now got two projects open. There’s absolutely no problem with having two 

or more projects open other than switching between them and that’s what we’re going to look at 

next.  

There are a number of ways of switching between open projects. There are ways within Project 

and there are ways within Windows as well. 

Now the ways within Windows of switching between open projects to some extent depend on 

whether you’re using Windows 7 or 8 or 8.1 or 10. One way is to use the well-known Alt-Tab 

way of cycling through the running programs. Another way, and this I’m going to demonstrate in 

Windows 10, is if I move the mouse over the Project icon on the Task Bar I can see the two open 

projects. And all I need to do is to click on the one I want to work on and I’ll switch into that 

project and then obviously switch back just choose the other one. 

Within Project itself the way of doing this is if you go to the View Tab, in the Window Group 

towards the right hand end one of the options is Switch Windows. And if you click there you’ll 
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see a list of the open projects. And all you need to do is to select the one that you want to work 

on and then you’ll be taken into that one. So there’s a couple of options there for switching 

between open projects. 

So by now you should have enough tools and techniques to create a project, save it, close it, open 

it again, work on more than one project at a time. And it’s time for you to do the first course 

exercise. That’s what I’m going to set you in the next section so please join me for that. 
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Video: Exercise 01 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section I’m setting you Exercise 01 on the course. The information you need for Exercise 

01 is in the Exercise folder. It’s a text file, Exercise 01 Major Tasks.txt. And that list, the major 

tasks, the major headings for the bathroom refit that you’re going to plan. So I’d like you to use 

that list and produce a Microsoft Project 2016 project like this. 

Now note the name that I’ve given my sample answer, Simon Sez IT, etcetera, Project 2016 

Exercise 01. All of the sample answers that I provide will be in that same exercise folder. So 

make sure you finish up with something pretty close to mine. I appreciate that the start date for 

you will be a different start date than mine. That won’t matter as you’ll see as we go along.  

That’s it for this section. Please join me in the next one. 
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Video: Task Properties 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section we’re going to look at some other basic properties of tasks. And I’m going to 

return to that first version of the wedding plan. And the first thing I want to look at is the 

duration of a task. Now if I look at that first task, the one with the name Planning, and click in 

the duration field, the duration as I explained earlier has a default value of one day with a 

question mark indicating that it is an estimated duration. I can use these little rollers to increase 

the duration. Note that as soon as I do that what Project assumes I mean is that the estimation 

part of it is gone and I’m now saying, for example, that that is a two day task. And of course I 

can increase that duration pretty much as much as I want to. Or if I decided I’ve overdone it I can 

decrease it again.  

Now I don’t have to use those rollers. If I, for instance, went to the Attire field I can literally 

click in that field and type a date either looking at the field itself as I do it or of course looking at 

the entry bar. So I could for example say three days and tick that. And as you can see as I adapt 

and adjust the duration of the tasks the bar in the Gantt Chart on the right extends accordingly. 

Now we haven’t actually looked at the definition of working days and working weeks and 

working hours yet but you can probably see from that that when I’m talking about, for example, 

an eight day task I’m talking about eight working days and that doesn’t include days at the 

weekend with the current calendar that I’m using on this project. 

Now look very carefully at the Bar Chart on the right because for the tasks that still have a one 

day estimated duration you’ll see that at the right hand end of each of those you’ve got that 

vertical line. Now it’s pretty much coincidence that it’s at the right hand end of those bars. That 

vertical line indicates the current date. That’s the today line. So at any point you can see where 

today is in relation to the project. Or if you like where the project is in relation to today.  

And we talked already about project start date. Supposing I was entering this project and in fact 

the various aspects of it had started a couple of weeks ago. I’m a bit late setting the project up in 

Project 2016. So some of these things have happened already. What I could do is to change the 

project start date. So look, for example, at that first planning task, Thursday, December 17th, the 

start date. That’s the date that I entered it yesterday and that is currently the start date for this 

project. Let’s go into the Project Information and change the start date to a date two weeks ago, 

December the 4th. Click on OK. None of the durations have changed but each of the tasks has a 

new start date. 

Now of course I could change individual task start dates. So for instance, if I wanted to change 

the date that Attire task is starting, if I click in the start field and click on the dropdown I get a 

Date Picker. And if I decided well we’re going to need to look at Attire. We’re going to need to 

start to sort clothes out but we’re not really going to be able to do that until after the Christmas 
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holiday. So let me go right on the month there. Let’s go into January and let’s say that we’re 

going to start that on say Tuesday, the 5th of January. So that’s when that task is going to start.  

Now in doing that one of the problems I have is that that task is now shut off to the right in my 

chart and I can no longer see it. That may or may not be a problem but you know how to resolve 

that already because you know about the Zoom Slider. So let’s zoom out a bit. That’s better. 

Now I can see that Attire task in January 2016. 

And of course if I wanted to I could not only set the duration of each of these tasks but I could 

start to actually set them out in time. So for instance I could decide on a wedding day and 

assuming that I’m confident we’d be ready for that I could plot that at some time next year as 

well. And similarly for each of those other tasks I could set up duration, I could decide on a start 

date and I could start to put my project plan together with a lot more care and attention and 

hopefully with a lot more resemblance to what actually is going to happen. 

And that is indeed what we are going to be doing over the next quite a few sections. However, 

this project if it just comprised those roughly ten tasks would not be a very realistic project. And 

so we need to put in a lot more detail to make this into a realistic planning exercise. Now in order 

to do that you need to know quite a lot more about tasks. You need to know about dependencies 

and you need to know about resources. And one of the next things I’m going to tell you about, in 

fact I’m going to start on that in the next section, is you need to understand summary tasks and 

outlining.  

But for the balance of this section I want to look just at information about tasks. We’ve seen task 

name, duration, start date, finish date. I mentioned work once or twice. But in fact for any task in 

Project 2016 there is an awful lot of information about that task available and that you may need 

to be able to manipulate in some way.  

Now I’ve got the Attire task selected and what I’m going to do is to right click on that row, bring 

up the contextual menu, and one of the options about fourth from the bottom there is 

Information. I’m going to click on Information. And it brings up the Task Information dialogue.  

Now this is a dialogue with half a dozen tabs and each tab has information about the selected 

task. Much of the information won’t mean very much at the moment. By the end of the course 

most of it will. And some things, I think the descriptions you can see here, pretty much explain 

what that particular piece of task information is about. So for instance, you know about name but 

percent complete how much of that task have we done? We haven’t done any of it, 0% complete. 

It’s an auto-scheduled task. I briefly explained what that means. You can see the start date and 

the finish date there. It’s not an estimated duration so that checkbox is ticked. Three day task and 

it has a priority of 500. Now the other properties on this particular tab are ones we’re going to be 

looking at later on. But let’s look at the other tabs. What are its predecessors? Which tasks must 

happen before this one? Or in some way that it depends on? Which resources does it use? 

There’s also an Advanced Tab with information like deadlines, constraints, specific calendars to 
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use and so on. Virtually all of these we’re going to be looking at during the course. We can 

record notes about the task and we can even set up custom fields with custom information about 

the task. 

So that’s the Task Information for the Attire task. Let me Cancel that and just point out 

something I’ve mentioned a couple of times before. 

Task Information is a good example of something which you can get at in a variety of different 

ways. So with that same Attire task selected if I go to the Task Tab on the Ribbon there is a 

button in the Properties Group, Information, that brings up exactly the same dialogue. And in 

fact if I double click on the task that brings up that dialogue as well. So there are many ways of 

bringing up task information. But access to that dialogue and the contents of it are going to be 

very important to you. And if you want to do a little bit of extra reading note the Help button 

there. 

That’s it for this section. I’ll see you in the next one. 
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Chapter 6 – Subtasks 

Video: Subtasks 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section we’re going to look at summary tasks and outlining and I’m going to use the 

wedding project and demonstrate how we can build up the level of detail and the structure of this 

project.  

Now I mentioned a couple of times already that the tasks that I currently have in the project, 

planning, attire, guests, etcetera, are actually high level tasks. They really represent groups of 

tasks. And what we’re going to start to do now is to break each of those high level tasks, what 

we’re going to call summary tasks, down into individual tasks or subtasks. By the end of this 

section we’ll have a much more detailed project. But to get us started I want to look at one 

particular summary task. 

Before I really get started I want to point out two things. First of all, if you were doing a 

breakdown of the tasks involved in a wedding project, particularly if you’re doing it from 

scratch, you would almost certainly come up with a different breakdown to me. And in fact just 

about everybody who tries to do this comes out with a different breakdown. So there isn’t a sort 

of right answer here. It’s important that all of the necessary tasks in the project are represented 

ultimately in the project plan. But the way you do this breakdown will be a very subjective way 

indeed. 

And the second thing to point out is although I’m going to add quite a bit of detail to this 

wedding project plan I could add a lot more. We’re going to finish up with something of the 

order of somewhere between say 50 and 100 tasks in total. But if you really were doing this very, 

very thoroughly there would probably be hundreds and hundreds of tasks. 

So the task I’m going to breakdown is the Guests task. 

Now if I select the task underneath it, Venue, and right click on Venue and click on Insert Task I 

get a new task above Venue and that is actually going to be one of my guests subtasks. It gets a 

default name. Note new task there between chevron markers. And then default values for 

duration, etcetera.  

Now what I’m going to put as the name of that task, I just click in the Entry Bar and type the 

name in, is Make guest list. So that is my first guest related task. 

Now the important thing here is that this is actually a subtask of my Guests task. And in order to 

indicate that it’s a subtask I’m going to demote it in my task hierarchy. There is a button in the 

Schedule Group on the Task Tab. Let me hover over it and it says Indent Task. And indenting 
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that task automatically demotes it within the hierarchy. Watch what happens when I do that. 

Now not only does Make guest list get indented and that clearly indicates that it is a subtask of 

Guests but a number of other things happen as well. One of them is that Guests becomes bold, 

indicating that it is a summary task. And it also gets a tiny little wedge next to it. And we can use 

that wedge to expand and collapse the guests summary task. If I click on the wedge now I only 

see the summary task Guests. In order to see the subtasks, in this case there is only one subtask 

and that is Make guest list, I use the wedge, so I expand and collapse with that wedge. 

Now what I’m going to do is to put in the second subtask. Again I’m going to click on Venue. 

I’m going to right click and once again insert task. This new task clearly goes above Venue again 

but it also inherits the indentation level, what we call the Outline level of the task above it. So it 

automatically becomes a subtask of Guests because it gets the same indentation level as Make 

guest list. So let me type in now the name of that second task. Now you can see there how the 

text is wrapped. I need my task name column to be a little bit wider. So let me widen that out a 

little. If when I enter this, Send out invitation was not actually meant to be a subtask of Guests all 

I need to do is make sure I’ve got that task selected and then one of the other buttons in the 

Schedule Group on the Task Tab is Outdent Task. And that would as we say promote Send out 

invitations to itself be a summary task. Clearly a summary task with no subtasks at the moment. 

But I do want it to be a subtask of Guests so let me just indent it again and let me put in the third 

and fourth subtasks. 

So having entered the fourth subtask let me just point out something else here. Let me right click 

on Book guest accommodation. Note that indent and outdent buttons are actually on the mini 

toolbar here. So you could use that. And as usual as you’re working in Project 2016 Project itself 

offers you the most likely commands on either the contextual menu or the mini toolbar. So keep 

eye open for those because they often give you a very quick way of working on a task like this. 

Now at this point you may feel inclined to work out how long each of these tasks is going to take 

and when each of them needs to happen and so on. I don’t want you to worry about any of those 

things at the moment. We’re going to come back to durations and time scales and dependencies 

and so on as we go through the next sections on the course. All I want to do at the moment is to 

put in the structure of the project and then we’ll start to add the detail a little bit later on. 

Having said that there’s one more thing I need to show you here about summary tasks. Let me go 

to Make guest list and I’m going to increase the duration to eight days. Now if you look over at 

the Gantt Chart itself you’ll see that the Make guest list task is indeed now eight days long. But 

you’ll also see that the summary task no longer has the same type of bar representing it as a 

standard subtask. The summary task has a different format bar on the right there. Now we’re 

going to talk about Gantt Chart formatting much later on and you can in fact change most aspects 

of the formatting of these bars anyway.  
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But there’s two important things. One of them is that the summary task does have a different 

format of bar which helps it stand out on the right there. But also the summary task by default 

does not have a duration of its own. The duration of the summary task is actually the duration 

from when its first subtask starts right through to when its latest subtask ends. So the duration of 

the summary task is in effect dictated by the scheduling of its subtasks. 

What I’m going to do now is to insert the rest of the subtasks for this particular project. Now if 

you’d like to actually do this yourself rather than use the sample file, the demo file that I’ll tell 

you about towards the end of this section, there is a text file in the course file folder. And that 

lists each of the subtasks under its relevant summary task. So if you want a bit of practice you 

could go through and set these up. This is what you’ll see in that text file. It’s called SSI-Project-

2016-Wedding-Task-Breakdown.txt. 

So here is the revised wedding plan. This will be the version that I’ll save as Wedding 02, if you 

want to just take a look at it and perhaps compare it with a version that you’ve made yourself. 

And there’s one other area now we need to look. And in order to look at that area what I’m going 

to do is to add even more detail to this temporarily. I’m going to take the task Select and order 

wedding dress and I’m going to break that down into three further subtasks. 

So the first subtask is going to be Select wedding dress, indent that, and then two further 

subtasks. Now as you can see these three further subtasks are Select wedding dress, Order dress 

and Measurements and fittings. And we might, for example, breakdown Measurements and 

fittings into Measurements and then First fitting and Second fitting or something like that. So as 

you can see even at this early stage of planning the wedding we’re starting to get quite a deep 

structure to the plan.  

Now when you’re looking at a plan like this, and bearing in mind that we’ve still only got round 

about, what, just under 50 tasks in total, the highest ID number there is 43. If we really went in 

and put in all of the detail actually making your way around this plan would start to get quite 

complicated because it will look more and more complicated. We haven’t even started yet on 

durations and assigning resources and putting in dependencies and time constraints and so on. So 

there’ll be much more detail to add. And it’s usually the case when you start to increase the size 

of a project that you only want to look at certain parts at certain times or even that you only want 

to look at the project at a certain level. Now there is a straightforward way of determining the 

level of detail that you see in a plan such as this one. 

What I’m going to do is to scroll back up to the top of the plan. I’m going to select the Attire 

summary task. That’s the task with ID 4. And then on the View Tab I’m going to go to the Data 

Group and there is an Outline button. If you look at the description there, the Screen Tip 

description, Specify which outline level should be used in the view. For a large project you may 

want to collapse everything to outline level 1 or 2 and then expand only the sections that interest 

you. If I have Attire selected and click on the bottom of this Outline button, let’s see what 
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happens if I say Hide Subtasks. You now only see Attire and all subtasks and all levels below it 

are hidden. Let’s go back to the Outline button again. Now if I want to show the subtasks again I 

can just click on Show Subtasks.  

Now in fact I can apply the same principle to the whole project. So if I click on the bottom of the 

Outline button and say click on Level 1, Show outline level 1 look what happens. I see 

everything just at level 1. If I click on it and say level 2 I see everything at level 2. But note with 

Task ID 5, Select and order wedding dress under Attire, level 2 means that I don’t see its 

subtasks. I only see the level 2 task Select and order wedding dress. 

So as you can see the summary tasks like Planning and Attire and Guests are at what we call 

level 1 and the level below that is level 2 and so on. There is in Project 2016 a level zero. And 

level zero is actually pretty important so let me show you what level zero is. 

If you go the Gantt Chart Tools Format Tab, towards the right hand end in the Show/Hide Group 

there is a checkbox for Project Summary Task. And the Project Summary Task has some very 

important uses, some of which we’re going to look at during this course. So I’m going to check 

that which switched on the Project Summary Task. You can see there that the name of the task is 

basically the name of the file at the moment. So it’s SSI-Wedding-02. And there is a duration for 

the Project Summary Task which is in effect the duration of the project. And as we’ll see there 

are many aspects of the project that we need to use the Project Summary Task in order to deal 

with. But more on those things later. 

I can select the Project Summary Task. And if I went back to the View Tab and the Outline 

button and said Hide Subtasks, bearing in mind that this applies to the selected task, I would hide 

all subtasks and I would only see the Project Summary Task itself. Let me show those again. 

And then finally since I’ve put in the subtasks of task five here, Select and order wedding dress. I 

think I will leave those in for now. They may be useful to us a little bit later on.  

So that’s it on summary tasks and outlining. Please join me for Exercise 02 in the next section. 
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Video: Exercise 02 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section I’d like you to take the information in the file in the exercise folder, Project-2016-

Exercise-02-Task-Breakdown.txt and use that to create the fuller version of the bathroom refit 

project with structure. So for example in the Planning summary task there are six subtasks, 

Scoping, Select style, etcetera. And what you should produce will be hopefully similar to my 

sample answer to Exercise 02.  

Now notice I’ve still only got one day estimated as the duration of each task. But my project now 

has structure. And in particular note the Project Summary Task right at the top there, the task 

with ID 0. 

So that’s it for Exercise 02. My sample answer is in the usual place. I’ll see you in the next 

section. 
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Chapter 7 – Dependencies, Deadlines and Milestones 

Video: Linking and Unlinking Tasks 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to look at dependencies. And as we’re doing that we’re going to add 

quite a bit more detail to the plan for the wedding.  

A Dependency reflects the fact that some things happening depend on other things happening. 

The way in which they depend can be quite complex but in a very simplest type of dependency 

we would say that one task cannot start until another task finishes. But we can have much 

complex dependencies than that. And in particular one task may depend on many other tasks. 

Now let’s take a pretty straightforward Dependency to begin with. Let’s look at task six and 

seven, Select wedding dress and Order dress. Now clearly you’re not going to order the dress 

until you’ve selected it. But as soon as you’ve selected it you may want to order it. If I want to 

record in my schedule that one task is dependent on another the very simplest way of doing it, let 

me select the first task which is six, Select wedding dress, hold the Control key down, press 

seven, Order dress, and then on the Task Tab in the Schedule Group there is a button, a chain-

link button that says Link the selected tasks. You can link tasks so one can’t start until the other 

has finished. And this establishes the very simplest kind of dependency. 

If you look at the Gantt Chart on the right you can see an arrow indicating the dependency 

whereby task six must finish. You can see the arrow there starting, coming out of the finish of 

task six. And you can see it going into the start of task seven, Order dress. 

And if I pull the divider over here you’ll be able to see the contents of this predecessors column. 

And for task seven it now has a predecessor of task six. 

Now let’s look at the durations of these tasks. Let’s go back to Select wedding dress. This is 

obviously very difficult to be absolute about but let’s suppose that the bride has decided that in 

order to select a wedding dress. It’s really quite a long and complex process. She’s probably 

going to need a couple of months. So let’s say that in terms of working days, weekday working 

days, I appreciate that somebody wouldn’t be planning a wedding purely on the basis of weekday 

working but let’s work on that basis for the moment. Let’s call it eight weeks. Let’s call it 40 

days. So if I click in the Select wedding dress task, go to the duration, I’m going to delete what’s 

there already and replace it with 40 days. That’s fine. But in terms of ordering the dress. That’s a 

very quick task. That’s going to be a matter of perhaps going into a store and filling in a form, 

committing to spending a certain amount of money. Probably paying a deposit on the dress. 

We’ll talk about things like cost later on. And we’re really going to say that that order is going to 

be placed in a day. So let’s change one day estimated to one day without estimated. We can 
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either just delete the question mark or as you saw earlier on we can go into the Task Information 

dialogue and uncheck the estimated checkbox. 

Now once the dress has been ordered the measurements and fittings can start. There’ll be a 

sequence of these until the dress is finalized. And once again let’s assume that it’s going to take a 

total period of 40 days for that to all happen. So we can select task seven and we can select task 

eight. We could create a Dependency in exactly the way that we did before. If I right click on the 

selection, if you look in the mini toolbar there’s a link button there. So I can do the link that way. 

And I can do the link before I establish the second duration. So let me double click on task eight, 

change its duration to not estimated and 40 days. There we are. And at the end of task eight we 

should have a wedding dress that fits. 

Now let’s move on to task nine, Select and order bridesmaid dresses. Now this is not a task 

which is completely independent of the wedding dress because as I understand it in general the 

wedding dress would be selected first with a thought to what the bridesmaid dresses will be like. 

But you certainly wouldn’t start selecting the bridesmaid dresses till you were certain about the 

wedding dress. So let’s in this case say that the Dependency is that we’ll select the wedding dress 

before we select and order the bridesmaid dresses. Now in reality not only would Select and 

order bridesmaid dresses itself be broken down into subtasks but even some of those subtasks 

would probably be broken down further. So for instance measurements and fittings would 

probably be broken down into two or three subtasks. But let’s stick with the level of detail that 

we’ve got. Let’s establish that link and change the duration of the Select and order bridesmaid 

dresses from an estimated one day to a total of 60 days. And as you can see our schedule now 

takes us towards the end of April 2016. You can also see there that that one task, Select wedding 

dress has now a number of tasks dependent on it. And of course any task cannot only have 

several tasks depending on it but it can depend on several tasks as well. 

Now let’s start to look at these dependencies in a little bit more detail. There is a Dependency 

from task six to task nine. We just set that up. If I hover over the arrow that represents that 

Dependency there is a Screen Tip that comes up that gives me a summary of the Dependency. 

It’s an FS, a finish to start dependency. That means that the first task in the Dependency, that is 

Select wedding dress, must F, must finish before Select and order bridesmaid dresses can S, can 

start. And in fact if I double click on that line I get a Task Dependency dialogue where I could if 

I wanted to change that Dependency. 

So it says from Select wedding dress to Select and order bridesmaid dresses there is a finish to 

start dependency with a lag of zero days. Now if I had decided in this particular case that after 

the wedding dress was selected and at the point that we were going to order it we could certainly 

start looking at selecting and ordering bridesmaid dresses but we needed to leave a gap of say 

five days for some reason that would represent a lag of five days. And if I then click on that as 

my dependency what you’ll see is a five day gap. Effectively we finish Select wedding dress, 

then there’s a five day gap and then we Select and order bridesmaid dresses. So that’s a lag. And 
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I could also have said let’s have a lag of minus five days. Now what that is, a negative lag we 

often refer to as a lead. We still have a finish to start relationship but what the relationship now 

says is that the second task can start five days before the first task finishes. So we can actually 

get started on selecting and ordering the bridesmaid dresses five days before we finish selecting 

the wedding dress. 

Now I’m going to restore that to being a lag of zero days in a moment but first of all I’d like you 

to look at the predecessors column. If you look at task seven, Order dress, its predecessor was 

six. Look at task eight. Its predecessor was seven. Where all you see in the predecessor column is 

a number, that indicates a default finish to start relationship with zero lag. If there’s more 

complexity to the Dependency then you’ll see something such as you can see for task nine. The 

Dependency is on task six so it begins with a six. The FS basically says this is a finish to start 

dependency, which is the default. But the reason it says that is because it then says minus five 

days. So that code tells you that task nine has a finish to start relationship with task six which 

means that six must finish before nine starts but there is a five day lead. So in effect task nine can 

start five days before task six finishes. And whenever there is anything other than a standard 

default finish to start relationship, so if it’s any other type of relationship or if there is lag or lead 

you’ll see that coded in the predecessors column. 

So let me once again open up that dialogue and change that back to being a zero lag. And just 

before I change this back the way it was let’s look at those other types of Dependency.  

There are four types in total. It’s finish to start, the default. There is start to start which means 

that the second task can start when the first one does. Of course you can apply lag or lead to any 

of these. Finish to finish which means that the second task can only finish when the first task 

finishes. And there is a start to finish which means that the second task can’t finish until the first 

task starts. 

Now by far the most common Dependency is the finish to start but you are very likely to come 

across the others. And in the next section or two I’m going to show you one or two examples of 

these other types of Dependency. 

The next task that I want to look at is the task of Making the guest list. Now Making the guest 

list can be quite a long and controversial subject. I’m going to assume for the moment that it’s 

going to take maybe three to four weeks to try to make sure that everybody that should be invited 

is invited. So let’s change that eight days to fifteen. But let’s also say that once we’ve got some 

guests on the guest list who are definitely going to be invited we might start sending out the 

invitations pretty much straightaway. So sending out the invitations would be a task that would 

pretty much run throughout the period of Making the guest list. We may even wait and see what 

responses we get to some of the invitations until we decide if you like close the guest list. So 

let’s extend Send out invitation to be say a 20 day task. And let’s say that it’s going to start five 

days after Making the guest list starts. So once we’ve been working on the guest list for a week 
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we’re going to start sending out the first batch of invitations and see what sort of responses we 

get. So we’ll link those two. And then what we’re going to do is change that Dependency from 

finish to start to start to start and put in a five day lag, start to start. 

We need to allow time for people to respond to invitations. As usual quite a controversial 

subject, how long you would give people to respond to an invitation. But probably a figure of 

something like two or three weeks. So you’re going to start sending out invitations on a 

particular date and then over a period of time you’ll send out some more and you’ll start to get 

replies back. But in reality you can’t really finalize the guest list until you’ve received all of the 

responses to the invitations. So what I’m going to do is to create a link between Send out 

invitations and Finalize guest list that works on the principle that you need to allow say three 

weeks from the end of sending out the invitations before you can actually finalize the guest list. 

So I’m going to create a link between those two and I’m going to put a lag of fifteen days in. 

And then instead of saying that it’s a finish to start link I’m going to say it’s a finish to finish 

link. And I’m going to say that Finalize guest list is just say a five day task. And what you can 

see there is a situation where at some point before our deadline we’re going to start to finalize the 

guest list but we’re not actually going to be able to finish it until fifteen days after we’ve sent out 

the last invitation. Now of course the way that I’ve done that was partly just to demonstrate these 

type of dependency. But you’ll see from that also that when you’re setting up dependencies there 

are often a number of options to consider. And coming up with the right sort of dependency can 

sometimes involve quite a bit of thought and discussion. 

So we’ve put in quite a bit more detail into our plan now for the wedding. In the next section 

we’re going to look at Constraints and Deadlines and we’re also going to do a little bit more on 

dependencies as well. So please join me for that. 
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Video: Setting Constraints and Deadlines 

Toby: Hello again and welcome back to our course on Project 2016.  

Since we last looked at the wedding plan I’ve added quite a bit more detail to it in terms of the 

durations of many of the tasks and quite a few straightforward dependencies. So for example, if 

you look down at ID 20, Catering, within that there are two pairs of tasks, Make caterer shortlist 

and then Book caterer and Finalize menu. I’ve allowed fifteen days for making a shortlist of 

caterers and talking to them, making a decision about which one to book and then finalizing the 

menu with them. I’ve allowed fifteen days for each of those tasks. And then I’ve done the same 

for the baker, the baker who’s going to make the wedding cake. 

Now it may look from the current plan that we could get this wedding through very, very 

quickly. But as you can see one of the main issues is that we’re doing everything all at once right 

at the start of the project. And in reality that’s not what would happen. There just wouldn’t be 

enough time in a short period of time, of in this case a few weeks, to do all of those things at the 

same time. And as we’ll see later on in the course there are various factors, various reasons that 

will force us to spread these activities out over time. But for the moment I want to just leave the 

plan like this except for adding a few dependencies that are really very important. 

Now one situation that arises very often when you’re working on projects is that there are one or 

two key decisions to make. And there are certain things you must do before you make those key 

decisions and there are certain other things you can’t do until after you’ve made those key 

decisions. And what I want to look at first in this section is the very key decision of the wedding 

date, the date of the wedding itself. Now you can’t do everything before you decide on the date. 

So for example we talked in the previous section about making out the guest list and sending out 

the invitations. You can’t send out the invitations until you’ve set the wedding date. But you 

can’t set the wedding date until you know that the venue you’re going to use is available. You 

may also want to make sure that the venue you’re going to use for what we call in the UK the 

reception is available as well. But you are going to have to take some things on trust. So for 

example, you may have to say well I’m going to fix the wedding date and then see which 

photographers are available and book one of those photographers. So what I’m going to assume 

here in the wedding plan it that there are two or three key things that must happen before we can 

set the wedding date. And that from that point onwards various other things will be dependent on 

knowing that wedding date. 

So appreciating once again that there is quite a lot of detail missing from this plan. I’ve been 

through the plan and I’ve decided that the two key things that I need to do are 18, that is Book 

the reception venue, and 38, that is Book the wedding venue. 

So I’m going to go up to Set wedding date and rather than use the linking mechanism that I’ve 

used before I’m going to type those IDs straight into the predecessors field for Set wedding date. 
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So I’m going to put in 18, 38 and tick it. And that gives me a date on which I’m going to set the 

wedding date. I should point out that this is not final yet because we have a few more hurdles to 

overcome a little bit later on. And then from the setting the wedding date, for example, I can say 

well if I select Set wedding date then certainly sending out the invitations will be dependent on 

that. In reality I need a task in here that says Print the invitations but let’s just stick with Send out 

invitations for now. Put in the linkage for that. And now we have a more realistic representation 

of when we’re going to be in a position to send out the invitations. 

Particularly in the early stages of creating a project plain it’s important to review the plan from 

time to time to make sure that things haven’t been missed. I’ve left a couple of items here which 

clearly have dependencies that aren’t currently represented in the plan. So for instance, task 19, 

Plan and finalize seating arrangements, and that will clearly need to have the guest list finalized 

before it can happen. So really a predecessor of Plan and finalize seating arrangements should be 

task 14. 

Now there are still one or two key dependencies that I haven’t put into the plan yet but I want to 

turn my attention now to Constraints and Deadlines. 

Let me insert a completely new task into this schedule. And you see that it is inserted at the 

project start date. We changed that option much earlier on in the course. And if I open up that 

task and go to its Advanced Tab I’ll see that the Constraint on that task is that it should Start as 

soon as possible. And when scheduling from a start date and when you have the project start date 

as the default date for new tasks that is the Constraint that new tasks get. Generally speaking they 

should start as soon as possible. 

There are a number of constraints that you can set on tasks. As late as possible. This is the 

default when you are scheduling to an end date. But you can also say that a task should Finish no 

earlier than a specific date, Finish no later than a specific date, it must Finish on a specific date, it 

must Start on a specific date, it must Start no earlier than, or Start no later than a certain date.  

Now it’s quite often external factors that mean you need to put constraints other than 

straightforward ones such as soon as possible onto a task. In many cases when you’re scheduling 

from a start date as we are here As soon as possible is the best bet because you’re basically 

trying to get all of the tasks done as soon as possible without restricting Project to doing certain 

things on certain dates. But let’s take an example of a possible Constraint. 

Let’s suppose that we already know that one of the bridesmaids who is the bride’s sister is 

actually out of the country. She’s working abroad at the moment and she’s not going to be 

available for the Select and order bridesmaid dresses task until the beginning of March 2016. So 

whatever else happens she won’t be available until then. Now if I double click on that task and 

go to the Advanced Tab I can say Constraint, Start no earlier than and then I can choose a date of 

March1, 2016. And when Project 2016 schedules the wedding it will take into account that 

constraint that we can’t start earlier than that. Now you may want at this point to put a note in 
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here to remind yourself why you put that Constraint in. But as you can see Project 2016 has 

successfully rescheduled that task to make sure that it doesn’t actually begin until the beginning 

of March. Now with the plan as it is at the moment and considering that particular task the 

Constraint that we’ve just added really has had quite an impact on the duration of the whole plan. 

So you’ve seen there an example of a Constraint. Let’s look next at Deadlines. 

Deadlines in many ways are quite similar to Constraints but there are two or three really 

important differences. One difference is that a Deadline is very easily visible in the Gantt Chart. 

It’s actually a physical marker in the Gantt Chart. And you get not only a marker in the Gantt 

Chart but you can get warning indicators in the indicator column to the left of the table. Another 

major difference is that although Constraints are used in scheduling, as you saw just now with 

the limitation on the availability of one of the bridesmaids Deadlines are not actually used in 

scheduling. They are used in some calculations associated with scheduling but they don’t 

actually affect the schedule itself. So let’s suppose that we decided, obviously we would want the 

wedding to be a success, but if possible we’d like it to before the beginning of September 2016, 

partly because of the weather.  

So what I’m going to do is to go down to the Wedding date task itself, the Wedding day, 41, 

open that up. And I’m going to go to the Advanced Tab and I’m going to put a Deadline on it. 

And the Deadline I’m going to put on it is September 1, 2016. Click on OK. Now you can’t 

actually see September at the moment in the Gantt Chart on the right there so let me just zoom 

out a little. And now you can see that Deadline marker, the green arrow there. If I hover over it 

Deadline task, Wedding day. Deadline Thursday, September 1st. Now that’s a purely visual 

marker. It won’t put a physical limitation. But clearly as we work further on the plan we need to 

try to make sure that the wedding day never moves to the right of that date. We’ve got quite a lot 

more to do on it yet so we don’t need to worry about it too much at the moment. And as I say if 

we do start to get a problem we will see an indicator in the I column to the left of the table. 

So I have two other things to do in this section, both fairly quick things to show you. First of all 

I’m going to go into Options and you may recall on the Schedule page one of the options, Auto-

schedule tasks scheduled On and we changed it to Project start date which is the setting that I 

usually use. But let me just change that to Current date, click on OK and insert another new task. 

Now if I look at the Constraints on that new task it doesn’t have an As soon as possible 

Constraint. It has a Start no earlier than Constraint of today which means as the constraint 

implies that that task cannot be scheduled by Project 2016 to start earlier than that date. So that’s 

an important distinction. I’m now going to Cancel that. I’m going to delete both of those new 

tasks. So right click, Delete, right click, Delete. And I just change that option back to the setting I 

prefer of project start date. 

The second thing that I want to do here is to make quite a big change. Right near the beginning 

of the plan task ID 2, Agree budget and approach. In terms of project management itself quite 
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often projects have phases. And probably the most likely phase with a wedding planning project 

would be that we’d start off by saying well, “How much money are we going to need to spend on 

this? What sort of level of spending are we looking at? And what will our approach be?” So for 

example, are we talking about a relatively small family wedding with maybe just immediate 

family, a dozen people, maybe twenty people? Or are we talking about a much grander affair 

with 200 or 300 guests and maybe even more than that attending the reception and entertainment 

in the evening?  

Now really that particular task is a precursor to virtually everything else within the schedule. 

And sometimes when you’ve been looking at a plan for a while like this one you may decide 

actually I’m not 100% sure about that planning task at the beginning there because setting the 

wedding date and agree budget and approach are really two completely separate tasks. So what 

I’m going to do is I’m going to promote task 2, which I can do from the mini toolbar, and I’m 

also going to promote Set wedding date. And I’m going to remove that planning task which now 

no longer has if you like a life of its own or any function of its own. And then I’m going to make 

task 1 a predecessor of each of the summary tasks. So 3, Attire, its predecessor is 1. So what I’ve 

done is to go through and put task 1 as a predecessor on each of those other summary tasks. And 

this reflects the fact that as you get more and more detail and accuracy in a plan you may well 

want to restructure it. You may want to take everything from Attire onwards and put that inside a 

sort of super summary task which would make it much easier to represent the fact that everything 

in that task follows after the task with ID 1. 

Something else you can do which often makes it easier to read a plan, to understand the structure 

of it. If I select task 3 on the Task Tab in the Insert Group on the Task button one of the options 

is Blank Row. And you can insert blank rows quite neatly into a project plan. And very often that 

emphasizes the structure of the plan. 

Note also, let’s take this task here with ID 1. If I insert a blank row watch what happens to all of 

the predecessors in the predecessor column. That task is now task 2 and of course other task IDs 

are updated accordingly. But Project 2016 takes care of all of that for you. 

That’s the end of this section. I’ll see you in the next one. 
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Video: Setting Milestones 

Toby: Welcome back to our course on Project 2016.  

In this section we’re going to look at Milestones. And Milestones are used to denote significant 

points or events in a project. Usually milestone tasks have zero duration but Project 2016 does 

allow milestones with non-zero durations as well. 

Milestones are used for a number of different purposes. And amongst the most important ones 

are as a way of providing a management snapshot of progress on a project. So there is for 

example a particular report called a Milestone Report where you can just view the key 

milestones in the project and get a summary of where you are in terms of those milestones which 

in turn gives you a good idea of general progress on the project. 

They can also be used to show you what’s coming up next, what’s happening say over the next 

week or the next month or the next few days. And very often milestones are associated with a 

payment schedule of some sort. So for example, when a particular point is reached in a project 

there may be a payment to make.  

Now what I’m going to do with the wedding project is to take some of the existing tasks and turn 

them into milestones. And I may well introduce one or two new milestones as I go through. 

Before I start note what I’ve done with the project at this stage. This is version 03 of the project. 

I have collapsed all of the summary tasks. Note that when I do this you can’t see all of the 

dependencies. So for instance, there is a dependency between a task in Wedding day and the 

setting of the wedding date. But because Wedding day is collapsed you can’t see that link. If I 

expand Wedding day that link is now visible Note the link from Book wedding venue, task 40, 

up to Set wedding date. But when Wedding day as a summary task is collapsed you can no 

longer see that link. So this just emphasizes the point that when you’re looking at a project with 

some summary task collapse you need to be careful at what you’re interpreting because some 

elements of the project may have become invisible even though they’re actually quite significant. 

Now one very important aspect of Milestones is that generally speaking although I should say 

there are exceptions, but generally speaking because a milestone is a task of zero duration it is 

assumed that there is little or no work associated with the milestone itself. If I take task 4 here, 

Set wedding date, if that doesn’t actually involve any significant amount of work I could make it 

into a milestone. But what I’m actually going to do on this occasion is to insert specifically a 

milestone which indicates when that task has been completed. So I’m going to select the task 

below it which is basically a blank row and then on the Task Tab in the Insert Group I’m going 

to say Insert Task. Now that task I’m going to rename to Wedding date set. So that’s basically a 

statement that something has happened. It isn’t something to do itself. And then in the duration 

for that task I’m going to change it to zero days which will make it into a milestone. And the 

default notation, the default symbol in a Gantt Chart for a milestone is a diamond. So now I’m 
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going to select Set wedding date and select Wedding date set and link them in the usual way. 

And I have my first Milestone in my project. 

Now I’m also going to set milestones that indicate when the venues have been booked, the venue 

for the wedding and the venue for the reception. So let’s start with the reception venue. So I want 

something to indicate that task 21 has been completed. I can do the same that I did just now, 

Insert Task, but there’s also an option within the Insert Group on the Task Tab of Insert 

Milestone. So that automatically gives me a task of zero duration. Let’s change the name. Once 

again put in the linkage and do the same down here for the wedding venue. And then I’ve just 

got a very few other milestones to add. I’m going to add one to indicate that all of the attire has 

been ordered, one to indicate that the guest list has been finalized and finally that the wedding is 

registered and licensed. 

And then I have just one more thing to do and that is that I’m going to turn the wedding date 

itself into a milestone. But I don’t want to reduce its duration to zero days because there will be 

things to do on the wedding day itself. So what I’m going to do is to double click on the wedding 

day and I’m going to use on the Advanced Tab this little checkbox in the bottom left hand 

corner, Mark task as milestone. Click on OK. The task is now marked as a Milestone. But as you 

can see its duration is a day. And there will be work for people to do on that day. Let’s hope they 

don’t think about it too much as work. But as far as Microsoft Project is concerned it is work. 

So there we are. We have some milestones in our project. I’m going to take a look at those in just 

a moment. Before we do I don’t actually need the Timeline at the moment. And the project is 

beginning to take up more and more space. So let’s save a bit of space by hiding the Timeline. 

Can you remember how to do that? You go to the View Tab and you can just switch off the 

Timeline. So uncheck that checkbox in Split View and we now have a little bit more space to see 

the project.  

If you only wanted to see the milestones you can use one of the features of the View Tab which 

is to use a Filter. And in the Data Group on the View Tab there is a Filter control with a 

dropdown there and one of the options on the dropdown is Milestones. And if I select that I will 

only see the project milestones. 

And that gives you some idea of how useful milestones can be in terms of setting out the key 

points in the project over the course of its duration. 

Now one other point that’s clear here is that we still have a lot of work to do on this project 

because for instance we still haven’t worked out when the wedding day is going to be. It’s still 

right near the beginning of the project. Now you might be a little bit frustrated by this and 

thinking well why don’t we sort out the wedding date? Well the reason that we don’t is that we 

still have some very key factors to take into account before we can work out when the wedding 

date can be. And we’re going to be moving onto those factors after we’ve done Exercise 03. 

Once we’ve done those we’ll be in a better position to actually pin down a wedding day and then 
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we’ll see again how useful these milestones can be in terms of giving us a realistic summary of 

the key points in the project. 

Now if you have applied a filter as I have here I can un-apply it by clicking on that dropdown 

again and saying No Filter. 

That’s the end of this section. Exercise 03 is the next one so please join me for that. 
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Video: Exercise 03 

Toby: Welcome back to our course on Project 2016. 

In this section I’m going to set you Exercise 03. And as exercises go this is actually quite a long 

exercise. It will take you a little while to work your way through this one. And it has a few 

constituent parts.  

What we’re going to do is to take the bathroom refit project and not only are we going to add the 

durations of the various component tasks but we’re going to put in dependencies and we are 

going to change the overall structure of the project for reasons that I’m going to explain first. 

Now sometimes when you go through a project and have your first try at listing all of the tasks 

and as we’ve done here grouping them together in some way you might be quite successful and 

make a thorough list of what’s required in the project. But you won’t necessarily structure it in a 

way that lends itself either to easy scheduling and planning or to easy understanding. And you 

can finish up in a situation and this is what was happening in the wedding project that you finish 

up with many, many complicated dependencies. So for instance, I have a task here, Preparation, 

task 16, and one of its subtasks is Prepare for painting. Now we know that further down in the 

plan we have a Paint task. And clearly one predecessor of the Paint task is going to have to be 

prepare for painting. But there will also be various tasks following on from painting that depend 

on it, such as actually fitting the equipment. Now whilst a number of dependencies are obviously 

going to be the cornerstone of scheduling the project you can greatly simplify the structure of the 

project once you’ve got your basic list of tasks by dividing the project into phases and making 

each phase as self-contained as possible.  

Now what we’re going to do with the bathroom refit project is to make four phases. We could do 

it in three but I’m going to make it into four phases. And from the point of view of dependencies 

each of the four phases is going to be self-dependent. It’s going to be independent of the others.  

Now looking at what’s involved in this bathroom refit, the four phases that I think that we should 

divide the project into are basically a planning, a phase of activities that happen before we start 

doing the work. So the planning certainly but also arranging the finance and appointing the 

contractors. All of that’s going to happen, those first three summary tasks are going to form one 

phase. The second phase is going to be a purchasing phase. There’s quite a lot of selecting to do. 

I need to select paint, equipment, tiles, and so on. And I need to order it and get it delivered. And 

I’m going to get all of that done before the work actually starts. Now of course you could have 

some of the materials arriving once work is started but for the purposes of simplicity and 

planning this project I’m going to get all of the purchasing done and all of the deliveries arranged 

before I actually start doing any work. The third phase will be the work itself, the 

implementation itself. We’ll call that the implementation phase. And then the final phase will be 
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one where any snags are dealt with and there’s a sort of cleaning up phase, making sure that 

everything is ready to be used. 

Now in order to give you the information you need to do this division into four phases let’s take 

a look at my answer to Exercise 03.  

So there you see the four phases as collapses summary tasks. Task 2 is the planning phase 

summary task. It’s total duration is 12 days. And you see the columns of information. Clearly the 

values in the duration columns for the summary task will be derived from the durations of its 

subtasks. But the predecessors column shows you the predecessors of summary task. And the 

successors column shows you the successors of the summary task. So if you take, for example, 

task ID 21, Purchasing phase. It’s predecessor, the one it depends on is task 2 which is the 

Planning phase and its successor, the one that comes after it, is task 40 which is the 

Implementation phase. So you can see there the very simple structure of the overall project in 

those four phases. 

Now if I open up one of the phases, I’ll give you an overview now of the dependencies and how 

they work within the phase. 

Within the Planning phase there are three summary tasks, as before, although I have moved 

Finance after Contractors. And basically with these three summary tasks the individual durations 

are there and lots of individual dependencies within the planning phase are there. So for instance, 

Scoping, task 4, has five successors, 5, 6, 7, 8, and 9. And these include selecting the style, 

deciding whether we’re going to have a project manager or not, checking what permissions are 

required if any to do the work, fixing the dates for the works, and arranging temporary 

accommodations to use while the bathroom is out of action. And then we have the summary task 

Contractors where we get some contractor recommendations, make a short list, get some 

quotations, appoint the contractors. Note that the Get contractor recommendations task runs in 

parallel with some early phases of planning. But we won’t be getting contractor quotations until 

the planning summary, task 3, is complete because we want to be clear about exactly what we’re 

expecting the contractor to do. Implicit in this arrangement is the fact that we don’t believe that 

any choices we make about tiles and so on will significantly affect the contractor quotation. 

That’s another point to bear in mind. If the contractor says well depending on the type of floor 

you get or the type of tiles you get you may increase or decrease the cost of the quotation. One 

would normally have to bear that in mind. 

So that’s the Contractor summary task. Then we have the Finance summary task. Once we’ve 

got our contractor quotations we can set about arranging the finance. 

Now in order to help you to get all of these numbers right, to get the durations in, get the 

dependencies right and so on I’ve prepared a text file for each of the four phases which is in the 

exercise folder and it lists the durations and the dependencies, the predecessors and successors in 

terms of the task IDs in my answer to Exercise 03. If for some reason your IDs are differently 
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numbered to mine then clearly that will affect all of these predecessors and successor values. But 

hopefully your ID numbers are the same as mine. So you should be able to use this to help you 

not only to enter the appropriate durations but also to setup all of the correct dependencies. 

So you’re looking now at the text file for the Planning phase. There is a text file for each phase 

in the exercise folder. 

So here’s the Purchasing phase. You may be wondering throughout why you can’t see start and 

finish dates here in my answer to Exercise 03. Well whenever you’re working your way through 

Exercise 03 it won’t be on the same dates that I’m recording this. So to a large extent the dates, if 

I gave you my dates wouldn’t really help you. The durations are important, the dependencies are 

important but I’m assuming throughout that your dates will be different from mine. But I’ve got 

a little twist in the tail of that towards the end of this section on Exercise 03. 

Okay so that’s the Purchasing phase. Pretty straightforward. It includes the delivery of each of 

the materials, tiles and so on. So at the end of this I’ve introduced a milestone there, task 38, All 

materials on site as a significant milestone in the project.  

Next we have the Implementation phase. Let me explain the main points here.  

We set up a skip, a receptacle for the waste products which arise from gutting the existing 

bathroom and from the building work that we’re going to do in fitting the new bathroom. Then 

we have a lot of preparation to do. Prepare for tiling, prepare for flooring. So there may be joist 

work to do. There may be plastering to do, etcetera. And we do the first fix electrics and the first 

fix plumbing. These are the electrics that go over the ceiling, behind the walls, under the floor. 

Similarly the plumbing that you can’t see. The waste pipes and so on. Then we do the painting, 

the flooring, the tiling, any other wall work that’s needed, general building work there such as 

55, 57, 59. Then we start the second fix electrics. This is things like putting the sockets on the 

walls. And the second fix plumbing which will be things like the pipes from the pipework behind 

the walls, but this is the visible pipework that connects up to the taps, the faucets. It’s often the 

case nowadays that there is some kind of electrical certification needed once the electrical work 

is finished. So that’s task 50 here. And then once the second fix is underway fitting the 

equipment begins, task 61. And when the fitting of the equipment is finished we have a 

milestone, task 62. 

The final phase, the Completion phase, is simplicity itself. We have a task to resolve any 

outstanding snags, we clean up and we declare the refit complete. 

There is one last part to Exercise 03. And the last part is to move the start date of the project to 

the first working day of the month following your current month. Clearly your dates will be 

different to my dates. I’m doing this in late December 2015. So I’m going to move the start of 

this project to January 4, 2016 which is the first working day for me in that year. When we 

looked at the Project Information dialogue earlier on in the course you saw a way of changing a 
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project start date. But once you’ve got a project setup and you have constraints and deadlines 

setup the way that you would change the start date of  a project so that the constraints and 

deadlines are moved in line with any change you’re making is to use the Move Project option 

which is in the Schedule Group on the Project Tab. You choose your new start date. In this case 

I’m going to choose January 4, 2016. Make sure that Move Deadlines is checked. That will move 

the deadlines and constraint dates. Click on OK and my project is now moved to start on January 

4, 2016. 

So that’s the last part of the exercise for you. That’s the end of this section. I’ll see you in the 

next one. 
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Chapter 8 – Resources 

Video: Filling Up the Resource Sheet 

Toby: Welcome back to our course on Project 2016. 

In this section we’re going to start to look at Resources. Resources include the people involved 

in a project, they include equipment and materials used, and various other types of resource, 

notably cost associated with a project. When you look at a Gantt Chart such as this one you’re 

primarily looking at tasks. The table on the left gives information about the tasks and the chart on 

the right gives a pictorial, a graphical representation of the scheduling of the tasks, their 

durations, dependencies, and so on. 

Now tasks and resources are basically the two building blocks of a project in Microsoft Project 

2016. And we link the two together using what are called Assignments or Resource 

Assignments. In this section we’re going to look at Resources and in the next section we’re 

going to look at Resource Assignments. 

One thing that you may have noticed when we were using the View Tab before is that the first 

two groups on the left are Task Views and Resource Views. And largely speaking when we’re 

looking at a project we tend to be looking at tasks or at resources. But there are many views that 

enable us to look at both. And in particular to look at the relationship between them. Usually so 

far when we’ve been looking at tasks we’ve used Gantt Chart View. And for most people that is 

the view that they use most of the time. Of the Resource Views a very popular view is Resource 

Sheet View. And that’s the one that we’re going to look at first. So if I click on Resource Sheet, 

this spreadsheet gives us information about all of the resources in our project. And at the moment 

as you can see we have no resources in our project.  

Now we’re going to start to add some resources in just a moment. But before we do just look 

down at the right hand end of the Status Bar. Two of the main icons there are on the left here the 

button to take us to Gantt Chart View and three to the right, the one that looks just like a 

spreadsheet, that one takes us back to Resource Sheet View. So you’ll probably get used to 

switching between those two. The two views between them are also very commonly used. Task 

Usage which basically lists tasks and shows which resources are used in a task. And at the 

moment we have no resources so there’s nothing being used. And the next one is Team Planner 

View which can enable us to look at how the work on a project is distributed between a team. 

Now at the moment we have no team because we have no resources to put into a team. So let’s 

go back to Resource Sheet View. 

The two main projects that I’m using on this course differ in many ways. And perhaps the 

biggest difference is in the resources that they use and the way that they use those resources. 
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In the case of a wedding some of the people resources involved which would, for example be the 

bride and groom, won’t be charging for their time. And also the wedding won’t involve using 

lots of consumable materials, not in any case in the way that a building project, a bathroom refit 

project would use materials such as paint and floor tiles and that kind of thing. The difference is 

going to be even bigger when we start looking at costs because when it comes to cost, for 

example, the bride and groom wouldn’t expect to charge their time on this project to people 

whereas the people working on the bathroom refit will be charging their time to whoever is 

paying for the bathroom refit. So there are many differences between these two projects in 

relation to how they handle resources and the associated costs. But I hope that by dealing with 

two such different projects we’re going to deal with many of the situations that you’re likely to 

come across in future when using Project 2016. 

As we add resources to the Resource Sheet each row on the sheet represents a resource. And 

each column represents a property of that resource. The first resource that I’m going to add to 

this project is the bride. And first of all I need to say what type of resource the bride is. There are 

basically three choices, work, material, and cost. And as we’re going to see this is not always a 

particularly easy choice to make. Generally speaking people are entered onto the resource sheet 

as work resources because they do work. And whether or not they charge for that work is a 

separate matter. But we expect them to perform tasks and complete work rather than as in the 

case of say materials be consumed by a job, used up in doing a particular task. Or a cost where 

we basically say with a task that it has a certain cost but isn’t necessarily performed by an 

individual or involve the consumption of some kind of material. Now we’re going to see 

examples of each of these three resource types but we’re going to work for the moment on the 

principle that when we add people we’re adding work resources generally. 

Now when I choose a type for a resource I will get a different accessible selection of properties 

here. So for instance, when I declare that a particular resource is a work resource I can specify 

their standard rate. And the standard rate here is $0 per hour. And I can specify their overtime 

rate. Now as I mentioned just now the bride is not going to be charging for her time on this 

project so we don’t need to assign a standard rate or overtime rate for the bride. We do however 

need to declare how many brides we have. And we only have one and she is represented by 

100%. If I were dealing with say bricklayers and I was building a house I might say I’ve got 

three bricklayers, so that’s 300%, and I could say the standard rate that it costs me to employ 

those bricklayers and then I can also enter an overtime rate. I also have here a cost per use. So if 

a particular resource has cost per use. So for example, if I’m dealing with something where 

there’s a setup fee, perhaps a delivery fee or a contract fee or a hiring fee or something, a one-off 

cost I can specify that here. And I will normally also specify an accrual method. Now for the 

moment I want you to ignore accrual and I also want you to ignore the next column which is the 

calendar that this particular resource uses, which by default is our standard base calendar. Now 

we’re not looking at calendars at the moment so just ignore both accrue and base. 
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Now when it comes to using any resource on a project it’s always a good idea to give that 

resource initials whereby we can identify that resource, for example, on a Gantt Chart. So for the 

bride I’m literally just going to put Bride as the initials. So that’s my first resource setup. 

Now it would only seem right to add the groom as my second resource. So my project now has 

two resources. 

The next resource I’m going to setup is a little bit controversial really. I’m not really sure you do 

it this way but you certainly could do it this way. And I’m going to add a resource, wedding ring. 

And I’m going to say that it is a material resource. You could actually work it that way. It may 

seem a little bit heartless in a way but let’s call it a material resource. And I’m going to give it an 

initials of Ring. And note that when I chose material some of the other fields, some of the other 

properties changed. So for instance Max was cleared out. It no longer said 100%, the default for 

a work resource because we’re not talking about having a maximum number of rings. We can 

basically buy as many rings as we want, subject to available funds of course. And similarly the 

standard rate changed from being dollars per hour to just dollars because we’re not talking about 

a rate of pay for somebody for a work resource, a person. We’re talking about the cost of a 

material. When you’re dealing with cost for materials you also declare what units the cost refers 

to. So if instead of wedding rings I was dealing with building bricks I might record a cost here 

for 1,000 bricks. And what I would put here in the material column might well be 1,000 for 

1,000 bricks. For the price for a ring will be a price per ring. And let’s suppose that the price I’m 

working on here is $500 per ring. And that is all the information I need to setup that material 

resource. So at whatever point I decide to buy one or more wedding rings in my project the cost 

will be recorded in the project as $500 per ring. 

Now for an example of a cost resource. And it’s going to seem now as though I’m disagreeing 

with what I said earlier in this section. Sometimes a person working on a project is not really 

working on it as though they were say a builder or in this case the bride or groom, somebody 

who’s directly involved in a number of tasks on the project. What they are doing is more of if 

you like a service. So I might choose to make the photographer or videographer for this project a 

service, a cost to the project. We’re not talking about paying this person by the hour. We’re 

talking about their standard charge for photographing or videoing a wedding. So in this case I’m 

going to add a resource Photographer and not deal with the photographer as though he or she is a 

person working on the project but deal with them as a service to the project, a cost to the project. 

So on this occasion I’m going to make the type cost. The initials I’m going to apply are Photo. 

Now you notice there that there is no highlighted cost rate field with dollars, 0.00, whatever as 

we had before for work or material resources. And in fact the best way to record the cost of a 

cost resource in a particular situation is to assign that cost when you assign the resource to the 

task. And I’m going to show you how to do that a little bit later on. At the moment the important 

thing is that we have listed our cost resource here, photographer, and of course with this project 

there will be many other cost resources. 
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It’s true to say in this particular case that many of the resources, things like wedding dress and 

even wedding ring might reasonably be considered to be costs rather than materials. But as I said 

earlier on in this section sometimes it’s actually quite a difficult decision to make and you’ll 

certainly find that you have your own approach to determining which is the best way of dealing 

with resources on your own projects. 

Having setup a few resources there we’re going to do a little bit of resource assignment in the 

next section. But there’s one more thing to show you in this section. If I select one of the 

resources note that there is a Resource Tab. And one of the options on the Resource Tab is 

Information and that brings up the Resource Information dialogue which is a direct parallel to the 

Task Information dialogue, except of course this one relates to resources. As with the Task 

Information dialogue you have a number of tabs and these tabs have already got the information 

we’ve entered so far on. But of course there’s other information that you can add, some of which 

we’ll be looking at a little bit later on in the course. 

There are of course other ways of getting at this Resource Information. You can right click and 

there is an Information option on the contextual menu. And of course just double clicking on a 

resource brings up the Resource Information dialogue as well. 

That’s it for Resources for the moment. I’ll see you in the next section. 
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Video: Resource Assignment Basics 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to look at the basics of assigning resources to tasks.  

In the previous section we set up a few resources for the wedding project. Clearly there are going 

to be many more. But let’s switch back to Gantt Chart View using the button towards the right 

hand end of the Status Bar. And I’m going to choose one of the tasks and assign resources to it.  

Select Agree budget and approach, right click, and click Assign Resources. Now that brings up 

the Assign Resources dialogue. And in the dialogue you can see a list of the available resources. 

Later on in the course we’ll look at the fact that as the number of resources available in a project 

grows you may need to filter this list in order to find a particular resource or resources that you 

need. But at the moment we’ve got such a short list of resources that it’s easy to find the one that 

we want to assign.  

I’m going to assign the bride and groom to this task. I’m going to work on the principle that the 

bride and groom are arranging this wedding themselves. I appreciate that in many situations it 

will perhaps be family members or other relations or friends that will be doing some or all of the 

organizing. But I’m trying to make this not too complicated. 

To assign a resource all I need to do is to select that resource, in this case the bride is already 

selected and then click on Assign. Now when I assign a resource to a task like that it doesn’t 

automatically close the Assign Resources dialogue. You note there a separate Close button. But 

what you can see if first of all the number of units. Well 100% represents one bride. So there’s 

one bride attached to that task which is just as well really because we only have one bride 

available. And the cost of the bride working on that task is zero. Don’t forget that the rate for the 

bride chargeable to this project is $0 per hour. So if she’s working on that task for ten days then 

she’s still not going to charge us any money for doing it. 

Now one very important point I’d like you to bear in mind here and this is going to become 

increasingly important later in the course. Is that the 100% means that the bride is working on 

this task fulltime. Now in reality it may well be that she is not working fulltime and that she’s 

actually doing her day job most of the time and she’s just spending a certain amount of time 

working on, in this case, the budget and approach to her wedding. But for the purposes of this 

particular project and this will not be the case for the bathroom refit, but for the purposes of this 

project all I’m going to do is treat that 100% as being all of the time that she has available. That 

doesn’t mean to say it’s a 40 hour week or an eight hour day or anything else. It just means that 

all of the time she’s got available she is going to spend on that task while that task is in progress. 

Now fortunately while that task is in progress she doesn’t actually have any other tasks on the 

wedding so she can spend all of her time on it. 
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If I want to assign a second resource and the most obvious second resource to assign is the 

groom. I’m going to select the groom and do the same thing. Click on Close and the bride and 

groom are now assigned to that task. 

One of the consequences of assigning the bride and groom to that task is to do with the amount 

of work involved in that task. I pointed out to you much earlier on in the course that when you 

look at work, particularly for a new project and particularly when this project was new, in the 

work column there was zero hours of work because we had no resources assigned to that task. As 

far as Project 2016 is concerned we have now taken a ten day task and it defaults to an eight hour 

working day. So ten days for eight hours a day is 80 hours. And when I assigned two people to it 

full time that is 160 hours of work. So as far as Project 2016 is concerned these two resources are 

going to do 160 hours of work on this task.  

Now when you do this and the reasons for this will become apparent in the next section, when 

you do this and you effectively increase the amount of work from zero hours to 160 hours 

Project 2016 offers you alternative ways of dealing with the change that you’ve made. And that 

little exclamation mark on the left there with the dropdown next to it offers you alternative ways 

of dealing with a situation where you’ve increased the amount of work in a task. 

As far as the wedding project is concerned this is of little interest really because we’re not really 

going to charge for the brides and grooms time. So the costings and in fact the scheduling of this 

is not going to be changed by the fact that we’ve assigned two resources to that task. We’re not 

going to say that because the bride and groom are working on it it’s only going to take half the 

time. We decided it was a ten day task and that was it. We don’t make it a five day task because 

two people are working on it. 

That set of arguments about work and duration and the amount of work in a task and so on is 

what we’re going to look at in the next section. And I hope that that section will explain to you 

why we get these options here and in fact which of these options is the right one to choose. But 

on this occasion we’re going to go for the default option which is Increase the amount of work 

but keep the same duration. 

When we do that Project 2016 is quite happy. The warnings gone away. We’ve got our 160 

hours of work. We’ve still got a ten day task and the bride and groom are assigned to that task. 

My main concern over the next few sections is going to be the scheduling of this wedding and 

the scheduling of projects in general. And in fact it’s the assignment of work resources that will 

be the key factor. For the balance of this section I’m just going to quickly show you a couple of 

other ways of assigning resources and we’re going to assign those other two resources that we set 

up, one cost resource and one material resource just to go through the basics of dealing with 

those. We’ll be coming back to cost and material resources later though as I really do want to 

concentrate on work resources and scheduling now. 
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Let’s go down to the photography section and let’s suppose that I want to assign the 

photographer to the Select and book photographer task. So I’m going to assign the cost of the 

photographer to this task.  

On the Resource Tab one of the buttons is Assign Resources. And that brings up the Assign 

Resources dialogue and from here I can assign the photographer. Now don’t forget that when I 

assign the photographer we don’t have a cost assigned because it’s a cost resource and we 

haven’t specified what that cost is until we actually assign it to the task. Now we’re going to 

allow for the fact that the photographer/videographer we’re going to use is going to charge right 

about $1,500. So enter $1,500, click somewhere else and we have a cost of $1,500. Having done 

that click on Close and that resource is assigned to the task. Note how the cost appears in 

brackets after Photographer.  

I should point out to you by the way that what you see on the Gantt Chart on the right, the words 

to the right of the blocks in this case, this is all customizable and we will be looking at 

customizing the Gantt Chart later on in the course. 

The last assignment that I would like to make here is the assignment of the rings. So I’m going to 

go to Select and buy rings and right click. I’m going to use this approach to getting the Assign 

Resources dialogue. And on this occasion I’m going to choose Ring. And I’m going to actually 

assign the number of rings because we’re actually going to buy two rings. Note how as I use that 

roller there the units I’ve specified for rings which is the text that I put in the material column on 

the Resource Sheet is shown. You can just about see it there. It’s saying two rings. You can just 

about make it out. You’ll see it better in just a moment. Click on Assign and as you can see two 

rings and it knows that each ring we’ve allowed $500 for. So that’s $1,000 for two wedding 

rings. 

The other important thing to bear in mind here is that I could at the same time assign the bride 

and groom to this task as well. So if I select Bride, hold the Control key down, select Groom, 

click on Assign and now click on Close. I’ve got three resources assigned to that task. I’ve got 

the bride and groom work resources and material resource, two wedding rings and note the units 

there, two ring. 

That’s the basics of assignments. In the next section we’re going to turn our attention back to 

work and we’re going to look at work with particular reference to different types of task. That’s 

it for this section. I’ll see you then. 
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Video: Adding Resources to Tasks 

Toby: Hello again and welcome back to our course on Project 2016.  

Now that you know how to assign resources to tasks the next thing we need to move on to is 

producing a workable schedule given the resources that are available. In order to do that there are 

a couple of fundamental things that you need to understand. And perhaps the most important 

thing to understand with Project 2016 is the different task types that can be involved in projects.  

Now in order to illustrate this I’m using a sort of dummy project, just a very simple project with 

three tasks in it, A, B, and C. Currently they’re each two day tasks and a resource, Jane, is 

working on those tasks. And Jane is working for eight hours a day. So on task A Jane is doing 16 

hours work, task B 16 hours work, C 16 hours work and so on. 

Now let’s suppose that I provide Jane with some help. I say, “Jane, John is going to help you.” If 

I assign John to task A what do you think would happen? Now what may happen is you may 

look at it and say well obviously Jane is going to be able to get that job done in half the time. So 

instead of being a two day task it’s going to be a one day task. And obviously that is one option. 

But there are a couple of other options as well. One other option is that if John works on that task 

as well it will still take two days but they will do 32 hours work during that time. So with twice 

as much resource twice as much work gets done but in the same time. Another possibility is that 

we still want to get our 16 hours of work done and we still want to do it in two days but the fact 

that we’ve got both Jane and John working on it means that they only each need to devote half 

their time to it. So we effectively have three options. And those three options correspond to the 

three options you saw in the previous section when Project 2016 said you’ve changed 

information about resourcing on a task. Which of these three options would you like to use when 

you apply that additional resource?  

Now let me just show you that again. I’m going to now right click on task A. I’m going to click 

on Assign Resources. I’m going to choose John and I’m going to say Assign. Now notice the 

little warning sign on the left there. Now note that Project has assumed that in assigning John I 

still want to spend two days on this task but by having that second person we’re getting twice as 

much work done. So let’s go over to that warning sign, click on the dropdown. The default 

option there, the middle one, Increase the amount of work but keep the same duration. The first 

one was, Reduce the duration but keep the same amount of work. So in that case we would have 

said well we’re still going to do 16 hours work but because we’ve got two people on it we can do 

it in a day. The third option, Reduce the hours resources worked per day, the units, but keep the 

same duration and work. So we say it’s still a two day task. It’s still only going to be 16 hours 

work but Jane and John only need to work half the time each. 

Now let me stick with the default option and what I want to do now is to show you why that was 

the default option. Let me open up task A. Now the reason that was the default option was 
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because the task type was declared as fixed duration. And very importantly the box to the right of 

that, Effort driven, was not checked. So what this says is this task is a fixed duration task. It’s a 

two day task. And putting more effort on it will not automatically reduce its duration. So my 

default is to keep the duration fixed and therefore if I add resource to it I’ll just get more work 

done. Let me now look at task B.  

Now the way that task B is set up is as a fixed work task. So the amount of work is fixed. And all 

fixed work tasks are effort driven. Note that the Effort driven box is checked but it’s grayed out 

so I can’t change it. Now what do you think will happen if I add an additional resource to this 

task? It’s fixed work. It’s effort driven. I’m going to assign John to it. Look what happens. I still 

get 16 hours work done but of course now with the additional resource it can be done in one day. 

If I go over to the warning on the left and click on the dropdown the default now, Reduce the 

duration but keep the same amount of work. Well that is the default for a fixed work task which 

is always effort driven. But I could say, Increase the amount of work but keep the same duration. 

So I could say well okay it’s declared to be a fixed work task but on this occasion I want to 

actually increase the amount of work, having put the additional resource on. And then I also have 

the option of reducing the hours resource work per day. So I could say okay I’ll put a second 

person on it. It’s fixed work. But because I’m not changing the amount of work each of the 

resources only needs to work part-time on it to achieve that amount of work. Now on this 

occasion I’m going to stick with the default and the duration of that task has been reduced by one 

day. 

Now let’s look at task C which is a fixed unit task and currently it’s not effort driven. Now the 

significance of the effort driven part is whether in fact what we’re trying to do is to do a certain 

amount of work, to put in a certain amount of effort. And in doing that we are flexing, we’re 

varying the number of people working on it or the duration in order to get that amount done. If a 

task is not effort driven then we’re not trying to achieve that certain amount of work, put in that 

certain amount of effort. And if I put more resources on to a task then all that will happen is that 

more work gets done. And as a task that’s not effort driven if I assign additional resource, let’s 

go to town this time. Let’s assign three more resources. What is going to happen is I assign a 

total of four people is that we’re just getting a lot more work done on that task. Now as usual 

you’ve got the warning sign on the left there and you can choose a different option. But basically 

we’re getting the default which is, Increase the amount of work but keep the same duration. 

Now let me undo that particular change. Let’s go back in now and make it an effort driven task. 

Now that means we’re trying to achieve a certain amount of work, putting in a certain amount of 

effort. Now what happens if I assign those three extra resources? Given that it’s fixed units what 

do you think it’s going to happen? Well what happens is that the duration is reduced. So in half a 

day four people can do that amount of work. Once again of course I can go to the warning sign 

and change that if I want to. But basically as it’s not fixed duration putting on that extra number 

of people means that I can get the work done much more quickly. 
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As I mentioned towards the beginning of this section we’re going to be doing quite a lot on 

scheduling from now on. And scheduling in Project 2016 can be quite complex at times and 

requires quite a bit of understanding of what’s going on. There is a very useful Help article, How 

Project schedules tasks behind the scenes, and it’s well worth you going through this Help 

article. It’s very useful, very well set out. It gives a lot of very useful information. Of course I 

will be covering virtually all of this on the course and quite often in a little more detail than 

you’ve got here. But there is a section there, I think it’s the fourth one in the list, How do task 

types affect the schedule, and it sets out for the different task types, fixed units, fixed work, fixed 

duration, what will happen if you revise units, if you revise duration, if you revise work. And 

then gives one or two really good examples of what happens in different situations. So I do 

suggest that you take some time to go through this and it will really help you if you can increase 

the level of your knowledge on scheduling in Project 2016. 

And another important point here and I briefly mentioned this right near the beginning of the 

course. In Project Options on the Schedule page there are a couple of very important settings. 

One of them is the default task type. Mine is set to fixed units. I find that that isn’t something 

that I leave set the same way all the time. I often vary this depending on the type of project that 

I’m planning. Sometimes setting it to fixed duration or fixed work throughout the time that I’m 

working on a new project in particular can actually save me time. But I’ve got it set here to fixed 

units. And the other default here is New tasks are effort driven. In my case that is not checked. 

You may find that you prefer your new task to be effort driven or again you might vary it from 

job to job. 

So that’s it. We’ve covered the basics of task types. In the next section we’re going to start to 

look at scheduling itself so please join me for that. 
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Video: The Basics of Scheduling 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section we’re going to start to look at scheduling. And as part of this we have a couple of 

fundamental things to do to our plan in readiness for actually coming up with a realistic schedule 

for the wedding. 

Now the first thing I want to talk about is the difference between manual scheduling and 

automatic scheduling. And as part of doing that I want to just explain something about 

scheduling in Project 2016.  

If you wanted to take a plan such as this one and schedule it manually there will be nothing to 

stop you. Now what I mean by scheduling it manually is that you choose exactly which task 

starts on which date and you check that you’ve got the time to do, that the resources are 

available, that your constraints and deadlines are met and so on. So you can pretty much 

handcraft the whole schedule. Now in some situations you may have projects where that’s 

exactly what you decide to do. But with a large project with a lot of resources and many 

constraints, dependencies, etcetera that will be a very big job. It would probably take you quite a 

lot of time to maintain that schedule, particularly if there is a lot of change involved. And 

particularly if as the project starts things start to shall we say not go according to plan. Largely 

speaking one of the main reasons that people use Project 2016 is to automate the scheduling. 

Now of course there are many other reasons to use Project 2016 but the automatic side of 

scheduling is one of the most significant ones. And it’s the one that we’re going to be 

concentrating on quite a bit over the coming sections. 

So my fundamental assumption about the wedding plan and indeed about the bathroom refit is 

that we are going to auto-schedule them. Having said that, and as we’re going to see with the 

wedding schedule, within an auto-scheduled project you may well decide to manually schedule 

some of the tasks. So for instance in the wedding plan we may well manually schedule the actual 

wedding date and fix it in time and not allow Project 2016 to change it. But the rest of the 

schedule we may be quite happy for Project 2016 to auto-schedule. 

Now one of the things that I haven’t done yet and which I need to do now is to resolve the 

question of when the wedding day will actually be. And at the moment, of course, because 

Wedding day, task 48, has no predecessors its almost the first task in the project which clearly is 

not correct. I really need to show that the wedding day is going to happen when everything else 

is done. I know there will still be a honeymoon after the wedding date but the honeymoon itself 

isn’t actually in the schedule at the moment. We’ve only got the making the shortlist and 

selecting and booking the honeymoon. We don’t have the honeymoon itself. So in effect the 

wedding day is going to be the last task.  

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

Now one way of doing this would be to have other summary tasks such as catering, flowers, 

memories, as predecessors of the wedding day. But often when you’re starting to get into the 

scheduling of a project you decide that one or more tasks or groups of tasks can be separated out 

into significant phases. And what I’m going to do here is to separate out the wedding day, and I 

think the rehearsal as well, as if you like the last phase of this project. And then what I can do is 

to say that this last phase has as its predecessor the preparation phase, the phase when all the 

work on deciding on the venue, booking the flowers, etcetera is all done. So what I’m going to 

do is to take tasks 47 and 48 and separate them out from the rest of the schedule and make them 

a separate phase. 

Now one of the things you need to be careful of here because I’m going to do a Cut and Paste, 

something I haven’t much talked about so far. And that is that where you have tasks such as 

these two which are subtasks of in this case the wedding day summary task, in order to cut them 

and put them elsewhere I need to stop them from being subtasks of a summary task. So having 

selected them I’m going to outdent them using the button in the Schedule Group on the Task 

Tab. I get a warning. Now you’re going to see quite a few of these Planning Wizard warnings. 

And this one tells me that if I outdent those two they will no longer be scheduled as part of the 

wedding day summary task. And in fact they’ll be rescheduled to start before the project start 

date. Now that sounds a little bit dangerous but in fact it’s something that’s going to happen from 

time to time, this sort of Planning Wizard warning. And what you can say with confidence in this 

case is that because I’m going to immediately reschedule those with a different set of rules this 

particular Planning Wizard warning is not one to worry about because although they will be 

given a very strange date it will be for a very short period of time. So I’m going to click on OK 

to continue and outdent these tasks anyway. 

Just one word here. Where you get warnings, and many of them will be from the Planning 

Wizard, you have this little checkbox in the bottom left hand corner here, Don’t tell me about 

this again. Once you get used to these warnings and maybe they start to irritate you a bit you can 

check these boxes so you don’t get the same kind of warning again. So on this occasion I’m 

going to leave the warning switched on but I’m going to click on OK. The tasks are outdented. 

Note their scheduled now right back to actually before the beginning of the project which is 

clearly not when wedding day is going to be. And I’m now going to Cut those. 

So I’ve put the cursor in a row below the end of the schedule and I’m going to Paste those two 

in. Now once they’ve been pasted into place they pick up the indentation of course of the task 

above them, task 49 in this case. I don’t want them as part of Honeymoon so I’m going to select 

both tasks and I’m going to outdent them. I get that same warning again about their scheduling. 

Again I’m going to continue, click on OK and they’re back being scheduled far too early. Now 

let me go back up to the Attire task, select that and do an Insert task above that and that is going 

to be my task, my summary task for the preparation phase. So let me change the task name and 

then what I’m going to do is to select Attire which is now 8, right down to task 50, select 

Honeymoon, and I’m going to indent those to make them part of the phase. And then for the 
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Wedding day task down here, that’s task 53. It’s predecessor will be the whole of the preparation 

phase. So I’m going to put in 7 in the predecessor column, click on the Entry Bar, tick, and I now 

have a wedding day on May 24th. Now I know that’s not right but at least I’ve got a wedding day 

now which is at the end of the wedding project. 

Generally speaking if you are going to use phases in a project it’s a good idea to do that before 

you start scheduling, partly for the reason that I’ve just shown you where it often makes it much 

easier to setup dependencies.  

Now I’ve got one or two other very small changes here. I’m going to change the name of the task 

44. It was called Wedding day. I’ve changed it to Wedding venue. And one particularly useful 

thing to note there is that Wedding day, an individual task, has as its predecessor a whole phase. 

So you really can mix and match these dependencies.  

The next thing we need to do is to check that our task types are correct. Very often when you’re 

setting up a project you will have thought carefully about task types. You’ll have your default set 

appropriately. And you’ll also want to make sure that any exceptions from the default are setup 

as well. While we’ve been setting up the wedding day project my default has been set to fixed 

units, as you know. But let me just demonstrate to you now and bearing in mind what we looked 

at in the preceding section that in this particular project fixed units is not a good choice. 

Let’s go to the Select and buy rings task. And let’s suppose that the bride and groom look at that 

task. It’s a four week task. And they say well it’s not going to be a full time job for us to select 

and buy the wedding rings over that time. Let’s say it’s only going to take half of our available 

time. Let’s go into the Assign Resources dialogue again. Obviously those two are assigned to 

that task but they’re assigned 100%. Let’s try reducing both of their allocation of time to 50% 

from 100%. Watch what happens when I reduce the bride’s assignment to 50%. As you can see 

the task becomes a 40 day task. And the amount of work continues to be set at 320 hours. Now 

of course in this project the bride and groom’s time isn’t chargeable and we’re working more on 

a notional idea of what proportion of their available time is being used on each task. So when we 

say the bride is 50% allocated that’s just half of the time that she’s got available to work on the 

plans for the wedding. 

Now clearly the idea is not here to extend that task but to just reflect the fact that the bride’s time 

on it is only going to be half of her available time. So what I’m going to do is to close this and 

I’m going to undo that last change. And what I really need to do here is to set the task type for 

this and effectively every other task in the project to be a fixed duration task. 

Now if I want to change a fundamental property of a task, you’ve already seen I can use the Task 

Information dialogue. I can also change that for a whole set of tasks by selecting multiple tasks 

and using the same approach. So what I’m going to do is to select everything from Attire, hold 

the Shift key down, down to Select honeymoon, etcetera. Then with the Control key held down 

I’m going to make other individual selections. And I’m going to change each of those to be fixed 
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duration. So I click on Information, go to the Advanced Tab and make sure I have Fixed duration 

and not effort driven. Note where you have a blob like that one. That means you’ve got a 

mixture. You’ve got some of that are and some that aren’t. I want none of them to be effort 

driven. Now you need to be very careful when you transfer what you’re looking at here to the 

bathroom refit project because the bathroom refit project has a situation with task types that’s a 

little bit different from what we have here in the wedding project. So let’s click on OK. That’s 

fine. Now let me go back to that wedding rings task, just select that, once again Assign 

Resources, once again change it to 50%. Watch what happens this time. Look at the duration and 

also look at the work. Now what happens is that the amount of work is reduced. The duration is 

not changed. The bride is shown at 50%. If I now reduce the groom to 50% as well, as you’ll see 

we’re not changing the duration but we are showing that each of the resources is only needed for 

50% of their time over that period. 

So we’ve now got what looks like a better project. And you may think that we’re coming up to 

being close to having a workable schedule. But in fact the schedule we’ve got is going to present 

some major problems. And you can see here, for example, if you look at the second half of 

December that the major problem is going to be that we have far too many things going on at 

once. And given that the bride and groom are going to be doing a lot of this work themselves we 

are going to find that they are going to be over-allocated over some parts of the period of the 

project.  

So what I’m going to do now is to quickly go through and allocate the bride and groom to all of 

the tasks in the schedule that they’re going to be responsible for. And you can start to see how 

we have a scheduling issue. 

So here I have allocated the bride and groom. Sometimes full time, sometimes with a proportion 

of their time. And in the left hand column you can see the little red symbol that indicates that that 

particular task has over-allocated resources.  

Now if I look at the Resource Sheet I can see that the two resources that have an overallocation 

problem, that means that they’ve just got too much to do over a period of time, are the bride and 

groom which is no surprise. And how we resolve those is what we’re going to look at in the next 

section. 

Now as I mentioned at the beginning of this section it’s in our interest to be able to automate the 

resolution of overallocation of resources. But in order to do that it’s also important to understand 

the context within which we’re working. So for instance, which things we can delay and which 

things we can’t, and which things we’d prefer not to delay if it can be avoided and so on. But 

they’re the issues that we’re going to look at in the next section when we’re going to look at 

leveling resources. So please join me for that. 
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Video: Resource Leveling Basics 

Toby: Hello and welcome back to our course on Project 2016. 

We’re starting this section from Wedding 05 and we’re going to look at Resource Leveling.  

The way we left things in the preceding section is that I had assigned the bride and groom to the 

tasks for which they have a level of involvement during the planning of the wedding. And we 

can see that both of them are significantly over-allocated, particularly during one period in the 

second half of December where they have a lot of different things to be doing all at once.  

You can see the specific tasks that are over-allocated with the indicator in the left hand column 

there in the display. And as I pointed out to you in the preceding section if we look at the 

Resource Sheet the two resources there that are marked in red are the ones that are over-

allocated. And of course in something like this project we don’t really have the option of say 

having a couple of extra brides or a couple of extra grooms to spread the work over. In another 

project, such as for example the bathroom refit, if the tiler or the plasterer or the bathroom fitter 

had too much work to do you could possibly get a second person into help but that isn’t really an 

option for us here. 

Now one of the things that I mentioned in the preceding section, which is of course a very 

important thing to do, is to make sure that you have your default task type set correctly. Let’s just 

take a look at that now. 

On the Schedule page in Project Options in Scheduling Options for this project note that I have 

this project selected. So that’s Wedding 05. And the default task type I now have is fixed 

duration. Note also that I have the checkbox, New tasks are effort driven, is not checked. Now if 

I go back to this dropdown here, for all new projects my overall default is still a default task type 

of fixed units. So in the absence of a specific change for a specific project, that is if you like my 

default default it’s fixed units. You will obviously need to set that up in the way that suits you. 

It’s very likely when you are planning projects and as your projects progress that you will 

experience overallocation of resources and there are a number of ways of resolving these 

overallocations and we’re going to be looking at quite a few during the course. But before we do 

just one very important point to make is this. There isn’t some universal, if you like, panacea for 

overallocations. There isn’t one way of resolving overallocations, which is always the right way 

of doing it. The resolution of overallocations almost always involves understanding the 

underlying project, the underlying business, the underlying activity that your project relates to 

because you have quite a few, if you like, nobs and dials that you can adjust in order to get the 

best result when you’re resolving overallocations.  

Now one of the key things you normally you need to decide is whether to resolve overallocations 

manually or automatically. Both of them have a place and it may well be that you work on the 
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principle that as far as possible you resolve overallocations automatically but that you’ll revert to 

manual methods where necessary. It actually wouldn’t be that complicated for us to go through 

and resolve all of the overallocations in this particular plan manually. But it can be very time 

consuming. And automating this process as much as possible is usually the best approach if you 

can in fact automate it successfully, which is not always the case. 

Now the first thing I’m going to do is to demonstrate a manual resolution of an overallocation. 

And I’m just going to take the first overallocation, Select wedding dress, and show you very 

quickly how you could resolve that manually. 

Now the fact that Project 2016 has put that red marker there that says this task has over-allocated 

resources tells you that it knows there’s a problem. It also says right click for options so let’s 

right click. And we’re really interested in the top three options. The first of those is Fix in Task 

Inspector. We’re going to look at the Task Inspector later in the course so we’ll come back to 

that one. And the third one is Ignore problems for this task. In the same way that in the preceding 

section once or twice I said let’s ignore that warning from the Planning Wizard, there will be 

situations where you have an apparent overallocation but either you know it’s not really a 

problem for reasons I’ll look at later on or you may know that you’re going to fix that problem 

later and you don’t need to deal with it now. So you do have the option of ignoring a particular 

problem related to overallocation.  

The second option is the one that you’ll very often use when you’re doing manual resolution. 

And it is Reschedule to available date. And what you’re basically saying to Project 2016 is I 

want you to find a date when this task can happen and I don’t then have an overallocation against 

it. And that’s what we’re going to do here, Reschedule to available date. Now notice the task has 

been rescheduled. And also notice that the red mark is gone from the left column there against 

task with ID 10. And also note that the date, the end date of our project has pushed right out quite 

a long way actually. So we’ve pushed everything related to the wedding dress out to the right 

because of course that one task, Select wedding dress, had a number of successors, including 

Order dress, Measurements, and Fittings. And of course that delays the Attire summary task 

which in turn delays the whole of the preparation phase. And if we look down here we’ll see now 

that our wedding date has moved out to June the 10th. 

Now we could go through each of these over-allocated tasks and resolve it manually in that way. 

But as I say that would be time consuming and generally speaking we’d like to automate it. So 

let’s look now at how we might automate this process. 

Now you might be tempted in this situation to undo what we just did and start again with an 

automated version of this process. But before we do I want to demonstrate something else. I’m 

going to change the view. And the view we’re going to use is one specifically that we use when 

we’re working on leveling resources. So I’m going to click on View and I’m going to go for 

Other Views, More Views. And I’m going to choose Leveling Gantt. Now the Leveling Gantt 
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View effectively shows you what Project 2016 is doing in terms of leveling the resources on a 

project. Now when you apply a new view like this it’s very often the case that the timescale is all 

completely wrong. So let’s go for Entire Project so that we see the project on the right there. And 

you note in particular this little colored bar here against Select wedding dress. That bar 

represents the leveling delay, the amount of delay that was added to that when we did the manual 

leveling just now. And we have in fact a set of tools to handle leveling delays. 

Now before I use one of those tools look at the table on the left. Let me just make the name 

column a little bit wider. There is a column there, Leveling Delay. And the current leveling delay 

on that task is 42 e-days. E-days are Elapsed days. So when we did the manual resource leveling 

just now what Project 2016 had to do was to delay that task by 42 elapsed days. And that’s the 

currently applied leveling delay to that task. 

Now notice that its successor tasks which were also delayed were not delayed because of 

leveling of themselves. They were delayed because we delayed the Select wedding dress task 

that had the resource overallocation. So their leveling e-days are set at zero days. They weren’t 

delayed because of a leveling problem. They were delayed because they are successors of a task 

that had a leveling problem. 

Now if I wanted to put this particular project back the way that it was I could obviously do the 

Undo, but I also can go to the Resource Tab and click on a button there, Clear Leveling in the 

Level Group. Watch what happens if I clear the leveling. I get an option of clearing it for the 

whole project or if I’m just working on part of the project or I want to clear the leveling on part 

of the project I can select the relevant tasks and change this option to selected tasks. As I’ve only 

done one bit of leveling here I’ll stick with entire project. Click on OK and basically what 

happens is that task goes back to where it was before. And if I now reverted back to the Gantt 

Chart View it would look exactly how it looked before. And of course I’ve got my overallocation 

indicator on the left there for task ID 10. 

Now before we look at automatically leveling let me just point something else out. We asked 

Project 2016 to reschedule Select wedding dress to a date where the resource wouldn’t be over-

allocated. You can reschedule these things completely manually yourself. So there will be 

nothing to stop me going into any of these tasks and changing the start and finish dates. And I 

could go through all of them and change the start and finish dates manually, schedule them 

manually, change their task types from auto-scheduled to manually scheduled if necessary, and 

fix any of these dates in time if I wanted to. But what we want to look at now is the opposite of 

doing that and that is putting everything in Project 2016’s hands and seeing if it can resolve these 

overallocations automatically. 

So I’m back in regular Gantt Chart View and I go to the Resource Tab. And in that Level Group 

that we saw just now there are two buttons there. There’s Level Resource and Level All. Level 

Resource gives me the ability to level one or more selected resources. So if all I wanted to do 
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was to level the bride and make sure that she’s not over-allocated I can select one resource and 

click on Level Now and Project 2016 will try to level the bride over the project so that she’s not 

over-allocated at any stage. 

Now it’s important to recognize it will try because it may well be that the constraints, the 

deadlines, the dependencies, they may mean that she cannot be leveled. There are going to be 

situations where she’s just got too much to do over a period of time. So you may find in many of 

your projects that you can’t completely resolve overallocations or should I say not in a way that 

you’re happy with. You may have to make some compromises or other changes in order to 

achieve a completely leveled project. 

So that’s leveling an individual resource. The Level All button basically levels all resources. And 

if I click on Level All let’s see what happens. I will normally get one or more warnings. And this 

is a warning. Note the yellow triangle on the left there. Project cannot resolve the overallocation 

of bride on Thursday, July 14th. When you get these there are often three choices. The first 

choice is To continue working on other over-allocated resources click Skip, To continue leveling 

and skip overallocations that cannot be resolved click Skip All. So if there’s a problem found 

here and I’m going to say well let’s just keep going and whatever problems you find just keep 

skipping them and leave the problems and I’ll sort them out later. And the third option is to Stop 

leveling click on Stop. Now what I’m going to do here is to say Skip All and then having click 

on Skip All we’ll see how many of the resource overallocations Project 2016 can resolve.  

And there we are. Now as you can see most of the red markers in the first column have gone. 

And our wedding is now on August the 1st. So the dates pushed out a long way. Don’t forget that 

little deadline marker there. You see we’re still a month short of our deadline marker so that’s 

not too bad. But we do still have some overallocations and if I click on the Resource Sheet you’ll 

see that both the bride and the groom still have overallocation issues. 

Now clearly we’re going to need to look at those outstanding overallocations to find out what’s 

causing them and whether we can resolve them or what we have to change to resolve them. But 

when we look at the schedule itself we may well find issues with that. Overall there are some 

very good aspects of the schedule now because, for example, we have the reception venue 

identified, we have the wedding venue identified, and they’re both done before we send out the 

invitations which is pretty good. We also have the wedding itself registered and licensed early 

on. But when we look at things like caterer, baker, florist, and so on we’re making the shortlist 

and then there’s a long time before we book those people. And the booking is probably a little bit 

too late in the day ideally. We seem to have left the bookings much too late in the process. 

Whereas with other aspects such as the wedding rings maybe they’re roughly in the right kind of 

place. But quite often when you look at schedule after leveling you’ll find that the resulting 

schedule doesn’t really tie in with the ideal sequence of events. And there are a number of 

options that you can apply when leveling to help you to get just the kind of sequence of events 
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that you want while still resolving any overallocations. And the use of those options is what 

we’re going to look at in the next section. So please join me for that. 
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Video: Leveling Options 

Toby: Hello again and welcome back to our course on Project 2016.  

In the preceding section we did a little bit of manual resource leveling in order to try to overcome 

overallocations of the bride and groom’s time in our wedding plan. Now what we’re going to do 

in this section is to look at automating the leveling of resources in Project 2016. And primarily 

we’re going to look at the options that are available when you’re doing this.  

Now before we start I should point out that when we did the leveling before we came up with a 

schedule that indicated a potential wedding day of August the 1st. That’s a good starting point. I 

think we may go for a date a little bit later than that. But first of all we need to make sure that all 

of our issues are overcome. It may well be that that appears to be a good date and the plan 

appears to work. But until you’ve actually looked at any outstanding issues you can’t really be 

certain that the end date, in this case the wedding date, is going to be achievable. The other thing 

to bear in mind is that with any project you are dependent on making sure, for example, that you 

have all of the tasks, dependencies, etcetera in place, that your estimates, your time estimates, 

your resource estimates are good, and that your resources are going to be available. We’re going 

to take a look at some of the things that might go wrong a little bit later on in the course but for 

the moment let’s assume that our resources are available and that we’re pretty much scheduling 

this project on the basis that given that a lot of it is down to the bride and groom they’re going to 

be very committed to getting the wedding running to schedule. And that therefore they’ll be 

more than happy to put in that extra bit of effort to deal with any problems that arise. 

Now the first thing that I’m going to do is to undo the leveling that we did in the previous 

section. And if I go to the Resource Tab, in the Level Group one of the options is Clear Leveling. 

Look carefully at the schedule, particularly around the area of Select and order wedding dress. 

Clear the leveling for the entire project and we’re back to where we were. Now what we’re going 

to try to do is to level automatically. And before we do that let’s look at Leveling Options. 

Now the Resource Leveling dialogue has many options and we’re going to look at a few of them 

in this section. One or two we’re going to save until later on in the course.  

Now first of all do you want leveling calculations to be automatic or manual? I normally set this 

at manual because whilst having Project 2016 automatically deal with leveling can work quite 

well. When you’re setting up a project it can actually be rather annoying because you get to a 

situation where it’s leveling resources and you’re thinking to yourself well hang on a minute. 

I’ve got loads more tasks and resources to put in yet. So you’re doing work that is really a waste 

of time because until all of the project or the bulk of the project is in there’s not really any point 

in doing this. So I tend to go for manual leveling calculations. 

The next option, look for overallocations on a default day by day basis. You can also have 

minute by minute, hour by hour, down to month by month. This is a very important option. I’m 
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going to explain it to you with an example. Let’s suppose that you have somebody doing a task 

for two hours a day over the course of a week. And maybe it’s the only job they’ve got to do on a 

project. But on Wednesday you need them to do a full day task. So they’ve got an eight hour job 

to do on Wednesday. If you have overallocations being looked for on a day by day basis Project 

2016 will look at Wednesday and say they’re over-allocated because they’ve got two hours on 

the first task and eight hours on the second task. That’s ten hours. That’s too much work. But if 

instead I said on a week by week basis what Project 2016 will do is to say let’s add up that first 

task, a week, five days, two hours, that’s ten hours. Let’s add the time for the second task, that’s 

eight hours. That’s a total of 18 hours. And I’ve got plenty of time in a week to do 18 hours of 

work. So as far as Project 2016 is concerned in that case they are not over-allocated. Basically 

what Project 2016 is doing is leveling out, evening out the work.  

Now it may be important to you to get Project 2016 to even out that work and week by week for 

that reason may be a good option. Month by month might be a good option. But if you really do 

need to make sure that they’re not over-allocated on even one day or one hour or one minute and 

that the tasks they’re being given are not on a nature where the resource can balance the time out 

themselves over the course of say a day or a week then you need to make sure you have the 

correct value set. Now in the case of the wedding well we’re not really that concerned about 

exactly what hours are being worked. The bride and groom have indicated the proportion of the 

time that they need on each task. I’m going to be quite happy with week by week leveling. 

The next option is the leveling range. Do I want to level the entire project? Or do I want to just 

level a certain date range? What can sometimes happen when you’re working on a long project is 

you may, for example, have the project in phases. And over the next phase, say the next few 

months, it may be important that you have the resources leveled. But for phases of a project 

which are much further off into the future leveling resources might be a bit of a waste of time 

because you don’t really have the detail in yet. There’s a lot more work to do on it. So leveling 

resources over that period really is a waste of time and will flag problems that don’t really yet 

exist. So in that situation you might want to choose just say the next few months to level. On this 

occasion we’re going to level the entire project. 

The next option we’re going to look at in the Resource Leveling dialogue relates to leveling 

order. But in fact I’m going to cover that last. I want to look at the checkboxes below that first 

because I’m just going to briefly review those. 

First of all there’s an option, Level only within available slack. Now we’re going to talk about 

slack and the critical path later on in the course but basically if I check the box that says Level 

only within available slack that means that leveling will be done in such a way that the end date 

of the project is not delayed. Now this may well constrain how successful leveling can be. But it 

does mean that we can be certain that this isn’t going to cause a delay in the project. At the 

moment that is unchecked. So any leveling we do may well delay the end of the project.  
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The second option, Leveling can adjust individual assignments on a task. Rather than move a 

task and of course the assignments associated with it for all of the resources that are assigned to 

that task it can adjust individual assignments. So it could take one resource and adjust that 

resources assignment on a task in order to overcome an overallocation issue. That’s currently 

checked so we’re allowing that. 

And the third option there, Leveling can create splits in remaining work. You may recall that 

when I did that manual leveling exercise and it moved some of the tasks associated with Attire 

out to the right, you may have noticed that one of the tasks was actually split into two with a sort 

of dash line between the two halves. What Project can do is to split outstanding tasks and say 

we’re going to do part of the job, then we’re going to take a break from it, then we’re going to do 

the other part of the job. And this is on the basis that in that gap in the middle the resources 

working on the task are needed to do something else. Again that is allowed now. So I am 

allowing Project 2016 to create splits in remaining work.  

The fourth option, Level resources with the proposed booking type is one we’re not really going 

to cover on this course. You can really have two types of booking. You can have a proposed 

booking and a confirmed booking. Now as I say the use of these booking types is outside the 

scope of what we’re covering on this course. But later on in your use of Project 2016 when you 

start looking at proposed and confirmed booking types that’s an important option to be aware of 

when you are leveling. 

The fifth option dictates whether leveling can be applied to manually scheduled tasks. Now 

generally speaking by default we don’t level manually scheduled tasks. But if you do want to 

include manually scheduled tasks in level operation check that box. 

So that’s that group of five options. One or two of them will come up again later on in the 

course. And let’s concentrate now on the leveling order. 

In Project 2016 there are three options for leveling order. And by default the leveling order here 

is standard. And with standard what basically happens is Project 2016 uses all of the information 

you’ve given it about resources, tasks, dependencies, constraints, etcetera and does the best job 

that it can to level the resources on the project. Subject of course to the various options that 

we’ve been looking at so far in this section. 

But you have two other options. Now these two options are very different but as I’m sure you 

appreciate by now even using the same terminology and looking at the same types of problem on 

two different project you very often take a very different approach to solving a problem. 

Now the first other option is what’s called ID Only. And the way that ID Only leveling works is 

that the leveling is done strictly in terms of the ID numbers. They’re the numbers, the left most 

numbers that you can see in the table in the Gantt Chart. So task 1, task 2, task 3, and so on. The 

higher the number the more likely it is to be leveled. I mentioned to you very, very early on in 
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the course that there’s absolutely no reason that you put the tasks here in, if you like, 

chronological order or any other order for that matter. But many people do put tasks in an order 

whereby if leveling is to occur then the ones that are if you like further down the schedule, the 

ones with the higher ID numbers, will tend to be leveled, to be delayed most. Now that usually 

corresponds with a general concept that the tasks near the beginning of the schedule are the ones 

that are done first. And the ones near the end are the ones that are done last. So with ID Only 

that’s the rule that Project 2016 follows. 

Now I should point out of course that it will still obey all of the rules in terms of dependencies, 

etcetera that you have set up in the project. It doesn’t ignore those. What happens with ID Only 

though is that where there is a conflict, where there is a decision to make the task with the higher 

IDs are the ones that will tend to be delayed. 

The other option is Priority and then Standard. And what happens with this is that you give 

Project some guidelines on the basis of priority. So let’s suppose we have a particular task that 

we definitely don’t want to be delayed. We know it’s involved in an overallocation issue but we 

don’t want it to be delayed. What we would do is to give that task a higher priority than all of the 

other tasks. Similarly if we have a particular task wherever it was in the schedule. It wouldn’t 

matter whether it was near the beginning or the end. Wherever it was and we really didn’t mind 

that task being delayed then we would give that task a lower priority and that would tend to 

reduce its chance of being delayed as part of the leveling process. 

So first of all what I’m going to do is to try just to use standard leveling and see what sort of 

result we get. So I select Standard, click on Level All and Project 2016 comes up with a new 

schedule. Now you’re going to see some problems with this schedule straightaway. The number 

of red overallocation indicators is greatly reduced so that’s good. You won’t necessarily always 

see all of them disappear. And sometimes you need a certain amount of manual work to resolve 

the ones that remain. But let’s look first at our end date. Well our end date is now September 

12th. So that’s maybe not too bad. We could maybe resolve that few days delay or even put back 

the date to that early date in September even though we’d set our deadline as September the 1st.  

But if you look at some of the issues, some of the issues are actually quite extreme. For instance, 

we’ve got a problem here, Make caterer shortlist, Book caterer. There’s a huge gap between 

them. There’s clearly some work needed there on the scheduling because we don’t want that 

huge long gap. We don’t want to leave those bookings to be quite so late in the day. But perhaps 

even more importantly the ordering of the dress and the measurement and fittings and the attire 

generally is being left right until the very last minute which doesn’t really seem like a good idea. 

So standard leveling hasn’t really done the job for us on this occasion. So let’s Undo that 

leveling and let’s try setting one or two priorities. 

Now one of the things that takes a little bit of getting used to when you’re doing leveling is that 

there are quite a few options and although I’m going to demonstrate priorities now you may 
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alternatively choose, for example, to fix some of these tasks in time and say to decide on the first 

few tasks, set a constraint that they must start on a certain date, or even make them manually 

scheduled tasks. But let’s suppose the first thing that I’m going to try is to say well the most 

important thing to get started with is to sort out the guest list and the invitations. And of course 

as part of that we’re going to need to book the venue so that we can send out the invitations. And 

we’re going to need to have decided on the actual date and so on. Most of that is covered by the 

dependencies that we’ve already setup. But let’s go into Make guest list and change its priority 

from 500 to 600. So we’re making that the highest priority task. And then we’re going to do the 

same sending out the invitations. Let’s make that 600 as well. And then let’s go into Leveling 

Options and choose Priority Standard as our leveling order and see what happens. 

Now when we do that not only do we finish up again with just a few overallocation markers on 

the left but we also finish up with a date of August the 16th. So we’ve actually come up with a 

better solution. And we probably have less problems. I haven’t counted them all. We’ve still got 

the problem with the attire. But as you can see we’ve got a much shorter project and of course 

we’ve got the making of the guest list and the sending out of the invitations happening as early as 

they can in the process. Don’t forget as part of getting ready to send the invitations we do have to 

sort out the venue. 

So having sorted out that particular issue we might now turn our attention to the attire and give 

that a higher priority than it currently has. And maybe also look at some of the other tasks, 

perhaps ones which ones which could do with a lower priority, things like the florist. We may 

decide that the florist is one of the last things we would need to do. But in that way with selective 

use of priorities we should be able to come up with a pretty good schedule. And it looks as 

though we might yet achieve our September the 1st date. However I’m going to stop working on 

this particular schedule for the moment because I want to do a little bit more work on these 

outstanding overallocations. And what I want to do instead is to give you a chance to try a little 

bit of resource leveling and scheduling now on the bathroom refit project. So we’re going to do 

that in Exercise 04. 

That’s going to be covered in the next section. I’ll see you then. 
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Video: Exercise 04 

Toby: Welcome back to our course on Project 2016.  

In this section I’m going to set you Exercise 04. This is a reasonably straightforward exercise but 

it takes a little bit of explaining.  

I’m starting you with a version of the bathroom refit project, version 04A. And I have setup 

some resources. But I’m only really concerned here with resources on the second part of the 

project. So for the first two phases, the parts that I’m effectively going to do myself where I’m 

going to do things like look into the color scheme and the tiles and all those things. I’m not really 

too worried about resourcing those. In fact with those I’ve generally set the task type to fixed 

duration.  

But later on in the project, for the implementation phase and the completion phase I’ve allocated 

some resources. These are people I’m going to employ to do the work on the refit for me. As you 

can see we have some resource overallocation issues. But if we just look now at the Resource 

Sheet you’ll see that I’ve setup an electrician, a plumber and a contractor. The contractor is 

basically a general builder, somebody who’s able to do most of the jobs that I’m going to need 

doing in this bathroom refit. As you can see it’s the contractor who is over-allocated. 

Now the first thing I’d like you to do is to move the start date of the project to tomorrow. That is 

your tomorrow, not my tomorrow when I’m recording this course, but your tomorrow. As though 

you were actually going to start doing all of this work from tomorrow. Now when I move my 

start date to tomorrow I finish up with an end date of March the 4th. Now clearly it’s very 

unlikely you’ll finish up with the same end date as me but make a mental note of that end date 

because the next step is to level the resources. And in order to do that I want you to use the 

standard leveling. And I want you to do it in such a way that you’re quite happy for the refit 

complete date to move out, to be later on. And I want you to do it on a week by week basis. So 

that’s the first exercise. Now when I do that my refit complete date goes back about ten days. 

And you should find that yours goes out about ten days as well. So given this one contractor and 

given the electrician and the plumber and the plan that I’ve got here I can stick with those 

resources and it will delay the end date by about ten days. So that’s the first part of the exercise. 

If you get a slightly different date to that, bear in mind it could just be the way that your 

weekends are falling. Or you may even have put some public holidays in, but more of that later 

on. 

Then what I want you to do is to clear the leveling again. So basically go back to the start point. 

So I’m back to March the 4th. Now what I want you to do is to level those resources on a day by 

day basis but without changing the end date. So the end date is still going to be March the 4th in 

my case or whatever your starting, end date is if you like. The end date you got straight after you 

moved the start date of the project. Now obvious question is how am I going to do that? How am 
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I going to keep the same end date and clear the overallocations? The answer to that is you’re 

going to use more contractors. The question for you is how many more do you need to use? 

My answer to that is in 4B. Good luck with that. I’ll see you in the next section. 
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Chapter 9 – Views and Timelines 

Video: Views – Part 1 

Toby: Hello again and welcome back to our course on Project 2016.  

In this section and the next section or two we’re going to look at views in Project 2016. You’ve 

already seen a few views, such as Gantt Chart View already. We’re going to look at quite a few 

others in the next couple of sections. But I’m also going to introduce you to some general aspects 

of views that will help you as your knowledge and use of Project 2016 develops. 

Now in a little bit of a break from tradition we’re going to look at the exercise, the bathroom refit 

exercise version 04B, my answer to Exercise 04 during this section. And one of the reasons for 

doing that is I want to explain a couple of things about my solution to Exercise 04. Hopefully 

your solution to Exercise 04 will have been pretty similar to mine. But I’m going to show you 

one or two tools that probably would have helped you to do the exercise a little more easily. 

But first of all a little reminder about some basic features of views. We’re currently showing 

Gantt Chart View. If you look on the View Tab, the left most button, Gantt Chart, is highlighted. 

That’s the one that’s currently in use. Don’t forget you’ve got those specific buttons down at the 

bottom right hand end of the Status Bar that let you switch between some of the more commonly 

used views. And you’ve also got the zoom control down there as well. Now up on the Ribbon on 

the View Tab the first two groups, one of them says Task Views and one of them says Resource 

Views. Now typically you’ll use the views in those two groups for those specific purposes. So 

clearly the views that you’re most likely to use for tasks are in the Task Views Group, those for 

resources are in the Resource Views Group. However, if you click on Other Views you’ll see a 

complete list of views from the More Views list here. You’ll find that as you use Project 2016 it 

will update some of the views that are on dropdown menus based on your use of them. Now at 

the moment I’m looking at More Views in the Resource Views Group. You can see that one of 

the views there is Gantt Chart. So as you can see I can access these views from various places. 

Now the other thing to remember is that many views involve a split of the screen. In fact some of 

them involve not only a vertical split like this one but you can have horizontal splits again, which 

we’re going to look at it in the next section. It’s pretty straightforward to move that split line 

across to change the balance of how much information you can see in the table on the left here or 

in the chart on the right. You can also change the width of any columns that aren’t highly 

convenient with. So for example, if you decided the predecessors column here was too wide, if 

you put the cursor to the right of the dividing line in its header, click with the mouse when you 

get that double arrow with the vertical bar, pull to the left, you’ve made the column narrower. 

And if I wanted, for example, to make the start date a little bit wider I could again get that double 

headed arrow, click, drag out to the right, and I’ve made the start date wider. So that’s how you 

can adjust what’s on the left hand half of the view. 
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But now let’s take a look at a completely different view related to task. Let’s go into Task Usage 

View. In Task Usage View what you have is a list of the tasks and for all tasks where resources 

are assigned it shows how much resource is used. Now if you remember with the bathroom refit 

project the first couple of phases we don’t have resources in use. But as we get further down into 

the implementation phase, as we see each task, so here 42, Setup skip. Underneath that there is a 

contractor resource. Now I’m going to make the task name column wider. By the way if you’re 

doing this with touch it’s pretty much the same approach. You just basically tap on the right hand 

border in the header and drag it across when you get the double headed arrow. But what you can 

see here is the amount of resource that’s used on a particular task. So let’s take, for example, the 

task Setup skip for waste. Now the resource that’s used is contractor. The amount of work is 

eight hours. And we can see in the view on the right where that eight hours occurs. It’s on the 

Tuesday of the week beginning February 14, 2016. So here we can see where our resource is 

being used. But not only can we see where the resource is being used and how much of it is 

being used but we can also see various subtotals. So for instance, we have a Preparation, task 41. 

And the totals for the preparation task are shown here in its row by each day. So there’s eight 

hours Tuesday, eight hours Wednesday, eight Thursday and 24 on Friday. Now the 24 hours on 

Friday are made up of eight there, eight there and eight there. So that’s our 24 hours. So you can 

see how the work that’s being done is broken down by task and by resource.  

Now sometimes when you’re looking at a Task Usage View the amount of information can 

actually seem quite overwhelming. The bathroom refit is not a huge project but already as we 

scroll through time and through the tasks you can see just how much is going on and how much 

work is being done. This is a situation where using the outlining that I showed you earlier on in 

the course can be very useful. So let’s go up to the Data Group on the View Tab, click on Outline 

and say we only want to see Level 2. Now with Level 2, let me just scroll back, go to the 

beginning again. Now with Level 2 we only see the Level 2 tasks. However, if I scroll across to 

where the work is happening you will see the totals for each of those tasks. And of course if I 

went to Level 1, let me go up here and see where the work is being done. You see the 

implementation phase work and how much is being done in the overall phase on each day. And 

you can also see when the completion phase starts, how much work is being done on each day 

there as well. Note right at the top a total for the whole project. So you can see there how we can 

control the level of detail that we can see in Task Usage View.  

And if we turn our attention now to what we call the Time Phased Data on the right we can do 

quite a lot there to customize the view to our specific requirements at any time. If you look in the 

Zoom Group on the View Tab the left most control there says Time Scale. Currently Days are 

selected. There are quite a few other options. Let’s take a look at Weeks, for example. And there 

we can see on a week by week basis how much work is being done. So we can see our totals for 

each week. 

Now when you make a selection like that what you finish up with quite often is pretty much a 

whole project squashed into a very thin amount of space and you may want to widen things out 
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or see a little bit more. And there are quite a few other options with zoom that I want to take a 

look at next. 

One of the most useful ones of all is this one, Entire Project. Note the Screen Tip description, 

Update the view so the entire project is visible on the screen. Now that will work in any view 

where you’ve got the time phase data. So it starts at the beginning of the project of course. In this 

particular project the first two phases we don’t have any resources assigned so we’ve got no 

work being done. So it looks as though it’s got entire project wrong. But in fact there’s plenty 

going on here. We’re just not recording any work for resources in the sort of first two-thirds of 

the view on the right here. The actual recordable recorded work is towards the latter end of the 

life of the project.  

Now you also have zoom control here. So you can do simple things like zoom in or you can 

zoom out as required. Often when you do that you might well lose sight of exactly where you are 

in terms of the project. You might have to use the scroll bars on the right or at the bottom in 

order to bring everything back into view. 

The other thing to notice here, and this can be a little bit unnerving at first, is that sometimes 

when you do a particular view, like Entire Project, what Project 2016 does is to adjust the 

timescale to what is sometimes a strange setting. So for instance in doing what I’ve done there 

the timescale now is three days. So look at those markings there. You’ve got January 16th, 19th, 

22nd, 25th, 28th, 31st, and then you get February 3rd, 6th, 9th, and so on. So it’s doing it in chunks of 

three days which is a rather strange unit of time, although of course it copes with it perfectly 

well. These totals of work will still be completely accurate. Now sometimes that sort of thing can 

be a little bit annoying. There is ultimately though a way that you can adjust timescale where you 

can pretty much achieve whatever effect you want to achieve. 

So let me show you how to do the ultimate adjustment to the view of time on the right there. If I 

right click over the header which currently includes the timescale markings for months, days, and 

so on. One of the options is Timescale. And that brings up the Timescale dialogue. That’s all. 

You can have up to three tiers of time. And I’m going to introduce a third tier here just to show 

you how it’s done. 

So Timescale Options partway down show I’ve currently got two tiers, middle and bottom. I’m 

going to change it to three tiers, top, middle and bottom. And then I will set each of those three 

tiers by selecting the appropriate tab in the dialogue and then saying what I want to show in that 

tab. At the moment don’t worry about nonworking time. We’ll just concentrate on the first three 

tabs. 

In the top tier for my units, just to demonstrate this basically, I’m going to put quarters. So I can 

then choose how I would like those quarters labeled. Default there Quarter 1, 2009. Let’s 

suppose instead of that I want Q1 09, Q2 09 and so on. How many of them do I want at a time? 

Well I’m just going to do them one at a time. Remember what I said just now about three days? 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

Well if you wanted it marked in three days or three quarters you’d say three of them here. You 

can also say how you want the markings in the header there aligned. I’m going to stick with left 

aligned. And very importantly you can also scale the view. I’ll show you that in just a moment. 

Let’s go to the middle tier. For the middle tier let’s do single months. Let’s mark them with that 

label option. One month at a time. Again, labeled left. And then for the bottom tier I’m going to 

do them, let’s do them in weeks. And let’s do the weeks, let’s put the dates in like that. And 

we’re going to count one week at a time. We’re going the dates in the center.  

Now there’s a preview down at the bottom here which gives you an idea of what that whole 

setup is going to look like. So let’s give that a go. So you can see it made quite a substantial 

change. So it’s probably a little bit overdoing it really but hopefully you get the idea from that. 

So I’ve got the timescale marked at the top in quarters, second level in months, third level in 

days. And not only can I adjust that in a very, very flexible way but I can also scale it.  

Let’s go in and scale this now. Let’s suppose that I think well actually that’s too wide. I need to 

cover a longer period of time. Let’s right click there again, bring up that Timescale dialogue 

again and I’m going to scale the top tier. It’s 100%. Let’s do down to say, let’s go for 75%. I’m 

really showing you how to do this, to show you how to do it. Not because it’s going to achieve a 

better result. So there we are. Now as you can see I can pretty much adjust that in any way I like. 

Not only in terms of width, scaling and so on but exactly how each time unit is labeled. 

Now you can use that approach to presenting time phase data on the right there, labeling, scaling, 

etcetera, up to three timescales on any view that has time phase data on the right. So this is Task 

Usage View. Clearly you could use it in Gantt Chart View as well. 

In the next section we’re going to take a look at resource usage. I’m going to talk a little bit more 

about the answer to Exercise 04 and then I’m going to show you how to split the view 

horizontally and how that helps you when you use Project 2016 as well. But that’s it for this 

section. I’ll see you in the next one. 
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Video: Views – Part 2 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to continue looking at views and we’re going to start by looking at 

Resource Views. 

Now I’m still looking at Exercise 04B. I’m going to go to the View Tab and on there in the 

Resource Views Group let’s first of all look at the Resource Sheet which is straightforward 

enough. It’s often the view we use to setup resources. And of course it’s got a lot of the 

information about each resource on it. And will also often contain helpful indicators such as 

overallocation indicators. 

But let’s look at the view that’s in the group there above it, Resource Usage. And Resource 

Usage View is the sort of compliment of Task Usage View. And what Resource Usage View 

gives us is a list of resources and then for each resource a list of the tasks that that resource is 

working on.  

Now as usual there’s a certain amount of diggory-pickory needed here in order to make the 

columns and the split of the view a little bit more helpful. So I’m going to quickly do that. And 

you see the first resource that’s listed is Unassigned. So the unassigned tasks that are the ones 

that don’t have any resource assigned to them. There’s really quite a long list of those on this 

particular project. As you know the first two phases I haven’t yet allocated any resource to at all. 

But if I go down now to the main body of what’s in phases three and four, I have three resources, 

electrician, plumber and contractor. And for each one I can see a list of the task that resource is 

working on. Now this can be a very useful facility for getting a list of the task that each resource 

is working on. And of course you’ve got the work hours shown on the right there. In fact the top 

section, the unassigned section is often very useful because it will basically tell you which tasks 

you haven’t got any resources assigned to yet. And very often you’ll want to go through that and 

make sure that you haven’t missed anything. 

The right hand half of this particular view is a conventional timescale. So it shows the time phase 

data on the work for these work resources. And of course you can customize it in the way that I 

showed you in the preceding section. 

Now you probably would have found this a very useful view to use to help you with Exercise 04. 

But there’s another Resource View which can be very helpful when you’re looking for 

overallocations and how to resolve them and that’s the Resource Graph. So I’m going to click on 

Other Views and one of the items on the list there is Resource Graph. 

Now this is really quite a different way of looking at the resources on a project. The left hand 

half of the display shows a little panel for a resource, in this case contractor. And you step 
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through your resources using the scroll at the bottom. So if I scroll to the left I go from contractor 

to plumber to electrician. And then forward again. Now if I use the scroll bar on the right it takes 

me through the timescale of the project. Rather than laboriously go through that let me click on 

Entire Project. And what you will see is the workload for the contractor resource in graphical 

form.  

Now let me just quickly go back into the Resource Sheet. And of course we solved our 

overallocation issue here by having three contractors. Let’s go back to the situation where we 

only had one contractor and let’s go back now to the Resource Graph. 

Now you can see how this Resource Graph here would immediately have shown you where your 

overallocation problem was. And to a large extent the extent of your overallocation. And you can 

see that contractor is over-allocated and you can see exactly when the contractor is over-

allocated as well. So this is a very good view for identifying where overallocations occur. 

So I’ve introduced you there to a couple of other important views. There are many more in 

Project 2016. If I click on Other Views and then on More Views I get this More Views dialogue 

where you can access the many different available views. We’re going to be looking at some 

more of those during the course. But I strongly suggest that you work your way through those, 

experiment with those. A couple of those you won’t see because they’re custom ones. They’re 

ones that I’ve made for my own projects. And you can create your own views. You can copy a 

view as a starting point for a custom view and you can edit the definition of a view. So as your 

use of Project 2016 develops it’s a good idea to find out about customizing views because it 

really can save you a lot of time and effort. 

Now what I want to look at next is splitting the view. So I’m going to go back Gantt Chart View 

and now I’m going to go to the Split View Group on the View Tab and I’m going to click on the 

Details checkbox. And what that dos is to split this view into two horizontally. The top part is 

still a Gantt Chart. The bottom part is now a Task Form. Now the important thing about this is 

that the task form will show the task information for the selected task in the Gantt Chart at the 

top. So if I click on Decide about project manager that’s the information that I see in here. Let 

me go down to a further part of the project, say down to here, Prepare for flooring. Now watch 

what happens when I click on Prepare for flooring. I’ll actually see resource names here. So the 

contractor is the resource. And I’ll also see a predecessor here. Now what you see in this task 

form is something you can choose. So you can decide which particular information to show in 

the task form. I’ll come to that in just a moment. 

But if I use these Next and Previous buttons they can be used to take me through the tasks in the 

project. So I’ve currently got Prepare for flooring which is task with ID 45. Let’s look at next. 

And note that as I step through with Next and Previous I get the task information for the selected 

task in the Gantt Chart at the top and that’s what I’m controlling using these Next and Previous 

buttons. 
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Now as I mentioned just now you can actually choose what you want to show in the bottom for 

the selected task. If you right click over the task form it gives you options, predecessors and 

successors, resources and successors. You can even show in there schedule. And that includes 

things like the amount of work, 16 hours, the scheduled start date, the scheduled finished date, 

and the leveling delay that’s currently applied. You can show work, the units, the work, overtime 

work, baseline work, actual work, remaining work. We’ll talk about those later in the course. 

And you can include things like cost and notes. So you’ve got a good selection of things that you 

can show in the task form. 

If I go back up to the Split View Group and the dropdown next to the Details checkbox you can 

even choose what is shown in the lower part of the Split View. So we’ve currently got Task 

Form there. I could show a Resource Form. Now you might think that’s a bit strange isn’t it 

showing Resource Form there when you’ve got a task shown in the top. But in fact what it means 

is I’m looking at the Prepare for painting task. The person working on that is the contractor. And 

what I’m seeing own at the bottom here is the work that the contractor is currently scheduled to 

do. So I can actually look at what one of the resources working on the selected task is doing. If I 

chose as my selected task Second fix electrics I’d see tasks that the electrician is currently 

assigned to. 

Now when you’ve finished using a Split View there’s a couple of ways of switching it off. One 

is to simply uncheck the Details checkbox there in the Split View Group. The other way is to just 

hover over the split bar there till you get that double arrow for the cursor and then just drag it off 

the bottom of the screen. 

So there are just a couple of other things I’d like to show you about views. You’ve already seen 

how to use the zoom to entire project but sometimes when you’re working on just part of a 

particular project you may want to get some kind of automatic zoom so that you can see the most 

detail of that part of the project. So let’s suppose that I was interested say in the preparation 

phase of the bathroom refit. If I select those tasks, just the tasks in the preparation phase, go to 

the Zoom Group, Zoom button, go to the Zoom dialogue and choose Selected tasks, what Project 

2016 does is to zoom just to those tasks. And in that way I can get the maximum amount of 

detail in view. Now exactly how this works does vary a little bit because it does have to deal in 

whole time units. So sometimes you’ll get perhaps a tiny bit more or a tiny bit less than you 

need. But a little bit of scrolling, maybe slight adjustment on the timescale you can normally 

come up with just the result that you want. 

And finally one other view that I’d like to show you. We will be seeing some others later on in 

the course but one particular one that also can be very, very useful. Let me go back to the top of 

this project. Just make sure I haven’t got a particular task selected. And let’s look at Calendar 

View because Calendar View is a very interesting one where you can see the tasks of the project 

set out on a calendar. Note how the milestones are colored differently. And you’ve got selected 

tabs at the top there where you can choose Month View, Week View, or in fact Custom View 
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showing a number of weeks or a date range. So that’s Calendar View which can be a very useful 

way of looking at what’s coming up on a project. 

That’s basically it on views for this section. In the next section we’re going to take a look at 

Timelines. So please join me for that. 
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Video: Timelines 

Toby: Welcome back to our course on Project 2016. 

In this section we’re going to take a look at Timelines. And primarily Timelines are used as a 

communication and presentation tool. A Timeline can be a pretty good way of getting a summary 

of aspects, possibly even all aspects of a project and presenting them to an audience, perhaps 

who aren’t as interested in the detail of your projects as you are or certainly an audience where 

the people don’t have or use Microsoft Project. So you want to show them just the right amount 

of detail of a project, maybe highlight certain points without going into the sort of complex 

diagram that we have here for the wedding. 

So first of all let’s switch on the Timeline for the wedding and see what it looks like at the 

moment. On the View Tab in the Split View Group there is a checkbox, Timeline. If I click on 

that you will see the current Timelines for this project.  

Now along the top of the Timeline you have dates. The left hand end by default is the start date 

of the project and the right hand end by default is the end date for the project. Now at the 

moment there are no tasks shown on the timeline. And the only other thing shown is a marker 

indicating today. If I wanted to show some tasks on the Timeline, let’s suppose I wanted to show 

the selecting and ordering of the bridesmaid dresses. If I select that task in the Gantt Chart and 

right click one of the options is Add to Timeline. And that task now appears in the Timeline. And 

you can see its duration in particular relative to the duration of the overall project. 

Now so far I’ve pretty much ignored people using touch so let me just do a little touch demo 

here. Let me just switch into Touch Mode for just a moment and let me go to Make guest list and 

then I’m going to press and hold that task and then on the dropdown, the contextual menu from 

the mini toolbar, one of the options is Add to Timeline. So that’s how you do the equivalent 

thing in touch. And as usual that’s pretty close parallel to doing things with touch to doing things 

with keyboard and mouse. So I’m just going to switch back to Mouse Mode. 

So in that way you can add whichever tasks you want to to the Timeline in order to highlight 

those, to perhaps group some tasks together for the purposes of a presentation or indeed just to 

give yourself a good summary of how a selection of tasks relate to each other and often how they 

are progressing. 

Having added a couple of tasks to the Timeline it’s very easy to take them off again. So if I right 

click on Make guest list one of the options there is Remove from Timeline. It’s important to 

recognize that you don’t use the timeline in some automated way. You select what to add and 

you’ll usually select it on the basis of the purpose of the timeline, which as I mentioned earlier 

will quite often be some kind of presentation or summary of progress on all or part of a project. 
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Now one of the very important aspects of a timeline is that you may well want to format it. If I 

select the timeline then I have Timeline Tools a Format Tab and on that tab I have facilities, for 

instance, to change the color of bars, to change the text styles and so on. Now I’m not going to 

look at them in detail now but let me just select that Select and order bridesmaids dresses task 

and let me go up to this command here which is the background color. Let me change the 

background color to say that one and as you can see you can format the color in this case. I could 

perhaps use a larger font for the text and so on. Now I’ll leave you to experiment with those 

formatting options for the timeline. I’m going to undo the last of those changes that I just made. 

Now there’s nothing to stop you working on the timeline in the orientation of the screen, etcetera 

that I’ve got here. It’s a very convenient way for adding and removing tasks. But you can 

actually work on the timeline on its own. And sometimes the rest of the display can be quite 

distracting. So let’s adopt Timeline View. You can do this in a couple of ways. If you right click 

on the gray bar at the left there, Gantt Chart, one of the optional views that comes up is Timeline 

View. But you can also just drag down that divider and you finish up in Timeline View where 

the timeline occupies the whole of the view. And one of the advantages of this is that you can 

build up a quite complex content for the timeline without the distraction of as we had just now a 

Gantt Chart. You may immediately think, “Yeah but that’s not really very helpful is it because I 

can’t see the tasks to add anymore.” But there are a couple of ways of doing that.  

With the timeline selected, on the Format Tab in the Insert Group there is an Existing Tasks 

button. And if you click on that it brings up a hierarchical list of existing tasks. And if you 

wanted to put two or three more tasks onto the timeline select them like that, click on OK. Not 

only are they added to the timeline but if necessary the height of the timeline is adjusted to 

accommodate tasks that are actually happening at the same time.  

You can also add completely new tasks. You could add a task which isn’t even in the schedule 

yet. And when you do that it’s added to the schedule and to the timeline at the same time. So if I 

wanted to add a task now. The details come up. I can fill in the Task Information dialogue as 

normal. And when I click on OK it would appear on the timeline and in my project schedule as 

well. Now of course for it to appear in the right place in the project schedule I may have to set 

dependencies. I may have to set a start date and so on. But I can certainly enter the details of the 

task and have it added to both the schedule and the timeline in that way. I can add a milestone in 

that way. And I can also add something called a Callout Task. 

Now this is basically going to do the same as adding the task does but the task will in this case 

appear on the timeline as a callout. Now what happens with a callout is that it appears outside the 

timeline as almost a sort of note. So let’s take that task there, Register wedding. If I right click it 

one of the options is Display as Callout. And then it sort of appears as a callout outside the 

timeline almost as an additional note if you like. 
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Now earlier on I mentioned that one of the main reasons that people use timelines is for 

communication and presentation purposes. And if you have a timeline like this one then in order 

to present it or include it say in a PowerPoint presentation or send it to somebody in an email you 

have a number of options. On the Format Tab there is a Copy Group. And the Copy Timeline 

button there has three options, Copy for email, Copy for presentation, Copy full size. You can 

use whichever of those is most appropriate. Copy basically to the Clipboard and then Paste in an 

appropriate format either using the source Theme, the theme here that we have, color scheme, 

etcetera that we’re currently using in Project or using the destination Theme if you will, perhaps 

pasting it into a Word document. And you can also Paste it if you like as a picture. So you get 

exactly what you’ve got here and then you can resize accordingly in the destination software 

where you’re pasting this. And it’s a very convenient way of looking at all or part of a project 

and presenting it to people, perhaps just extracting the key points that you want to make in a 

presentation. 

And a final thing that I want to show you here is that the main new feature in Project 2016 in 

relation to Timelines was the ability to have more than one Timeline. So let’s suppose we want 

to just highlight a particular perhaps shorter period in the project and add some tasks to that 

particular period. Let’s suppose that we want to really show what’s going to be happening during 

the period April to June. 

If you look on the Format Bar in the Insert Group there is a Timeline Bar button. If I click on that 

it adds a new Timeline, a second Timeline. And what I’m going to do with this one is change its 

dates. So I’m going to change its date range to go from the start of April say, let’s say to the end 

of June. And of course I could take some or all of these tasks or other tasks from the schedule 

and for instance just drag from that timeline into that timeline. And now of course I can choose 

which of those timelines I’m interested in at any particular time. This could typically be a phase 

within a project. And I may just want to show the tasks that are occurring within that phase or 

over that time period. So that gives us the ability to use multiple timelines. 

If I now revert back to the Gantt Chart and on the View Tab I’ll switch on Timeline again, I’ll 

see both of the Timelines. And I can add tasks to either, remove tasks from either, drag them 

between timelines and so on. 

That’s it on Timelines. I’ll see you in the next section. 
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Chapter 10 – Costs 

Video: Setting Cost for Tasks 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to start to look at Costs. And I’m going to begin by looking at the 

bathroom refit project. We’re going to look at some basic aspects of costs in this project. Then 

I’m going to set you Exercise 05 to do, put in a little bit more detail about cost in relation to the 

bathroom refit. And then in the section after that we’re going to look at a couple of other more 

general aspects of cost and we’re going to also look at the cost for the wedding. 

So first of all let’s look at the cost for the bathroom refit. And what I’m preparing here is version 

05A of the bathroom refit project. And I’m going to go to the Resource Sheet and we’re going to 

look first of all at the cost related to the electrician. Now for work resources, generally, basically 

we would need at least a standard rate for a cost. And by default cost rate is entered in currency 

units per hour. You can express it, for instance, in cost per day but we’ll stick with per hour. And 

I’m going to put the electrician cost as $25 per hour as a standard rate. That’s the STD column. 

And I’m going to put it as $40 per hour for the overtime rate. 

Now as soon as I do that if I go back to the project itself, so let me just switch back to the Gantt 

Chart. There’s not really any noticeable different on that at all. But if I go to Project Information 

on the Project Tab and click on the Statistics button I’ll now see that I’ve got for the first time a 

cost for the bathroom refit. And it comes out, currently, at $800. Now the reason it’s $800 is of 

course because the electrician is scheduled to do 32 hours of work on the project. So the first fix 

electric is two days work. That’s 16 hours at $25. That’s $400. And then the second fix electric is 

the same amount, another $400. So let’s close that and let me return to the Resource Sheet. 

Now let’s take a look at a couple of other aspects of the cost of a work resource. We also 

specified here an overtime rate. And if for example I needed to get the electrician to work 

overtime, so to work outside the electrician’s normal hours of work then that is the rate I would 

need to pay the electrician at. This difference between standard rate and overtime rate can of 

course be very significant because it may increase the cost of, for example, keeping a project on 

time that is starting to slip. And sometimes you have to balance the cost of a delay against the 

additional cost of keeping on schedule.  

Cost per use relates to an additional cost for each time you might need to use a resource. This 

may apply to a work resource. So you may, for instance, have an agency hiring fee to pay or 

something like that. But it also could relate, for example, to a piece of equipment, the delivery 

cost of a pump or a special piece of machinery. 

The next column is the accrue column or the accrue at column. And this basically relates to how 

you accrue a particular cost. Now this will often relate to when you pay for it. Do you pay for it 
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up front? Do you pay for it as the work progresses? Do you pay for it at the end? And if I click 

on Accrual and click on the dropdown I’ve basically got those three options, Accrue at the start, 

Accrue prorated throughout the duration of the task, or Accrue at the end. Now when it comes to 

company finance of course the accrual will be handled probably by an accountant or a team of 

accountants. But in a smaller project it can be as simple as saying when do I have to pay for this? 

Now very often on a small job like a bathroom refit you may have already agreed with the 

contractor that you’re going to pay at the start or perhaps by installments as you go or pay at the 

end. So on this occasion I’ve agreed to pay the electrician at the end so I’m going to put Accrue 

at end. 

The next column determines which calendar is used by the particular resource. We haven’t 

looked at calendars at all yet. We’re going to be looking at them in a few sections from now. But 

basically by default we have a five day week, eight hour day working calendar. But a particular 

resource may have a different calendar. So for instance, this electrician may only be available 

Mondays, Tuesdays and Wednesday or may have different hours of work, perhaps starting 

earlier or finishing later than the rest of the people working on the project. If the resource in this 

case the electrician does have a different calendar I can specify it here. And when Project is 

doing its scheduling it will use the resources calendar rather than the default one for the project. 

But as I say, more on that later. 

So having put in the cost of the electrician and bearing in mind that I’m going to get you to setup 

the costs for the plumber and the contractor as part of Exercise 05, let’s look now at some of the 

materials on the bathroom refit. And we’re going to start with the flooring. 

Now I’m going to fit floor tiles. The type of resource is material. And the material column 

specifies the unit that this material is measured in. Now it’s going to be measured in square 

meters, perhaps the initials. And the standard rate will be the cost of one of the material units. So 

this is the cost of one square meter of floor tiles which we’re going to set at $36. Now in the case 

of the floor tiles we’re going to have to pay for those up front. So we’re going to put in here an 

accrual of Start. Now note cost per use in this case might, for example, be a delivery cost.  

Now let’s go back to the Gantt Chart. Let’s find the task Select and order flooring and let’s 

assign the floor tiles to that task. Floor tiles are here. And the number of units that we need, we 

need 12 square meters of floor tile. So I put 12 in here, click on Assign. Note the cost there, 

$432. Close that and that’s another additional cost. Note that the cost itself doesn’t appear in the 

Gantt Chart on the right but the assignment of the floor tiles resource does. 

Notice also that we’re going to have similar costs for the wall tiles here, Select and order wall 

tiles, Select and order paint, and Select and order equipment. 

So we’ve entered some of the costs associated with this project. Exercise 05 is going to involve 

you in entering some more. And it’s Exercise 05 that I’m going to cover in the next section. 

Please join me for that. 
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Video: Exercise 05 

Toby: Welcome back to our course on Project 2016. 

In this section I’m going to set you Exercise 05. And in Exercise 05 you are going to add some 

costs to the bathroom refit project.  

We’ve already put in a couple of costs related to floor tiles and to the electrician’s time. And 

what I want you to do in Exercise 05 is first of all to put in an hourly rate and an hourly overtime 

rate for contractors and for the plumber. For the contractors the hourly rate is $22 and an 

overtime rate of $33. And for the plumber the hourly rate is $25 with an overtime rate of $35.  

Now in addition to that I’d like you to put in the cost of the tile, that’s the wall tiles not the floor 

tiles. They cost $34 per square meter and we need 18 square meters. So when we Select and 

order the tiles we need to pay for 18 square meters. And for the tiles there is a delivery charge of 

$12. That’s a one-off delivery charge. 

For the paint we need 8 liters of paint. It costs $7 per liter and there’s no delivery charge on that. 

And for both of those material costs the cost accrue at the start of their respective tasks. 

So starting from 05A I’d like you to add those costs. That won’t be all of the costs associated 

with this project but it’s some more of the most significant ones. And my answer to that is 

Exercise 05B.  

That’s it for this section. I’ll see you in the next one. 
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Video: Adding Cost Resources 

Toby: Hello again and welcome back to our course on Project 2016.  

I want to start this section by taking a look at the cost so far on the bathroom refit project because 

in this section we’re going to look at some of the other costs that can be incurred in a project of 

this type, but also some of the other ways that you can deal with cost in Project 2016. 

Now the first thing I want to do is to take a look at Task Usage View again. And you may recall 

when we looked at this before that we can see the work for each of the tasks and where resources 

are assigned to a particular task we can see the amount of work that each resource is scheduled to 

do. If I right click on the details column there, so for instance over one of those words Work, it 

brings up a little contextual menu. And this is a list of the items that I can show in the right hand 

half, the time phased half of this display. And not only can I show work but I can show actual 

work, cumulative work, baseline work, they’re all things we’re going to look at a little bit later 

on. And I can show, amongst other things, cost.  

Now if I show cost then with the current timescale enabled I can show the cost of each of the 

tasks and where relevant each of the resources on each of the days that my project is in progress. 

Now interestingly if you look at the purchasing phase and let me just scroll back a little bit 

earlier in time. If you look, for example, at task 24, a little bit of adjustment here, Review 

available tiles. Select and order tiles. Although I’m not charging my time to the project for this. 

This is something I’m going to do myself. So the work that I’m doing as a resource is not 

chargeable. The cost of the tiles is chargeable. And because the accrual is specified as at the start 

given the two day task, Select and order tiles, which starts on that Wednesday, the cost of the 

tiles, $18 square meters, $624 is chargeable to my project on that Wednesday. And in fact that’s 

the same date that the floor tiles are chargeable as well, 12 square meters of floor tiles. That’s a 

charge of $432 to the project. 

And one other point to notice here, which can be quite confusing but it’s important to 

understand. Because we’ve assigned this resource to this task, so the floor tiles resource is 

allocated to the Select and order flooring task, Project assumes that we’re actually going to 

consume this resource on this task even though what we’re actually doing is paying for it on this 

task.  

Now there are a couple of other ways you can deal that and we’re going to be looking at those a 

little bit later on in this section. But it’s important to realize that some of the assumptions that 

Project 2016 makes when you assign a resource to a task are not necessarily how things are in 

reality. But if as in this case the cost works fine doing it this way, showing the cost when you 

buy the tiles even though you’re not using them in that buying task. You’re using them in a later 

task. Sometimes that approach will work, sometimes you would want to approach this in a way 

that more accurately reflects the situation in the specific project. 
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Now don’t forget that as before we can actually change the outline level. So if I wanted to look at 

these costs at Level 1. You can now see the cost profile of the whole project starting to develop. 

Now what I want to do now is go back to the Gantt Chart and do something else which we 

haven’t done so far. We’re going to look at this in more detail later on as well. But we’ve looked 

at our projects with a number of different views. Apart from changing the view you can change 

the specific table that is shown on the left hand half of, for example, the Gantt Chart View. And 

what I want to do here is to choose a different table. On the View Tab there’s a Tables dropdown 

in the Data Group. And instead of showing the default entry table I’m going to show the Cost 

Table.  

Now what the Cost Table shows me is a breakdown of the cost for my project at the appropriate 

selected level. Now you can see that for each of the phases here I have a total cost, a baseline 

cost, a cost variance, an actual cost, and the remaining cost. Now again we’re going to talk about 

those later on in the course. Let’s go to Level 2. And you can see a very detailed tabular 

breakdown of cost. And you can go right down to the level of checking the cost at any level of 

subtask. 

Now we still have the third type of resource to look at and that is a cost resource. And I want to 

refer you back now to what I said just a moment or two ago about how Project when you assign a 

material to a task by default will assume that you are going to consume that material uniformly 

during the task. And that may or may not be important in a particular project. 

Another way that you can assign the cost of a material to a task is just to assign it as a cost and 

then Project doesn’t assume that there is usage of the material at all. And it won’t of course even 

assume that a material is being consumed during the task.  

One of the major costs that we haven’t so far setup on this project is the cost of the bathroom 

equipment. And I could of course have a nice long shopping list of basins, faucets or taps, 

etcetera and put that all into the project, show the individual cost. But supposing that all I want to 

do is to say that well I’ve already figured out the cost of the equipment and it’s not consumed in 

the way that say paint is. It’s just a cost to the project. And what I’m going to do is to setup the 

bathroom equipment itself as a cost resource.  

So I’m going to go to the Resource Sheet. I’m going to add a new resource and it’s called, it’s 

type is cost. And when I set the type as cost a number of things happen. One of them is that I 

can’t put anything in the standard or overtime rate or anything like that. I can indicate how the 

cost is accrued and in this case I’m going to say it’s accrued at the end of the task in which I 

actually purchase it. But note there’s no calendar, there’s no cost, etcetera. And I enter the cost 

when I actually assign this resource to the relevant task. 

So let me go back to the Gantt, identify that task, purchasing phase, equipment, and Select and 

order equipment is the task where I’m going to assign this resource, this cost resource. So right 

click, Assign Resources. Bathroom equipment is a cost resource. And it’s only when I actually 
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assign it that I enter the cost. And the cost is going to be $3,000. Click on Assign and now I have 

that cost assigned to that particular task. 

Now the difference here is that Project does not assume that there is a material being consumed. 

And if I went back to Task Usage View and looked at this particular task you’ll notice that the 

cost of $3,000 is accrued at the end of the task. And if I, for instance, go back up again and look 

at tiling you can see the material usage against the task and the cost being accrued at the start. 

But in the case of the bathroom equipment and the cost resource there is no work involved at all. 

It’s just a cost resource. 

Now I hope that from that you’re starting to get a reasonable idea of how the different types of 

resource work and the situations in which each of them is most suitable. So where you have an 

amount of work, perhaps a duration of a task, an amount of work to do. Often it’s work resources 

that are best for that. Where you have a task where the amount of a resource that’s used, very 

often it’s material that’s good for that. Whereas where the cost is some kind of fixed figure then 

often a cost resource is a good approach for that. But unfortunately it’s not that clear a 

delineation and you may well need to adjust the way to do it depending on a particular project, 

particular situation. 

Now there are a couple of other examples of cost that I want to show you here and in fact there 

are some others that you’ll come across pretty later on in your use of Project. But just a couple of 

important ones here to know about them. 

And the first of them is a fixed cost that may be specifically associated with a task. Now in this 

case you might think of this as sort of the equivalent of the delivery cost of the tiles. But this is 

not a fixed cost associated with one of the resources used on a task. This is a fixed cost 

associated with the task itself. 

So I’m back to the Gantt Chart. Let’s look at an example of one of these fixed costs. When we 

looked at the cost table earlier I didn’t mention that very first column to the right of task name, 

fixed cost. But as an example of that let’s look in the electrical summary task. One of the items 

there is Certification. We need to get certification from the local authority on electricity, 

electricity board or local council or whoever it is. And there is a standard charge for getting that 

certification of $75. So we’re going to put in a fixed task cost of $75. And that needs to be paid 

upfront. So that’s a cost that’s accrued at the start of the particular task. Now note, it’s not to do 

with a resource. It’s not to do with the amount of material. It’s not actually associated with a 

resource at all, although you perhaps could identify the person who comes along and does the 

certification from the council or the electricity company, whatever it is. You could put that 

person on your project as a resource and say that you pay them a one-off charge of $75. But apart 

from the fact that means putting somebody on the resource sheet who’s only going to do that one 

job it makes sense to have this facility of just putting a fixed cost on that particular task, not 
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having to setup another resource but just to record that cost accurately within your project costs. 

Though that’s another alternative. 

The last example of a cost that I want to tell you about is a budget cost. Setting up budget costs is 

not very intuitive and you really need to know a little bit about how they work in order to 

remember and understand how to set them up.  

Let’s suppose that on this project I expect that I’m going to have to have some incidental 

expenses. So I’m going to need to pay for an odd sort of pot of glaze here, maybe a bit of 

beading or plastic or strip or something here. And I’m going to have to allow for the fact that I 

might need those expenses. I’ve probably got some idea of what they’re going to be. So I need to 

allow myself $300 over the life of this project to pay for those incidentals. Now I’m not going to 

allocate every single needle and screw and pin and bit of plastic to a task as I got. But on the 

other hand I do want to start out with a good idea of how much expense this project is going to 

incur. And this is particularly true if for example I need to get finance for it. 

Now what you can setup is a budget cost. But a budget cost applies to the whole project. And in 

order to setup that budget cost you create a budget resource and then assign it to the project 

summary task. 

So let’s first of all go into the Resource Sheet and setup our budget resource. I’m going to call it, 

and of course as it’s a cost resource I won’t be entering any rates or amounts of money here. I’m 

going to leave it the accrual at prorated. And then what I do is to open up the Resource 

Information dialogue and check the box that says Budget. Note that other checkbox there, 

Generic. That’s used for generic resources which we’re not going to look at at the moment but 

it’s something that you will come across later on in your use of Project 2016. 

So there’s my budget resource. Now let me go back to the Gantt Chart and let me select the 

project summary task, open up the Task Information for that. Notice it’s Summary Task 

Information. Go to the Resources Tab, select my new resource. You can only assign budget 

resources to the project summary task. You can’t assign them to any other task within the 

project. You also cannot at this stage enter a cost. I’ll show you how to do that in just a moment. 

Having done that click on OK. 

Now we go back to Task Usage View. And now what you see right at the top there is our project 

summary task and underneath it the single resource, Incidental expenses, which is of course a 

budget resource.  

Now what I’m going to do is to change tables so that we can see cost. I’m going to change to the 

Cost Table. And let me just make a little bit more room over here. And I’m going to include, 

insert a new column in this table. I right click on any one of the columns. It doesn’t matter which 

one. Click on Insert Column and I’m going to go down and find Budget. There it is, Budget cost. 
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And I’m going to put in my $300. So the only task in this project that has a budget resource is the 

project summary task and it’s got a cost of $300. 

Now as you’ll see later on when we start tracking cost I also need to manually track this cost. So 

if at the end of the first month I’ve spent $127 I’m going to need to show that I’ve spent $127 of 

those $300. But that is how to setup a budget cost on a project. 

Now as far as cost goes that’s certainly enough to get us started. It’s certainly enough for us to 

start to build up a good cost profile and a reasonable project cost. But that’s the end of this 

section. I’ll see you in the next one. 
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Video: Setting Up Budget Cost 

Toby: Hello again and welcome back to our course on Project 2016. 

In the previous section we looked at costs and I showed you quite a few different ways of 

handling cost but with specific reference to the bathroom refit project. I’m returning now to the 

wedding and we’re going to look at costs in the wedding because largely speaking the issues of 

cost in the wedding are completely different to those in the bathroom refit. And although we 

basically use the same tools and techniques in each of the projects that you manage in Project 

2016. It’s important to use the appropriate resources and the appropriate approach to cost 

depending on the type of project. So let’s take a look now at cost for the wedding. 

Now earlier on we added a small number of resources to this plan, assigned them to various 

tasks. What I’ve done now is to add quite a few more resources primarily as cost resources. If we 

look at the Resource Sheet you’ll see that I’ve added resources like wedding venue, reception 

venue and so on. And I’ve setup the accrual of those as end and you might think well surely 

you’re not going to pay for those venues at the end of using them. The important point here 

though is that those resources are not assigned to the use of the venue. They are assigned to the 

booking. And the cost is incurred in the case of the wedding venue when we book the venue. 

And if I go back into the Gantt Chart again the task where we’re actually assigning that resource 

is Book wedding venue. And the cost that I’ve entered there, $3,500, is going to be at the end of 

that task of booking the venue. It’s a cost resource. We’re not talking about consuming it through 

the life of the task. We’re talking about accruing a cost at that point. The use of the venue of 

course is on the wedding itself but you don’t pay for it then. We’re going to be paying for it 

when we book it. 

Now let’s suppose that in fact with this cost of the wedding venue we have to pay for it in two 

parts. We had to pay a deposit and we had to pay a balance, perhaps on the day of the wedding. 

In that case what you would normally do is to create two costs, a deposit cost and a balance cost, 

and assign the deposit cost to the booking task and the balance cost to the wedding day itself. 

Now I haven’t done that here but it’s a pretty straightforward thing to do. And with all of these 

costs associated with the wedding you may well pay them in two or more installments. And in 

that case you could cover that in that way.  

It’s certainly the case with most of these resources that you wouldn’t set them up as materials 

that are used during the life of the project. So if I just go back to the Resource Sheet again. In the 

case of the photographer, for example, the cost is there and again I’ve set it up for accrual at the 

end. That’s the task where we book the photographer. And if we were going to pay for the 

photographer fully in advance we would accrue this at the end of the task where we’re booking 

the photographer. 
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Let’s return briefly to wedding rings. I set them up as materials. We were talking about materials 

at that time. They’re not really material resources. Now you could say well the material is 

wedding ring. The unit is ring and we’re buying two of them and we are using two of them 

during a particular task. But in reality the wedding rings will probably be more appropriately 

setup as a cost as well. And indeed I’m going to change those to a cost resource as well. 

So as you can see virtually all of the resources here are setup as cost resources. We have work 

resources just to make sure that the work is spread out for the bride and groom and the 

bridesmaids. But of course that is not chargeable time. So we have pretty much a completely 

different arrangement here to the arrangement that we have in the bathroom refit. 

Now again referring back to the preceding section, many of the costs for the wedding could have 

been set up as fixed costs for tasks. And I’ve set one of them up here just to show that it can be 

done. In task 42, Register wedding and get license, I’ve put in there a local state license fee of 

$60 for a marriage license. Clearly many of the other costs could be handled in just the same 

way. One of the key differences there as you can see by say comparing 42 with 46 is that 

whereas the wedding venue cost shows as a resource on the Gantt Chart there and will be in the 

resource list for the task the cost of the wedding license, the marriage license being a fixed cost 

of the task doesn’t appear as a resource of the task. And of course you don’t need to setup entries 

on the Resource Sheet for these things. 

You will develop over time as you use Project 2016 more and more your own way of going 

about dealing with cost and very often the reasons for doing them in certain ways are very 

specific to the project you’re working on. 

So having setup those costs let’s go up to the Project Tab, Project Information, Statistics, and we 

have a cost at the moment of our wedding of $30,750. Now that’s probably about the average 

wedding cost in the United States, for example. It might be slightly below average at the time of 

recording this. Of course there will be other costs but on the other hand many of the costs that 

I’ve included here I’ve set a little bit higher than you’d normally expect to pay just as budgetary 

figures and then hopefully many of them will come in under that budgetary cost. It may also be 

the case with a project like this one that you may want to setup a budget for incidental expenses 

as we did with the bathroom refit. 

Now apart from assigning those costs to the project I’ve also done a little bit more work on the 

resourcing from the point of view of removing any overallocations. Currently we have no over-

allocated resources so my schedule works. And what I then did was to take task 7, summary task 

7, the preparation phase, and setup a dependency from 7 and the dependency is shown there, 

7FS+21 days. That’s a predecessor of the wedding day. Now you should by now be getting used 

to reading those. So this particular task, Wedding day, has 7 as a predecessor. There’s a finish to 

start link and a 21 day lag. So what I’ve said here is that having worked out how long it’s going 

to take to do the preparation I’ve then added 21 days and said that’s my wedding date. So that’s 
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given me in effect 21 days, that’s working days of contingency from the end of task 7, which is 

the preparation, through to the wedding day.  

Now at some point I may want to decide to fix that wedding date. I may choose the next 

Saturday, for example, if I want to have the wedding on a Saturday. By adding that bit of 

contingency there I’m going to allow for some of the little bumps that are going to happen along 

the way of this wedding project.  

But having done that and I am within my September the 1st deadline for the wedding. I’m now 

ready to get the project started and start tracking progress. That is what we’re going to start in the 

next section. I’ll see you then. 
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Chapter 11 – Baselines and Critical Paths 

Video: Measuring a Project Against a Baseline 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to take our first look at Baselines. And put simply the baseline for a 

project is basically what we anticipated, what we planned to happen. And hopefully when the 

project starts and we start measuring our progress on the project the baseline is what we keep 

close to. Ideally we’re going to deliver the project according to the use of resources, the 

timescales and the cost in our Baseline. 

The Baseline is in effect a snapshot of a project at a point in time. So in the case of the wedding 

if I decide that I’m now happy with my resource allocation, I’m happy with the cost, I’m happy 

with the date, and I’m happy with the sequence in which all of these things are happening then I 

can say that is what I intend to happen. That is going to become my Baseline. And from this 

point onwards I’m going to measure progress against this Baseline. 

Now in the case of the wedding and bearing in mind that in this case it may well be the bride and 

groom that are paying for it it’s probably very, very important to them to know whether they’re 

keeping within their budget and to know whether they’re working to schedule or not. And as 

with any other project it’s unlikely that exactly what is in this schedule that you’re looking at 

here is what’s going to happen. There are going to be some problems. There are going to be 

some ups and downs. The cost may be higher here and lower there. Tasks may be delayed. Tasks 

may take less or more time than you anticipated. 

So the measuring of progress is very important. But we measure it against a Baseline. 

Now I should point out a couple of project management related things about baselines just before 

we start. One of them is that the use of a Baseline is a very good tool for measuring progress, for 

measuring progress against cost, timescales, etcetera. But it’s not that difficult to pull the wool 

over people’s eyes with progress reporting against the baseline. And when you’re looking at 

progress against the baseline it’s very important to understand what you’re looking at. 

Let me just give you a very quick example. I went to a meeting once where somebody was 

explaining how the costs on a project were way below budget and they were actually spending a 

lot less than anticipated. Everybody in the audience was really impressed. But the reason they 

were spending less than anticipated was because they were so far behind schedule that they 

hadn’t bought half of the materials yet. So they’d taken bad news and turned it into good news. 

Having said that, there is a technique called Earned Value Analysis which largely circumvents 

these potential pieces of deception and gives you a true picture of how well a project is doing. 

And in fact there are good features for Earned Value Analysis in Project 2016. 
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The other thing to point out is that once you’ve saved your Baseline under normal circumstances 

you wouldn’t change it, you wouldn’t if you like move the goal post for your project. But there 

can be situations when you will legitimately change a Baseline. So for example, you may be 

working on a project, say this wedding project, and shortly after you’ve started the bride and 

groom decide to make it a completely different sort of wedding. So they decide to hold the 

wedding overseas perhaps or to make it a much larger wedding or a much smaller wedding. And 

it would be ridiculous to try to measure progress on something completely different against the 

Baseline for the original wedding plan. So in that case you may need to change the Baseline or 

you may need to just clear the Baseline altogether and start again. 

I’m going to assume for the purposes, generally speaking, of this course that once we’ve got a 

Baseline that’s it. So let’s take this project as it is and save it as a Baseline. 

And what I’d like to do as we’re doing this is to just demonstrate what saving or setting a 

Baseline actually does. So I’m going to change the table shown in the Gantt Chart here again. 

You don’t actually need to do this to set a Baseline but I’m going to do it on this occasion. And 

I’m going to choose a different table. The table I’m going to choose is actually called the 

Baseline Table. I’m going to apply that table. And what you can see here in the Baseline Table 

are the baseline duration of each task. Note everything is zero. And the reason is because this 

baseline information hasn’t been set yet, until we save a baseline all of these fields are empty. 

We have a baseline start date, baseline finish date, baseline amount of work, and there are 

various other baseline fields such as you would expect baseline cost. So when we set the baseline 

all of these fields get filled in. Of course some of them may say zero. But things like baseline 

start and baseline finish will record the start and finish date as they are in this version of the plan.  

What I do now is go to the Project Tab. There’s a Set Baseline option there. Click on Set 

Baseline and that brings up the Set Baseline dialogue. Now the first thing to point out here is that 

when you set a baseline you choose which baseline to set. By default it’s Baseline. But in fact in 

Project you can have up to eleven baselines. That’s baseline and ten alternatives. What can 

happen during the life of a project is that after you’ve been working on the project for some 

length of time there are so many things to change and you get to a point where you need to save 

a new baseline but you may want to save the original version of a baseline. You may want to 

save many earlier versions of a baseline, possibly for reporting purposes, just to keep a record of 

them and so on. And that’s why you are given these up to eleven baselines which basically 

means up to eleven sets of baseline values. 

The second option on this dialogue is Set Interim Plan. I’m going to tell you about interim plans 

in two or three sections from now. I want you to ignore interim plans at the moment. 

And then you can either set a baseline for the entire project or for selected tasks within the 

project. I’m going to set it for the entire project and I’m going to click on OK and I want you to 
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watch what happens. And you hopefully weren’t surprised by the fact that very many of the 

fields in the Baseline Table were filled in when I set the Baseline. 

Now one very important thing to remember about baselines, although setting a baseline involve 

Project setting up a lot of information it’s very straightforward to clear a baseline. If you go back 

to that same button in the Schedule Group on the Project Tab, click on the bottom there, Set 

Baseline. The other option is Clear Baseline. And that says, Which baseline do you want to 

clear? It lists the available baselines and where one has been saved it gives you the date that it 

was saved on. So that’s the one that I had just set. I get an option to clear an interim plan and 

then I can also clear a baseline for the entire project or selected tasks. Let me clear this baseline, 

the one I’ve just saved for the entire project. Click on OK. Everything goes back to the way it 

was. Let me just set it once more. And I now have a Baseline. 

Once the baseline has been set you have the basis to measure progress on a project. And we’re 

going to be looking at tracking progress a little bit later on in the course. I also need to tell you 

one or two other useful things about baselines but before we do that you’ve got a couple of other 

things to do. First of all in the next section I’m going to tell you about the Critical Path. And then 

following that you’re going to set the baseline for the bathroom refit. But that’s it for this section. 

I’ll see you in the next one. 
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Video: Working with Critical Path 

Toby: Welcome back to our course on Project 2016.  

In this section we’re going to look at the Critical Path in Project 2016. In the preceding section 

we saved a baseline for our wedding project and now we’re going to look at the Critical Path. 

The reason that I want to look at the critical path now is because as we start to track progress on 

a project it’s very often the case that things start to go wrong. Things get delayed, they take 

longer than expected, perhaps cost increase. And any one time you may need to get back to a 

situation where you are saving time, you’re making up for slippage on a project. And when you 

need to make up for slippage what you really need to know is which tasks are really driving 

when this project is going to finish. The set of tasks that determine when a project is going to 

finish is called the Critical Path. And the tasks within the critical path are usually referred to as 

the Critical Tasks. 

So the first thing I’m going to do with the wedding project is to find out what our critical tasks 

are.  

Now in order to do that in Gantt Chart View if I go to the Format Tab in the Bar Styles Group 

one of the options there, there’s a checkbox, Critical Tasks. And if I check Critical Tasks it will 

show all critical tasks in red. Note the Screen Tip description there. A task is critical if it must be 

completed on schedule for the project to finish on schedule. So if I check Critical Tasks you can 

see that the red tasks are the ones that are actually determining when this project is going to be 

completed.  

Now sometimes, and particularly with a project with a lot of tasks in it, it’s difficult to see the 

critical tasks. They may be spread out quite a bit as are these. And there is a way of only showing 

the critical tasks. And in order to do that we’re going to look at another important aspect of 

views.  

So now I’m going to click on the View Tab and I’m going to apply a filter. Now in this case the 

filter I’m going to apply, note the control there with the little picture of the chemical filter there, 

is Critical Tasks. So the filter is called Critical. And now I only see the critical tasks in my 

project. 

Now it’s quite often the case when you look at the critical path on a project that it is a continuous 

critical path. What I mean by that is that for every day of the project from the very beginning to 

the very end there is at least one critical task happening.  

In this particular project that is not the case. There are I think three significant gaps. And 

sometimes gaps are completely explicable. They’re there for a good reason. No problem with 

them at all. Sometimes they can indicate that maybe there’s a problem with the way that you 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

have your project setup. Let’s just take a quick look at a couple of the gaps here just to give you 

an idea of how these things can occur. I’m going to look first at the one towards the end. So this 

is the one that occupies quite a bit of August and it’s the gap after Select honeymoon destination 

and Book honeymoon which is a critical task and Wedding day which itself of critical because 

it’s the end, it’s the last day of the project. Now the reason there’s a gap there is because I setup 

that 21 day contingency. So I said that Wedding day is going to be 21 days after the end of the 

preparation phase. Now given the definition of what a critical task is, it’s one that’s happening 

and can’t slip. There are no tasks occurring in that period so none of them can be critical. So 

that’s a perfectly legitimate gap in a critical path.  

The gap in the middle is largely down to the effects of resource leveling. And what can happen 

sometimes is that although we’ll know one particular task has to be completed by a particular 

day you have a lot of work to do. You can probably be reasonably flexible in the order in which 

you complete the tasks subject to dependencies, constraints, etcetera. But basically you just have 

a lot of work to do in the time and resource leveling will sometimes cause gaps.  

The first gap, that’s after Agree budget and approach and before Make reception venue shortlist, 

there is actually a task active there which is Making of the guest list. And there are dependencies 

on that although the dependencies on Making the guest list are based on its start date not its end 

date which will sometimes stop a task from being critical anyway. But the gap here is largely 

down to a combination of leveling and task prioritization as well. 

So in many ways this particular project schedule is quite unusual. The critical path is quite 

unusual because of the number of gaps but there are reasons for those gaps. And you will tend to 

get gaps, for example, in projects where you have a lot of resource issues and also where there 

isn’t a very definite sequence through the project. You’ve got a lot of things to do over a period 

of time but the sequence isn’t as well defined as it is say in the bathroom refit. 

So what I’d like to do now is show you another way of looking at criticality of tasks. And first of 

all I’m going to change the table that’s in use here. I’m going to go back to the Entry Table and 

I’m going to insert an additional column in here. I’m going to insert column and what I’m going 

to insert is called Finish slack. And what Finish slack shows me is the slack, the amount by 

which any task can be delayed, its finish can be delayed without affecting the end of a project.  

Now for critical tasks their finish slack is zero days. And as you can see all of these red tasks 

have a finish slack of zero days. In fact in Project 2016 you can change, if you like, this 

definition of critical and say for example that any task with two days or less finish slack is 

regarded as critical. We’re not going to look at this on this course. For the moment we’re going 

to stick with the standard definition that a task is critical if its finish slack is zero days. That 

means that if it was even one day late it would affect the end date of the project. 

Now let me remove that critical filter and let’s look at the finish slack on all tasks. Now if you 

look at something like Select wedding dress that’s got 48 days of finish slack. So that could be 
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48 days late, bear in mind various other tasks follow on after that. But it could be 48 days late 

without affecting the finish date of the whole project. And if you look down at all of the other 

tasks in the schedule you’ll see that all of the noncritical tasks have in many case a significant 

amount of finish slack.  

Something else that you might well find useful, again if I go to the Gantt Chart Tools Format 

Tab, underneath the Critical Tasks checkbox in the Bar Styles Group there is a Slack checkbox. 

And if you enable that for each task you will see a visual indicator of its slack. Now of course for 

the critical tasks there is no slack. But if you look down at other tasks you’ll see a line. If you 

take, for example, this one, measurement and fittings, look at that line that goes out to the right 

hand end, the black line. It indicates the slack on that particular task. The slack also shows on 

summary task. So the various summary tasks within the preparation phase you can see how much 

slack there is in each of those as well. So that again gives you a good visual indicator of how 

much slack there is in individual tasks within your schedule. 

So in this section we’ve looked at the Critical Path and Critical Tasks and at Slack. A couple of 

other things to mention. If I go back to the Resource Tab and go into Leveling Options. Again I 

mentioned this earlier on. Level only within available slack. If you click on Level only within 

available slack that does severely limit the amount of leveling that Project is able to do but it 

does also mean that you don’t cause delay.  

And secondly if you need to shorten the project, possibly to deal with a delay during the running 

of the project, the place to start is with the Critical Path because it’s the Critical Tasks on the 

Critical Path that basically determine when the project is going to finish. So the critical tasks are 

the place to start. 

That’s the end of this section. In the next section I’m going to set you Exercise 06. Please join 

me for that. 
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Video: Exercise 06 

Toby: Welcome back to our course on Project 2016. 

In this section I’m going to set you Exercise 06. Now this is a pretty straightforward exercise. 

You’re looking here at an outlined version of the bathroom refit project. And all I want you to do 

is to save a Baseline for the project. Bear in mind that the dates that you have will almost 

certainly not be the same as the dates that I have so I can’t tell you specifically, for instance, 

when your project starts and ends. But the shape of the project should be very similar to the 

shape that you see here. 

So I want you to save a Baseline. And having saved it what I’d then like you to do is to highlight 

the Critical Path on the project. 

Now my answer to that is in version 06B of the bathroom refit project. And with the critical tasks 

filtered you can see the critical path on the bathroom refit project. Obviously it’s a completely 

different proposition to the wedding because there really aren’t any gaps and in many places or 

many days there are two or more critical tasks in progress. If any project where there is a definite 

sequence to the task that needs to occur you will normally see a Critical Path which is much 

more like this one, pretty much virtually gap free. 

So there we are. That’s my sample answer to Exercise 06. That’s the end of this section. I’ll see 

you in the next one. 
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Video: Changing Baselines 

Toby: Hello again and welcome back to our course on Project 2016. In this section I’m going to 

tell you a few more things about baselines. 

We’ve already set a baseline for each of our two projects, the wedding and the bathroom refit. 

And I want to talk about what happens if you need to change a baseline first of all. 

Now there are various situations in which a baseline might need to be changed. In some cases 

you may have a reason if you like legitimately to change a baseline. In others circumstances may 

mean that rather than changing the baseline you perhaps ought to be saving a new one. 

Let’s start with what might be called a legitimate example of changing a Baseline.  

I’ve done the plan for the wedding. I’ve setup the costs. I’ve sorted out my resource 

overallocations, etcetera. As far as I’m concerned everything is looking good. I decide to save 

my Baseline. And just after I’ve saved the baseline I realize that I’ve left something out. And the 

thing I’ve left out is the best man or the groomsman’s tuxedo which I know is a cost to the 

wedding. We promised the groomsman that he’s going to get a new suit out of this. And so really 

this is not a case that the cost of the wedding has been exceeded because of something changing. 

It’s a straightforward mistake. We’ve left something out. It should have been in the baseline in 

the first case. Now what I don’t want to have to do is to sort of start again. I just want to add to 

that one task to the baseline.  

Now another situation of a similar nature might be, for instance, if I had literally just got the cost 

of something wrong and I realize soon after I’ve saved the baseline that one of the costs is 

wrong, one of the durations is wrong, and I don’t want it to appear that the project is already 

going wrong. I’ve just made if you like an honest mistake at the beginning. 

Now I can update the baseline. And the way that I would normally do that is by making the 

changes that I need to make and then doing a Set Baseline but only for selected tasks.  

So what I’m going to do here is to insert the task that’s missing. I’m going to put it after select 

and order groom tuxedo. Now you might be tempted at this point to say okay well I can fill in the 

baseline figures here. I can put in the baseline duration, etcetera. That isn’t really how baselines 

work. When you want to add an item like this to the baseline or you want to change an item you 

need to do it by setting the normal fields up and then doing a Set Baseline because Project 2016 

does a certain amount of calculation, there’s a certain amount of dependent processing going on 

and you can’t successfully and correctly update a baseline just by typing the baseline figures in, 

which you might be tempted to do here.  

Now there’s a couple of things I could do here. I could, for instance, bring up the Task 

Information dialogue box. But what I’m going to do is to change back to the normal Entry View 
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for just a moment. And I’m going to change the settings for this task. So I’m going to say it’s a 

20 day task and I’m going to say that it really needs two resources. One resource is going to be a 

little bit of time by the groom to help the best man, the groomsman, to choose a tuxedo. But I’m 

also going to need the cost of the best man tuxedo. So let’s go to the Resource Sheet and insert a 

new cost resource. I put best man’s attire because he might get a pair of shoes out of it as well. 

So there’s my new resource. It’s a cost resource of course. And as I say, I’m just going to need 

10% of the groom’s time just to get involved in the selection of the best man or groomsman 

tuxedo. There we are. 

So now we have an overallocation on the groom’s time. And we have one more thing to do 

before we look at that overallocation and that is we don’t want the best man’s attire to be started 

until we’ve started on selecting and ordering the groom’s attire. So what I’m going to do is select 

tasks 14 and 15 and I’m going to establish a link between them. And so what I’m going to say is 

that we’re not going to sort out the best man’s attire until after the groom’s attire is sorted out. So 

I’m just going to setup a link between those two. And in fact in doing that the resource 

overallocation is resolved anyway. 

So having done that what I’m going to is to select that single new task there, task 15. I’m going 

to go up to the Project Tab and the Set Baseline, click on Set Baseline. Make sure that I have the 

correct Baseline selected which is the only one we have at the moment. And I’m going to say For 

selected tasks. And in fact in this case only one task has been inserted. If I had inserted other 

tasks or changed other tasks if I selected those first they will be included in this operation. 

Now there are a couple of important checkboxes here and I’m going to briefly explain these to 

you.  

If you add a task like this note that it isn’t only individual tasks that we store baseline 

information for. If we have a task within a summary task, in this case this task is within the 

Attire summary task, then I’m sure you notice that we have baseline information for the 

summary task. And in turn baseline information for the phase that that summary task belongs to, 

in this case the preparation phase. And in turn baseline information for the whole project. And 

we’re going to look back at the Baseline Table in just a moment. 

Now in the process of adding this task we have to decide whether we want to change, whether 

we want to update the baseline figures for all of the summary tasks up the tree if you like. So do 

we want to roll up baselines to all summary tasks? We also have the option of selecting which 

summary tasks we want to update baseline information for. This is called Rolling up the 

information. So if we wanted, for example, to leave all of the original totals as they are and just 

add the individual task we wouldn’t check either of those boxes. Now on this occasion I’m going 

to say Roll up baselines to all summary tasks. I’m going to click on OK. I’m going to say Yes 

and then I’m going to go back to the Baseline Table and now you can see that for our Select and 

order best man tuxedo task we have all of its baseline information saved. And in fact if you 
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checked earlier versions of this file and the Baseline Table you’d see that all of the summary 

tasks have had their baseline information updated as well. 

Now at this stage I have two other things to tell you about in relation to baselines and I’m going 

to if you like join those two topics together. And one of them is copying baselines and the other 

one is the use of interim plans.  

It’s very often the case that particularly in long projects things do change. And after a time it 

becomes inappropriate to measure progress against an original baseline because so many things 

have changed. Now we’re talking here about the scope of the project rather than things just going 

wrong. But there often comes a point when you decide that what you really need is a new 

baseline to measure progress against.  

Now best practice normally says that whatever happens you are going to save the original 

baseline. And the normal way to save a Baseline in Project 2016 is to Copy it. I mentioned there 

are a total of eleven sets of Baseline fields. Many people Copy the original Baseline to Baseline 

ten and that’s the convention that’s used as a way of keeping the original Baseline. Now that is 

just a convention. You can actually Copy any Baseline number to any baseline number. But the 

reason for putting these two topics together as I mentioned just now is that you do that as part of 

what appears to be setting an Interim Plan.  

An Interim Plan is in effect a sort of low fat Baseline. An Interim Plan is if you like a Baseline 

with just the start and finish dates in it. Baselines in general store information about work and 

cost and durations. They’re all in the columns that you can see in front of you in the Baseline 

Table here. An Interim Plan only has start and finish dates in it. And the reason that people 

sometimes use Interim Plans is again it’s related to change in a way. If, for example, you’re 

working on a project and you’ve got all your costs and your work and your duration, everything 

is fine. But there’s a holdup. There’s a very well-known example of a holdup. About two or three 

years ago in the UK a major government project was held up by the discovery of some rare 

spiders when they came to put in the foundations, the footings of a major new government 

building. And the whole thing was held up for quite a few weeks while they were trying to find 

out a way of rehoming these very rare spiders. Now in terms of the actual project cost, work, 

etcetera, little if anything changed but all of the dates were thrown out by a good few weeks. I 

can’t remember exactly how much it was. So what people will sometimes do is stick with the 

original baseline but measure progress in terms of time against an interim plan. 

Now if you want to set an interim plan, if you go to the Project Tab, go to Set Baseline, click on 

Set Baseline. The second option there is Set Interim Plan. And what you do when you set an 

interim plan is you copy something to something. So I could copy the currently scheduled start 

and finish dates to a start one and finish one. Now that pair of start and finish dates constitutes an 

interim plan. And if I wanted to see the interim plan or measure progress against the interim plan 

I would measure progress against start on and finish one.  

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

Now in doing that you can actually copy a baseline instead. So if I wanted to copy the current 

baseline to, for example, baseline ten to make like a backup I can do that using this Set Interim 

Plan function which in this case isn’t setting an interim plan at all. It’s just copying a baseline to 

a baseline. And as you can see there by default it will do that for the entire project. So if I did 

that now I would Copy the current baseline to baseline ten. 

Okay that’s it for this section. Please join me in the next one. 
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Chapter 12 – Tables 

Video: Modifying Task and Resource Tables 

Toby: Welcome back to our course on Project 2016. 

In this section I’m going to look in a little bit more detail at Tables. We’ve used tables. I’ve 

switched between tables a few times already in the course. And much of what you need to know 

hopefully you will have picked up from what we’ve done earlier on. But there are a few specific 

things I need to point out to you. 

Now the first thing to point out is that a table is really just a collection of pieces of information 

about either a task or a resource. The tables in Project 2016 are divided into Task Tables and 

Resource Tables. Task Tables contain information about tasks and I’ll let you guess what 

Resource Tables contain. 

Now there are several different Task Tables. And if we go back to the View Tab and click on the 

Tables dropdown what are perceived to be the most commonly used ones are the Cost Table, the 

Entry Table, Hyperlink, Schedule, etcetera. There’s about eight or nine there. But there is a full 

list of tables and it’s actually quite a long list. Now the list that you see in your installation of 

Project 2016 will not be the same list as the list you see here because I have some custom tables. 

I have a table here called TA Weekly Update. And that’s a table I created myself to make it easy 

for me to update progress on a weekly basis on some of my projects. I’ve also got some custom 

tables up here that I use for specific customer related information, again on some of the projects 

that I manage myself. But the other tables here are ones that you will see. And each of them 

contains a different combination of pieces of information about a task.  

So let’s go back to the Entry Table, one that you probably use quite a bit. If I click on Entry, 

click on Apply, you’re back to seeing the Entry Table in, in this case a Gantt Chart. 

Now in order to tell you a little bit more about tables what I’m going to do here is to drag the 

chart part right off to the right there somewhere, leave plenty of space, and talk about what’s in 

each of the columns in this table. An Entry Table is a combination of a certain number of 

columns. And in fact in any of the Task Tables or indeed any of the Resource Tables you can put 

in any combination of columns that you want. So if I wanted to insert a different column say 

between the start column and the finish column here, if I click on Finish, right click and click on 

Insert Column it gives me a blank column and I can choose which of the many task fields I want 

to include in this column. Now the list of fields is indeed a very long list. And just to tie it with 

something we’ve seen over the last two or three sections, the Baseline fields, our baseline budget 

cost, baseline budget work, etcetera. And then when you get to the end of the baseline fields you 

get the baseline one fields and then the baseline ten fields and then the baseline two fields. So an 

awful lot of these fields are actually related to baselines. If I go right down towards the end you 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

get various start fields, the ID start fields for interim plan start dates and then you’ve got various 

finish fields, finish to finish ten. They’re associated also with interim plans. But apart from those 

as you can see you have many, many other task fields that you could include in that column. So 

if for instance I wanted to put Finish slack in there I could. Now as I say the standard tables, the 

ones that we tend to use a lot have pretty much a default combination of columns. But you can 

adjust that combination of columns as much as you like.  

Now generally speaking a column corresponds to one of those available fields. But bear in mind 

that some of the fields are not restricted to containing single things. So for instance the 

predecessors field, the one which is shown in this column, has a sequence. It’s got a list of 

predecessors and the basis of the link, the dependency, for each of those. So in this particular row 

4, Set wedding date, 25,47. That tells you that that particular task has as predecessors 25 and 47. 

In the absence of any other information it’s a default finish to start dependency. If it’s not a 

default finish to start then in the way that you’ve seen earlier in the course the dependency is 

described. So for instance, down here task 19, 18SS+5. By now you should know what 18SS+5 

days means. 

Now apart from inserting a column in the way that I just showed between a couple of existing 

columns or should I say more specifically to the left of an existing column you also have this 

column at the end, Add new column. Choose a column. Let’s choose on this occasion Critical. 

And that’s now the right most column. Although having added that column what Project 2016 

does is to give you a new Add new column option on the right there. 

Now one thing that you may well find useful with tables is to be able to format them a little bit 

more comprehensively. And this is particularly useful when you’re doing presentations, possibly 

when you’re printing out something like a Gantt Chart and you want to make the information 

look smart and informative. 

If you right click on the head of a column one of the options is Field Settings and that brings up 

the Field Settings dialogue. Now in the Field Settings dialogue you can set or change quite a few 

things. The very first dropdown list here, Field Name, lets you choose the field name that’s 

shown. And it’s just that very long list again. Let’s stick with Start. But I could put a different 

title without changing the field name. So if I wanted to call it Task Start Date I could. I can say 

how I would like the title aligned. So for instance I could say that I want the title aligned in the 

center as it is now. How I would like the data aligned. Let’s change the data alignment from right 

to center. At the moment those dates are right aligned in the column. Let’s change them to 

center. Not because it’ll better but just to prove that I can do it. Let’s make the column wider. It’s 

currently 16 units. Let’s make it say 20 units. And where the header text is too long to fit. If I 

have this box checked then the text will wrap. If you look over the resource names column five 

to the right of this one you’ll see how the text is wrapped. Let’s on this occasion say that we’re 

not going to have header text wrapping. Click on OK and as you can see I’ve quite significantly 

changed the formatting of that column. Let me right click on it again. We go back to Field 
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Settings again. If I made it obviously too small and I had header text wrapping not set then I 

would lose part of the header text. And the other thing that you can do, right click one more time, 

Field Settings, is to say Best fit and then it will set the width to fit all of the data that’s currently 

in the column. 

Now there are various other ways in which you can customize the appearance. You can format 

columns. If you go to the Gantt Chart Tools Format Tab there is a Columns Group. And apart 

from being able to do things like insert a column you can also if you click on the dropdown to 

the right of Column Settings get into the Field Settings that you’ve just seen. And going back to 

the right click menu on this column in particular you can, for example, change the font. You can 

also do things like change text styles. Now I’m not going to spend a lot of time on that now. I 

suggest you experiment with formatting columns. 

One other thing that you need to be able to do is to hide a column which is basically doing the 

opposite of inserting a column. When it says hide a column it really means remove it from this 

table. It doesn’t delete any data. It just means that that column of information is no longer shown. 

So there you can see it. Although I’ve hidden that column it’s actually not deleted any data. You 

just don’t see that column anymore. If I wanted to insert the column again, so that was the start 

column. To find a particular field to include in a column you can start typing. So if I actually 

press the S key on the keyboard it takes me down to the S’s. If I now press the T it takes me to 

the ST’s and there’s the Start. And the Start column is back again. Note that because I had 

reinserted the start column in effect I’ve lost the customization that I put in before. 

So now for a very quick demonstration related to Resource Tables. If I go into the Resource 

Sheet we have only a table here. We don’t have some sort of chart on the right. But if you want 

to insert an additional column of resource information here. Let’s say you wanted something to 

the left of the max column. If I right click on that, Insert Column. I’m offered a list of resource 

related columns. So I could choose one of those. What about baseline cost? That will be the cost 

related to this resource in my project baseline. And as you can see for the bride and groom 

there’s no cost because their time isn’t chargeable. But you can see it’s $1,000 for wedding rings, 

$1,500 for photographer, etcetera.  

So pretty much everything else works just the same when you’re dealing with a Resource Table. 

You’ve even got the Column Formatting Group here, Columns Group on the Resource Sheet 

Tools Format Tab. 

Now finally let me just go back into the Gantt Chart again and go back to the View Tab and go 

into the Tables once more, and then to More Tables. If I wanted to create my own table I could 

click on New and that brings up the Table Definition dialogue. Give my table a name. For each 

field I can specify alignment, width, title, and so on. And in that way I can setup a table that 

serves a particular purpose and possibly combines together exactly the pieces of information that 

I want to cover a particular situation. 
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And one really final thing, let’s just cancel out of that. I’m not going to demonstrate creating a 

new table but it’s a good thing for you to experiment with yourself. Also back to the dropdown 

here under tables. If I’ve made lots and lots of changes to tables, I’ve added fields, formatted 

columns, done all sorts of things, there’s an option here Reset to Default. And that will reset the 

current table back to the default table. 

So that’s it on Tables. I’ll see you in the next section. 
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Chapter 13 – Gantt Chart 

Video: Formatting a Gantt Chart 

Toby: Hello again and welcome back to our course on Project 2016. In this section we’re going 

to take a look at Gantt Chart formatting. 

This is a topic on which we could spend an awful lot of time. I don’t propose to spend very time 

on it but I do intend to introduce you to some of the basic principles of formatting and then if you 

need to format your Gantt Charts extensively I’ll leave you to experiment with many of the tools 

that are available in Project 2016. 

Now when it comes to formatting you really have two major options. There is a high level tool 

called the Gantt Chart Wizard which can do an awful lot of heavy formatting for you and come 

up with pretty smart standard styles for Gantt Charts that can be very good for fitting in say as 

part of a presentation where you’re preparing other parts of the presentation in other tools. And 

then there is what you might call the manual approach to formatting a Gantt Chart. We’ve done a 

little bit of the manual approach already. I’ve demonstrated things like changing the font in a 

column. But the range of tools for manually formatting a Gantt Chart is actually quite 

impressive. I’m going to show you a couple of examples of manual formatting and then as I say 

I’ll leave you to it. 

Now before we get started here is an important point. If you’re going to work on formatting a 

Gantt Chart, in fact if you’re going to work on formatting any view, changing the layout, even 

changing the timescale and so on, unless you’re just doing a small temporary job and you know 

what you’re doing and you may want to leave things as they are or maybe just do an Undo to go 

back to where you were. If you’re planning to do something that may be a major change it’s a 

very good idea not to work on the particular view, in this case say a Gantt Chart View, but to 

work on a copy of it so that you can always go back to the original. Now I ought to qualify that 

just a little by the fact that if you look at the View Tab, Task Views Group on the left where the 

Gantt Chart button is. If you click on the dropdown at the bottom one of the options is Reset to 

Default. Now you might think well that will do the job for me. If all goes wrong I can reset to the 

default. And to some extent that’s true. The problem is that the default really is the default when 

you got Project out of the box if you like. So if you’ve done some formatting some time ago, 

you’ve been working on your formatted version for some time and then you do a second batch of 

changes say and you want to go back to where you were after the first batch, Reset to Default 

won’t do that. It’ll take you right back to the beginning again. So if I’m going to work in this 

case on Gantt Chart View and I want to make some changes to it I would normally make a copy 

of it and work on the copy. Now I’ll come back to that in a few minutes time. Let’s concentrate 

now on the Gantt Chart Wizard. 
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What you’re about to see is that the Gantt Chart Wizard is very easy to use but you’ll also see 

that it’s not quite so easy to find. It’s not actually on the Ribbon by default. And for some reason 

which is still unknown to me Microsoft make it one of the items that’s not shown on the Ribbon. 

And in order to use it the first thing you want to do really is to either put it on the Ribbon or to 

put it on the Quick Access Toolbar. I’m going to add it to the Quick Access Toolbar. So I go up 

to the dropdown at the right hand end, click on More Commands. In the category Commands not 

in the Ribbon one of them is Gantt Chart Wizard. There it is. Click on Add. It’s now added to my 

Quick Access Toolbar. Click on OK and it appears on the Quick Access Toolbar. 

Now let’s take it out for a spin. Let’s start Gantt Chart Wizard. This is a short series of screens in 

which you make some fairly straightforward choices. It’s quite a high level tool the Gantt Chart 

Wizard. But if you want to do something quickly that will give you pretty smart results it is a 

good option. 

So first of all let’s say Next. What kind of information do you want to display? Do we want 

standard information? Do we want to show the critical path? Do we want to show the baseline? 

Or do we want to show something else? Or do we want to actually show a custom Gantt Chart? 

Now I will let you experiment yourself with some of these other options. We’re going to go for 

standard. Click on Next. What task information do you want to display with your Gantt Bars? 

The information that it’s referring to here is the words that are on the right hand side of each bar. 

And until now we’ve not really looked at why those particular words are there and in fact how 

you can control which words are shown. But for the purposes of this exercise I’m going to say 

that I don’t want any words to appear. I’m going to say None. Note that I could have resources 

and dates, resources, or dates. I can also specify custom task information. Once again I’ll leave 

you to experiment with that. Click on Next. Do you want to show link lines between dependent 

tasks? Note that when you’re doing this you’re getting a preview of how things are going to look 

in this box on the left. So in this step you can already see that the word have been removed but 

the little lines are still shown to show the dependencies. If I select No the lines are no longer 

shown. I’m going to leave the dependency lines shown. Click on Next. And that’s it really. And 

then I just click on Format it. It chugs away for a moment or two. Click on Exit Wizard and there 

is my Gantt Chart formatted according to the choices that I’ve made. So that’s a very, very 

straightforward way of formatting a Gantt Chart. 

So that’s the quick way of doing it. And as I say you get pretty smart results. Let’s now look at 

some aspects of manual formatting. Just before I do let’s undo what we’ve just done. So I’m just 

going to click the Undo button there. We’re back to where we were. 

What I’m going to do first here is make a copy of the current Gantt Chart View. So if I click on 

Other Views, More Views, with Gantt Chart selected if I click on Copy it will make a copy of 

that. Give my new view a name. I’m going to call it TA Gantt Chart. My initials in there makes it 

easy for anybody else using this installation to know who has created a particular view. Click on 

OK. That new view now exists and I’m going to apply it. Don’t forget you can check which view 
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is currently applied by looking down on the left had edge here to the left of where the table is. 

And I’ve still got my original Gantt Chart to revert back to at any time if I need to. Now let’s set 

about doing some formatting of this view, this Gantt Chart View. 

First of all let’s do a little bit of formatting of the table. Note that it’s currently the Entry Table. 

What I’m going to do is to select all of the columns from task name to predecessors and I’m 

going to Best Fit all of those columns. So I’m going to go to Field Settings. I’m going to say Best 

Fit and the widths of all of those columns are adjusted accordingly. I’m then going to hide the 

predecessors list but leave the duration field there. I’m going to hide the work field and just so 

start and finish. Okay. And then I think what I’ll do is I will Center Align the contents of the 

finish column.  

And then finally as far as the total is concerned let me just illustrate a very important point here. 

If I select a number of entries here. Let’s suppose that I chose all of the text under the attire 

summary task. And if I right click to bring up the contextual menu and the mini toolbar. What if 

I change the font from Calibri to say Blackoak (Standard)? What you can see, that looks 

absolutely horrible of course, is that I have changed the font, style, size, etcetera for the selected 

fields, the selected entries in the selected columns. Let me just undo that again. But if I wanted to 

change all of the text to that font no matter where I put the cursor, whatever selection I make, if I 

click on Text Styles on the Format Tab in the Gantt Chart Tools, let me choose that same font 

again, click on OK. That applies to all of the text. So a Test Style change changes the text 

everywhere. Now I’m not suggesting that’s a good choice for this particular Gantt Chart but 

there’s a difference between changing individual items or selections and changing a style. So let 

me undo that as well. 

Now let’s take a look at a couple of aspects of formatting the chart itself on the right. First of all 

there is a Gantt Chart Style Gallery on the Format Tab and you can choose the style of Gantt 

Chart that you want. Now there are quite a few styles. We’ve got scheduling styles and we’ve 

got presentation styles. Let me try one or two of the presentation styles. And you might want to 

experiment with some of those to see which you like the most. And in general terms one of the 

key things here as we just saw with the table on the left is that you can either choose to style a 

particular bar or to change the style of all bars of a particular type. So in the Bar Styles Group, 

left there there is a Format button. If you click on the bottom of that you can format a bar which 

is a specific bar that you’ve selected or you can format Bar Styles. In this case let’s take a look at 

formatting Bar Styles. If I click on Bar Styles it brings up this rather complex looking dialogue 

where we can format just about every possible aspect of those bars.  

Now first of all we have different types of object. So we have straightforward task objects, we 

have splits, we have milestones, summary tasks, the project summary task, etcetera. Now with 

each of these we can choose its appearance and we can view or in some cases change various 

aspects of how the bar appears. So let’s say take our standard task which is what most of these 

bars represent. You can see the color there. You’ve got that appearance. If I wanted to change the 
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appearance I’ve got a number of ways that I could change it. For instance, at the moment there is 

no start symbol. If I click on the list of start symbols, supposing I wanted a start symbol that was 

say like that. And then I wanted the same shape at the end. I wanted that at the end as well. 

Watch what happens if I click on OK. All my bars now have that same start and end symbol. 

Let’s go back into Bar Styles again. So that’s an example of what you can do to start and end 

shapes. Let’s look at this middle section here, Shape, pattern and color. Supposing I wanted to 

make the pattern different, supposing I wanted to make it stripey like that, so vertical stripes. See 

how that looks? Okay. And then finally as an example of that what about the text that appears on 

the right? I’ve talked about that earlier on in the section where we were talking about the Gantt 

Chart Wizard. If I click on the Text Tab here, currently it says, On the left of the bar there’s no 

text. On the right there are the resource names. Top nothing, bottom nothing, etcetera. Supposing 

that instead of resource names I’m going to show, what about cost? Click on OK. Now what I 

can see against each bar is the cost of that task. 

So you can probably see from that just how flexible the formatting of Gantt Charts can be. 

You’ve got the style, you’ve got the ability to change the color, the shapes, the ends, the text on 

all the charts, and you can also do things like change the way that summary tasks are shown. So 

I’m going to leave you to experiment with that.  

That’s the end of this section. I’ll see you in the next one. 
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Chapter 14 – Notes 

Video: Applying Notes to Tasks or Resources 

Toby: Welcome back to our course on Project 2016. In this section we’re going to take a look at 

Notes. 

Notes can be applied to tasks or resources and they’re used for a number of different reasons. 

Amongst the most popular reasons for using notes are as a means of communicating with other 

people. So for example, if you’re working on a project with others and you say want to just leave 

a note for somebody such as a piece of information or something that has been agreed or 

something to be careful of then a note is often a good way of doing it. 

I also use it as a reminder for myself. Not a reminder as in an Outlook type reminder where 

something pops up and tell me to do something but very often a reminder of why I did something 

or a reminder about something which when I look at it a little bit baffled later on and wonder 

why did I do that or what do I have to do with that it just jogs my memory. 

So let’s take a look at adding a note to one of the tasks on the wedding plan. First of all I’m 

going to go back to standard Gantt Chart View. So I don’t need to go back to the View Tab for 

that. I can just go to the Task Tab, click on the dropdown and just select the Gantt Chart View. 

That takes me back to my standard Gantt Chart View. 

So let’s suppose that I’ve got a contact name and number for somebody who can print really nice 

wedding invitations. I’m going to go down to task 19, Send out invitations. I’m going to right 

click and one of the options there is Notes. Note also up on the Task Tab towards the right there 

is a group called Properties and that’s the same group that has the Information button in it but it 

also has a Notes button. So you can get to Notes from there as well. Let’s click on Notes.  

Now when I enter a note it’s actually one of the tabs in the Task Information dialogue. So let me 

enter the content of the note first. So there’s my note. There are some formatting options here. 

Not particularly dynamic but a few. So for instance, if you look at some of the buttons here 

you’ve got a Format Font button. You can Align. You can make a Bullet List there. You can 

even include a picture in a note. But one useful thing to bear in mind with Notes as I’ll show you 

in just a moment is that it’s a good idea to word or format the note in such a way that the 

beginning of the note gives you a good idea of what the note is about. I’ll explain that to you a 

little bit better in just a moment. So let’s click on OK. There’s my note. Now once I’ve added a 

note the note appears in the I column on the left there. I know there’s a note there. And note also 

that if I hover over it I get the beginning of the note. Now in this case the beginning is all of the 

note because it’s not a particularly long note. But if you’d put a lot of information in that note 

you’d just get a certain amount of it, whatever fitted into that available space. This makes it quite 

a good idea to make sure that the beginning of your note pretty much explains what it’s about. 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

And then if somebody sees that the note is of help to them or interest or use to them they’ll open 

the note up and look at the whole thing. 

Now if I see the task has a note and I want to open it up, obviously if I just double click then I 

just go back to the Note Tab and I’ll see the full note there. 

And to clear a note, the simplest way to do it is to just select that particular content for the Note 

Tab and just delete it all. Click on OK and it’s gone. 

And finally just one other thing. I mentioned that you can insert notes for resources. You could 

probably work out how to do that for yourself. But let me not completely ignore the people using 

touch. Let’s do this using touch. So first of all let me go into Touch Mode. Now I’m going to 

switch to the Resource Sheet with my finger. Now I’m going to choose a resource. I’m going to 

choose the photographer. So tap and hold. And then on the dropdown one of the options is Notes. 

I can now enter my note against the resource. Of course I can either if I’m using an attached 

keyboard I can use that or I can even use my onscreen keyboard. Enter my note, tap on OK and 

so on. So it works in very much the same way when you’re using touch. 

One other thing to mention now just before I finish this section. When you come to printing 

which we’re going to come to in the next section, one of the options when you’re printing certain 

types of information from Project 2016 is whether to print the notes or not. So that’s one to 

watch out for. 

But as far as Notes are concerned that’s it for now. I’ll see you in the next section. 
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Chapter 15 – Printing and Spellchecking 

Video: Modifying Print Options and Printing Your Current View 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to take a look at printing. During the course overall I’m actually 

going to look at printing twice. I’m going to look at it now and then later on in the course we’re 

going to look at it briefly again in relation to printing reports from Project 2016. What we’re 

going to look at now though is how you print the current view. 

Let’s suppose that I wanted to print out the plan for the wedding. And not only can I print it to 

paper but I could print it to an electronic document such as making a PDF file out of it. Or I 

could print it, for example, into Microsoft OneNote. 

To access the Print function in Project 2016 go to the File Tab to switch it into Backstage View. 

And then one of the options there is Print which takes you to the Print page. 

Now on the left of the Print page there’s a set of controls that I’m going to look at in just a 

moment. One of the controls is the Print button. And if I click Print now it would print to the 

printer that’s named immediately underneath. This is actually setup at the moment as Microsoft 

Print PDF. So it would print to a PDF document. What it prints is previewed on the right. And 

it’s the preview that I want to talk to you about first. 

Now just below the preview, the left hand corner, it says 1 of 6. That means that if I were to print 

this with the current settings this would be page 1 of 6. So I would get a six page document. If 

you look to the bottom right below the preview there’s a set of little wedges like arrows and you 

can use those to step through the six pages that would print. Now if I click on that right one it 

will take me to page four. Click on the left one to go back. Click down it takes me to page two. 

And of course the reason for this you can see by selecting not the current view which is actual 

size but by clicking on multiple pages. And that shows me the six pages that my printout would 

occupy if I printed it as it is now. And you can see there how my wedding plan would appear if I 

were just to print it as it is now. 

So you can see there how to preview what will be printed. Let me go back to a different setting 

here. I’m going to go back to the one page option using the button at the bottom right there. And 

I’m going to look now at those options over on the left.  

We have of course a number of copies option. You can either use the rollers on the right or you 

can type the number in there. And then as I mentioned just now you choose the printer. Exactly 

which printers you have available will depend on your own installation. I have the options to 

Print to fax, Print to an actual printer, Print to PDF, Print to XPS which is Microsoft’s equivalent 

to PDF, or I can send to OneNote. If I, for instance, want to add another printer, perhaps a 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

network printer, I can click here and add that. You setup printers in pretty much the same way 

that you do in any other Microsoft desktop application.  

Let’s look now at the printer option. If I choose say printer option then I will get a set of options, 

printer property options, that depend on my specific printer. The printer that’s available to the 

machine that I’m recording this on it’s quite an old printer but it’s got fairly typical printer 

properties. I’m not going to go through these because exactly what you get will depend on your 

printer. But you have things like color quality, type of paper you’re going to print on, color 

settings, and very often options to do with the size of the paper, whether you’re getting paper 

from two trays on the printer and so on. But as I say that will very much depend on your specific 

printer. 

Below the printer options you have another set of settings and these settings enable you to 

specify what you want to print. So for instance, I can say Print the entire project, Print specific 

dates, Print specific pages, Print custom dates and pages. One of the options below there is 

whether you want Notes to be printed. I mentioned that when we were looking at Notes earlier 

on in the course. Whether you want all sheet columns to be shown and when you want the left 

column of the pages only. I think those options pretty much speak for themselves but by all 

means give them a try. And if you don’t to waste all the paper try printing to PDF or to OneNote. 

If you want or need to specify the dates or pages to print you can use these controls. You choose 

whether you want Landscape Orientation or Portrait Orientation using this control. And then 

finally you can choose your paper size. The default in the UK and Europe is A4. The default in 

North America is generally Letter. There’s various defaults around the world. Choose whichever 

paper size is appropriate for you. 

And finally right at the bottom we have a Page Setup link. And this brings up the Page Setup in 

this case Gantt Chart dialogue. Exactly what you get here will depend on the view that is current. 

Obviously ours is Gantt Chart. And here you can do things like adjust the margins on the page. 

So you’ve got a Margins Tab there. You can have larger or smaller margins, depending on your 

requirements to fit material onto the pages. And you can also, for example, add a header to each 

of your pages. Now at the moment if I click on Header if you look in the preview box there 

you’ll see that there is no header. In fact if you look at the page behind there’s no header. Let’s 

add a header to this page.  

The header can be in three parts, a left part, a center part and a right part. In the left part let’s put 

the current date. Now it’s no good to actually just type in today’s date because it will always say 

today’s date. So what you have in Project 2016 is a set of fields that you can include. And if you 

include a field in there, for instance the field that represents the date. The date that’s actually 

shown when you print this particular view will be the date that you printed it. So the particular 

control we need here is Insert Current Date. And you can see that what it puts in is ampersand 

and then the word Date in square brackets. In square brackets denotes that it’s a field. And so this 
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is saying put in the current value of the date. Now the preview shows you what that will be 

today, Tue 2/2/16. So it’s February 2, 2016. In the right hand side I can actually put say the time. 

Again it’s a field for the time. In the center what I’m going to do is type in the heading for the 

center. So I’m going to type in, now this of course isn’t a field and it will always say the same 

thing. It will say Our Wedding. Now if you look at the preview there you can see how that’s 

going to look. 

Now before I actually click OK to confirm that just click over to Footer. The footer already has 

some content and the content there is a combination of something that’s been typed, Page, and 

then a field which is the page number and that’s why it says down at the bottom of the page you 

can see here Page 1 and then on subsequent pages it says Page 2, Page 3, Page 4, and so on. Now 

let me just amend that slightly. What I’m going to do is I’m going to click at the end, type the 

word Of and then I’m going to use another field which is that one, Insert total page count. So it 

now says Page, that’ll be the page number, the word Of, and then it will say the total page count. 

Click on OK. Let’s see what we get. There you can see it. date, Our Wedding, the time, and it 

now says Page 1 of 6 at the bottom. I suggest you experiment with that Page Setup dialogue and 

find out how to make your printout a little bit smarter and a little bit more informative as well. 

That’s it for this section. I’ll see you in the next one. 

  

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

Video: Spellchecking Your Project 

Toby: Hello again and welcome back to our course on Project 2016.  

In the previous section we looked at printing. And one aspect of printing is of course you’ll quite 

often want to print out a schedule, Gantt Chart for example, in order to present material to other 

people. Either give them a set of paper handout or perhaps in order to include part of a plan in a 

presentation or a PDF that you’re handing out. 

Now one thing that you will usually want to do in this situation is to check your spellings. And if 

you’ve used Microsoft desktop products before you’ll be used to the Spellchecker. Well there is 

a Spellchecker in Project. I’m going to take you on a very quick tour of the main points about it 

now. You may well think that if you’ve used the Spellchecker in Word or Excel or PowerPoint 

before you don’t really need to look at it in Project but there are a couple of important and 

unusual points about it. 

First of all I’ve taken version 13 of the wedding plan and I’ve just put a couple of spelling errors 

in it just to show generally how this works. And if I want to run a spellcheck on the current 

project, on the Project Tab in the Proofing Group on the right there is a button there, Spelling. 

Click on Spelling and the Spellchecker runs.  

Now first of all it’s found one of my errors and it says at the top of that little dialogue, Not in 

dictionary, V-N-E-N-U-E. It makes suggestions about the word that I may have intended to use. 

In this case it says Did you mean Venue? Which in this case is the correct spelling of the word I 

intended to use. But you have a number of options down on the right. You can say well Ignore 

this. It may be that you’ve used an usual word but it is the word you meant to use and you’re just 

saying to the Spellchecker in Project just ignore that. You may also know that you’ve used that 

in a number of other places and you can select Ignore All which will basically tell Project to 

ignore this particular word wherever it comes across it. You can also click on Change and it will 

change the misspelt word, V-N-E-N-U-E in this case, to the selected one in the Suggestions, in 

this case Venue. If I suspect that I’ve made the same mistake in various places I can click on 

Change All. One other option I have is to Add this word to my Spellchecker dictionary. And that 

means that if it comes across this word again it won’t flag it as a potential spelling error. It won’t 

say it’s not in the dictionary. It’ll say well it’s in the dictionary so it’s probably fine. 

Now I can choose here the dictionary language. Mine defaults to English (United States). And 

there’s a helpful field just above there which tells you where Project 2016 found that particular 

error. And if you look down at the task name column, task 25, you can see where the error 

actually occurs. So on this occasion I’m going to click on Change. What happens when I click on 

Change or Ignore or whatever I choose to do is it looks for a further error or errors and it keeps 

doing that until it think it’s checked everything. So let me click on Change. It’s found another 

error there. It’s found the word Catoring where I probably mean Catering. It’s telling me this is a 
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name from resource 9. So this is actually on the Resource Sheet. I may want to go to the 

Resource Sheet now and check that that’s the error. But in fact I know that it is. I did mean to 

write Catering. So I’m going to click on Change for that. Catoring to Catering. Click on Change 

and now it’s finished. So it’s fine. 

So that’s the basics of running a spellcheck. There are options that you can setup here. If I go to 

File, Options. One of the pages there is Proofing. And most of that is taken up with, if you like, 

defining the rules for spellchecking. In fact the main section here, When correcting spelling in 

Microsoft Office programs relates to all Microsoft Office programs. So you can select options 

like Ignore words in uppercase. If that’s checked any words which are all uppercase Microsoft 

Project won’t check the spelling. Ignore words that contain numbers. If you’ve got an expression 

like Task197. The fact that it’s got numbers in it means that it won’t be spellchecked. Ignore 

internet and file addresses and so on. So you have a number of options that you can choose from 

there. You can also setup and use custom dictionaries.  

And right at the bottom you have a list which is specific to Project and that is to say which fields 

you want to check the spelling in. Some fields are actually quite unsuitable for checking spelling. 

Obviously things like date fields. You won’t want to check the spelling in those. And generally 

speaking spellchecking is restricted to names and notes. And the list that you see here is a list of 

the fields that are spellchecked by default. If you don’t want any of those to be spellchecked you 

could uncheck before you start doing spellchecking and then those fields won’t be checked when 

the Spellchecker is running. 

So to make sure you’ve got nice, clean spelling when you are preparing your projects, perhaps 

presenting your projects try to make a point of running the Spellchecker. And of course make 

sure that the options here are set appropriately for your use. 

That is the end of this section. I’ll see you in the next one. 
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Chapter 16 – Tracking Progress 

Video: Tracking Progress – Part 1 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to start looking at tracking progress on a project. We’re going to use 

the wedding plan again. I’m looking at version 14 now. We’ve saved a baseline. I’m reasonably 

happy with the plan. But the first thing I want to do is to take a look at Project Information now. 

Now if you go into Project Information and click on the Statistics button what you can see now 

in the lower half of that dialogue is that we have current figures for duration, work and cost. We 

have baseline figures which of course currently agree with those current figures. And then we 

have actual figures that are currently empty and remaining figures which also agree with the 

baseline figures. This is the situation that you’ll always be in just as you start to record progress 

on a project. You’ve saved the baseline. You’ve still got everything to do. That’s the remaining. 

And you haven’t actually done anything at all yet. The actuals are all zero. What happens when 

you track progress is that you basically start to record actuals. And as the actuals increase in 

theory the remainings should decrease. And when you get to the end of the project your 

remainings will be zero and your actuals, hopefully, will pretty much agree with what was in 

your baseline. Now of course if they agree accurately that would be an extremely well planned 

and executed project indeed. But it really is your intention to keep as close to that as you 

possibly can. 

Now the other thing to notice in the top half of the same dialogue is that you’ve basically got for 

the first three lines the same. So the current start date for the project is Friday, December 4th and 

the end date is Thursday, August 25th. The baselines the same of course. We have no actual start 

and we certainly don’t have an actual finish yet. And the variants indicates how much, what’s 

actually happening varies from our baseline. 

Now let me close that Statistics dialogue and let’s go back to the Project Information because the 

next thing we need to look at are the top right hand two fields, Current Date and Status Date on 

the project.  

Now hopefully you won’t be surprised to learn that Current Dte is supposed to be the current 

date and this is being recorded on Wednesday, February 3, 2016. If I wanted to change that date I 

could. And particularly when I’m recording training material it’s really useful to be able to 

change the current date because I can pretend that it’s any date that I like when it comes to 

recording the information in Project. I’m actually going to leave that date as it is for the moment. 

And one thing you’ll notice is of course that the current date is some time after when the project 

actually was planned to start. And you’ll realize by now that there’s actually quite a cunning 

reason for that because I’m able to look back at the first part of the project without lying to you 
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about the current date and we can look at what’s happened for the first couple of months of this 

project. 

One very important point here is of course that your dates are going to be different to mine. So 

I’m going to talk about things like choosing a date about a month after the start and choosing a 

date a couple of months after the start rather than looking at very specific dates. Of course you 

could cheat the dates if you wanted to and use the same dates of me. There’s no reason not to. 

But if you want to use dates that are more appropriate for when you’re working your way 

through this course that’s fine, but just be guided by what I describe to you in terms of dates. 

The second date is the Status Date. If you work on Project almost without exception you will be 

recording the status of a project on a date other than when the status was actually recorded. Let 

me give an example. A lot of the projects that I work on are IT related projects. Many of them 

are government or financial services related projects. And very often what we’re dealing with is 

information that’s been gathered either from project teams, managers, individuals and typically it 

will be something like, “What was the status of your project last Friday?” And by the time we 

come to put all that information into Microsoft Project it’s usually a few days old. Now there are 

exceptions to that. Sometimes the information goes straight in. In fact if you use some of the 

other Project related tools you can even get members of the team to enter their own status, record 

their own actuals. But usually what happens is you gather information up to the status date which 

may be Friday or the end of the month or some other suitable day, but you’ll often enter it on a 

later date. So when we’re recording status, when we’re recording progress on a project it’s very 

important that you set the status date because what you’re basically saying to Project 2016 is the 

information I’m giving you now relates to this status date. And for instance the first update that 

we’re going to do is for a status date in the middle of December. 

So let’s do our first bit of progress tracking. I’m going to set the Status Date as the 18th of 

December. Click on OK. And if you look on the Project Tab in the Status Group you’ll see the 

latest Status Date there. So you can see 12/18/15. Now what we’re going to do is to update the 

project. So we use the Update Project button in that Status Group. And the Update Project button 

gives us a couple of options. First of all we can either say I want to update the work as complete 

through and that means up to this date, Friday, December the 18th. Now I can do either of the 

following. Set 0% to 100% complete. What that means is that Project will look at a task and say, 

“On that date how much of it should have been done?” Now for tasks that are way off in the 

future the answer will be 0%. For tasks that should have been finished it’ll be 100%. For 

something that’s supposed to be halfway through it’s 50% and so on. Now Project will work that 

out for you and mark those tasks as being complete by the appropriate percentage. Instead you 

can say set 0% or 100% complete only. What it does then is to say if a task isn’t due to have 

started we consider it to be 0%. If it started but it hasn’t finished it’s still 0%. It’s only when it 

gets finished, when it’s past it’s finish date that it says 100%. Now sometimes that’s a very 

useful way of doing things where typically you’re working with a lot of very small tasks and 
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maybe you’re not particularly interested in the percent complete of those many, many small 

tasks. But we’re going to use the first option on this occasion. 

Now we have another option here, Reschedule uncompleted work. I’m going to talk to you about 

that a bit later on. So we’ll ignore that for the moment. 

And then we’ll make a choice. We say do we want to do this update for the entire project or for 

selected tasks? Now for the first update or two I’m going to update the whole project. I’m going 

to say the bride and groom have looked at their Gantt Chart and said, “Yep. We’re up until the 

middle of December everything was going fine.” So let’s do the simple option of saying 

whatever should have been in progress then it had achieved its planned level of completion. So 

having done that we click on OK and the update is now done. 

Now in fact if I scroll up and down the project what you’ll see is in fact there are only two tasks 

due to have anything happen at all there. And the first of them was Agree budget and approach. 

Now it was due to start on December the 4th and finish on December the 17th. Therefore it should 

have finished by that date and in fact it has. Then you can see that nice tick in the I column there. 

This task was completed on Thursday, December 17th.  

The other task that’s due to have started is this one, Make guest list. Now just let’s open up the 

Task Information, have a quick look at something about that task because if we now look at it’s 

percent complete it’s now got a percent complete figure of 7%. And that’s important because 

Project has made that calculation for us based on the duration of the task. Now, very important 

point. Sometimes you will update a project in the way that we’ve done here and you’ll look at 

the whole thing and say, “Yep. It’s all going to schedule.” And Project will automatically 

calculate all those percent completes for you. But in other situations you may actually need to go 

through every single task and indicate for each individual task what its percent complete was. 

Now that can be quite a laborious task but it’s also often a very, very important task. So 

sometimes you might be able to update a whole project or a whole phase or a whole group of 

tasks, sometimes you’ll work on individual tasks. That totally depends on the particular 

circumstances. 

Now once you start recording progress there are some very good visual and other indicators of 

how things are going. Let’s stick with the Gantt Chart for just a moment. If you look back at the 

task with ID 2, the one that’s ticked, the complete one, note that it’s Gantt Chart bar has a 

horizontal line, a dark line through the middle of it. That indicates that it is complete. Whereas if 

you look down at the task with ID 18, Make guest list we know that’s 7% complete. Note how 

the little dark line just indicates that we’re only a small proportion of the way through that task. 

The other thing I want to do now is to change the table that we’re looking at. So I’m going to go 

to the View Tab, Tables, and we’re going to apply the Tracking Table. Now having applied that I 

just need to adjust the column widths a bit. Now in the Tracking Table you can see that we now 

some actuals. For instance, we have an actual start for Agree budget and approach. And in the 
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absence of any other information it’s December 4th. We also have an actual finish. And again in 

the absence of adding other information it’s December the 17th. When we did that project update 

because we didn’t tell Project anything else other than the fact that all of the tasks were running 

to schedule Project will deduce that that task must have finished when it was scheduled to finish, 

which was December 17th. 

Now note that task has a percent complete of 100%. It’s actual duration was ten days. The 

remaining duration was zero. And the actual work is 160 hours. Bear in mind that two people 

were working on that for eight hours a day for ten hours. So that was 160 hours. Of course the 

bride and groom aren’t charging their time so there’s no actual cost involved in that but we still 

record the notion of actual work. 

If you go down to Make guest list, task ID 18, in this case we have an actual start, December 

18th, but no actual finish because it’s not finished. We have a percent complete of 7% that you 

know about. We have an actual duration, one day, and a remaining duration, fourteen days. Note 

that seven days is one-fifteenth of that task. That rounded to a whole number of course. 

And the other important point here, if you take Make guest list as an example. Make guest list is 

actually a part of a summary task. And the fact that we have done 7% of that task means that we 

have done 2% of the Guests task above it. Now I’m not going to go through those calculations. I 

think you can trust Project to do those. But once you start recording actuals for individual tasks 

then summary tasks, so on have rolled up actuals as well. And indeed if you look at the whole 

wedding, if you look at the project summary task at the top there the percent complete for the 

whole wedding plan is now 2%. 

So that’s our first bit of progress tracking and we’re going to do another bit in the next section. 

But just before we finish this section, just up to the Project Tab again, click on Project 

Information and into Statistics. And of course now we’ve got some actuals in our statistics. So 

for instance, if you look in the lower half there, Work, of the 2,105.6 hours of work according to 

our update we’ve done 176 hours and there’s 1,929.6 hours remaining. Note also that the project 

has an actual start date. But of course still no actual finish date.  

That’s it for this section. Please join me in the next one. 

  

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

Video: Tracking Progress – Part 2 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to carry on looking at tracking progress on the wedding project. And 

we’re going to start by doing a more detailed, if you like a more manual update on progress. 

Now I’m going to record progress up until the end of January. I’m doing it today which is 

February 4th. Don’t forget that vertical line you can see there indicates today at any time, or 

should I say the current date as far as Project 2016 is concerned, which of course you can change 

if you need to. 

So the first thing I’m going to do then is to set a new Status Date. If I go to the Project Tab, 

remember we can always see the latest Status Date there. It was previously December the 18th. If 

we click on that we can set it to a new date. And as I say we’re going to update status to the end 

of January. 

Now before we do that there is one thing I want to mention and one thing I want to do. First of 

all it’s very important to recognize that when you’re dealing with manually scheduled tasks 

things do work a little differently. For example, if I update progress on a manually scheduled 

task and it has manually scheduled successors, if for instance I show a significant delay on the 

first task Project will not reschedule subsequent tasks. The scheduling of manually scheduled 

tasks is up to you. Project manages the scheduling of auto-scheduled tasks. So, be very careful 

when you’re dealing with manually scheduled tasks what the effects of progress tracking are. In 

the wedding plan we have no manually scheduled task so the problem doesn’t arise but it’s a 

very important point to be aware of.  

The other point to be aware of is that when we came up with this final if you like plan to get 

started we pretty much fixed on that wedding date and it was based on taking all of the work on 

the schedule and giving ourselves a nice contingency before fixing that date of August the 25th. 

Once we’ve done that we may or may not decide to leave that contingency as part of the 

dependency between the preparation phase of the project and the wedding day. But one thing I 

absolutely do want to do is to fix the wedding date so that we don’t find that we are inadvertently 

rescheduling the wedding day once we start recording progress.  

So what I’m going to do here is to open the Wedding date task and I’m going to go to the 

Advance Tab and I’m going to change its constraint type. And I’m going to say that it must start 

on. And now let’s go to the constraint date and we need to go to our wedding date which is 

Thursday, August 25th. Click on OK. Now we get a warning there from Project 2016. You’ll get 

many warnings from the Planning Wizard and many of them don’t indicate that there is a 

problem. But that because of what you’re doing, the nature of what you’re doing means that you 

may cause a problem. And this is one of those where there really isn’t any actual evidence that a 

problem will be caused because all we’re doing is keeping the date the same but we are applying 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

a constraint. Now when you get warnings from the Planning Wizard you do need to look 

carefully at what they are and consider what they’re telling you. In this case we’re putting on a 

must start on constraint and all that’s happening is that the Planning Wizard is saying this could 

result in a scheduling conflict either now or later. Now on this occasion because we’re not trying 

to make this day earlier and we already know that we can achieve this date then I’m going to 

click on the third option, Continue, and must start on constraint will be set. And now the 

wedding day we’ve fixed on August 25th. 

Now we’ve still got our 21 working day contingency and we may need to use some of that up if 

progress doesn’t go well. But we are fixed on that date of August the 25th. And obviously we’re 

going to be very determined to keep to that date. 

So time now to track some progress. We’ve set the status date correctly, January 31st. The 

current date, today, it’s February 4th. Let’s look at the tasks that have been in progress.  

First of all we already know that Agree budget and approach is complete. That was marked as 

complete on the previous progress update. Let’s turn our attention now to Make guest list. Now 

Make guest list is now also complete so that’s good news. How do you mark something as 

complete? Well there are a number of ways of doing it. If you go to the Task Tab, in the 

Schedule Group there is a set of buttons with significant percentages complete on it. zero, 25, 50, 

75, 100. Many people only really record the level of completeness with that sort of granularity. 

And marking something as complete, 100%, just click on the 100% button and that task is now 

complete. You can see now that it has an actual finish and you can see the horizontal dark bar 

through the middle of it right to the end. 

Notice how you have a number of other very useful buttons in there. You have a Mark on Track 

button. And if you click on that it says, Set these selected tasks, you can do this with individual 

tasks or any selection of tasks so they are on schedule per the status date. And then it reminds 

you there you can set the status date on the Project Tab. 

Now let’s move on to another one of the tasks. Let’s move on to Make reception venue shortlist.  

Now that task is also complete so that’s also good news. If I right click on the task I get the 

contextual menu and a mini toolbar and on the mini toolbar the little dropdown there with the 

same buttons. Arranged in a different way but again I can use that to indicate 100% complete. So 

they’re the tasks that we’ve successfully completed.  

Let’s go back now to Select wedding dress. Now at the end of January that should have been 

probably about half done. Let’s suppose that our update is that it is actually 50% done. The bride 

looks at it and says, “Yep. I need about the same length of time again from the end of January” 

but let’s say 50%. Now if I double click on that and open up the Task Information dialogue, on 

the General Tab there is a Percent Complete button. And I can mark 50% on there. So you can 

see there are many ways of doing these marks complete. 
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Now the ones we looked at before this one obviously showed those 0%, 25, 50. In the Task 

Information dialogue you can type in whatever percent complete you want. So that’s useful if 

you are recording progress very accurately and you want to say something is 48% complete or 

something. So that’s the Wedding dress task. Now let’s go down to Make caterer shortlist. 

Now the Make caterer shortlist should have been about complete by now but in fact progress on 

that has not been so good and we’ve only achieved 50% on that. And the other task that we 

should have made some reasonable progress on is Make wedding venue shortlist. Now with that 

our progress is only at 25%. Now with all other tasks we have no progress to record. So let’s just 

see how that looks on the project overall. Let’s look at Project Information, go into Statistics, and 

you can see the Actuals. But in terms of percentage, percent complete, duration 15%, work 29%. 

Now as I mentioned earlier you need to be very, very careful about how you interpret these 

figures because duration 15%, work 29% doesn’t necessarily mean we’ve done a lot more work 

than we should have done. That would only be the case if the work was evenly distributed over 

the duration and of course on this project it isn’t. We’re doing a lot of the more intensive work 

tasks up front and therefore we appear to have done more than we should have done. But the 

figure there, duration 15, work 29 does not mean that we’ve done twice as much work as we 

should have done. And as I mentioned to you earlier on in the course there are some tools and 

techniques available to look at actually how we’re doing at the moment to give ourselves a 

feeling of whether we’re ahead or behind schedule. But it’s not as simple as just looking at those 

two numbers. 

So having done that second update which gets us up to the end of January, what I’d like to look 

at now is another view. And the view we’re going to look at is called the Tracking Gantt View. 

Now when we go into Tracking Gantt View and this is very often the case when we change view 

as you’ll realize by now, very often have to do a certain amount of jiggery-pockery. So I’m 

going to change column widths there, click on Entire Project. And what Tracking Gantt View 

does is on a task by task basis to show us how we’re doing against schedule. Now if you look, 

for example, at Agree budget and approach which is a completed task the bar is now in two parts. 

There’s a bottom bar which is basically the baseline and there’s a top bar which is task progress. 

And for that particular task of course both are at 100%. But if you look at Select wedding dress 

you can see the baseline at the bottom there and the task progress at the top. If you look at 

today’s date then you can see that just about, we’re just a tiny bit ahead of schedule. We’ve done 

a little bit more work than we should have done. Not enough to sort of get excited about but just 

a little bit more. Whereas if I go down to Make caterer shortlist it’s immediately clear that 

although we should have finished that task by now we’re actually quite a long way behind 

because we’ve only completed half of it. And again if I go further down still, Make wedding 

venue shortlist actually is also pretty much on schedule. So the Tracking Gantt Chart is a pretty 

good way of looking at each of the tasks and getting a good visual indication of how each task is 

doing. 
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Now it would be quite reasonable at this point to carry on with the project, keep an eye on the 

things that are running late and make sure the things that should have started and haven’t get 

started, and generally make sure that we keep to track on the rest of the plan. And that’s the way 

that many people would proceed once tracking progress is started. But in many ways a more 

realistic approach is to look at the current situation, particularly in relation to the caterer, task 29, 

and say what we really need to do now is to do a bit of a reschedule at this point. Let’s take into 

account the fact that that task in particular is slipping behind. And let’s reschedule the project, 

the outstanding work on the project from the end of January. 

So let’s say that we’ve recorded progress up to the end of January. Now we want to reschedule 

the outstanding work. Now that’s one of the options on the Project Update Tab. So we’ve still 

got the same Status Date, January 31st but we’re going to click on Update Project and on this 

occasion what we’re going to say is Reschedule the uncompleted work to start after Sunday, 

January 31st. And we’re going to do this for the entire project. Clearly I could select individual 

tasks if I wanted to but let’s do it for the entire project. So click on OK and that work is 

rescheduled. Select wedding dress is in progress but of course it’s running to schedule. It’s very 

slightly ahead of schedule. There’s absolutely not a problem. But when it comes down to Make 

caterer shortlist what it’s done is to say not only that effectively we need to split out the 

proportion of the work that isn’t done to start after January 31st, hence it’s split that task. But also 

of course because Book caterer depends on that task. That is rescheduled as well. Now in the 

process of rescheduling what then happens is we get, not surprisingly, a resourcing issue and 

we’ve got some overallocations in the column on the left. 

So let’s see if we can resolve those resource allocations without delaying the end of the project. 

So I’m going to go Resource and Leveling Options. I’m going to level only within available 

slack. I’ll try the whole project, Level entire project, check everything else is okay. Click on 

Level All. Project finds it has a problem with a particular overallocation. What I normally do in 

this situation is to skip any of these flagged problems and aim to deal with them separately if 

they remain. On this occasion let’s click on Skip All. And in fact it does manage to resolve all of 

the overallocations and we seem to be okay again. We’re not over-allocated. We’ve got the 

project nicely rescheduled. We can work for another period of time, perhaps another couple of 

weeks, four weeks, and then do another update. 

It’s always a good idea to keep an eye on the Tracking Gantt. For some tasks, for instance, Book 

caterer and Finalize menu there. Notice how the baseline bar, the bottom have and the current 

bar, where it is now, the current plan, they’re quite separate now. The dates for booking the 

caterer and finalizing the menu have moved several weeks into the future. It’s a good idea to 

keep an eye on those. And of course the Tracking Gantt is a great way of doing that. 

That’s it for this section. I’ll see you in the next one. 
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Video: Exercise 07 

Toby: Welcome back to our course on Project 2016.  

It’s now time for Exercise 07. And it’s going to be a little bit tricky to set this exercise because 

the dates are important. And you’ll be working your way through this part of the course on a 

different date to the date that I’m recording it.  

So I’m going to describe this in terms of the start of the bathroom refit project and I’m looking 

here at the very early stages of the project. Now the project for me has a start date of January the 

20th. Now I go up to the Project Information. You can see that it’s Wednesday, January 20, 2016. 

And the updates that I need you to do are going to be after one week of the project and then after 

two weeks of the project. So in my case I’ll be setting this first Status Date to Wednesday the 

27th of January, January 27th, and then the second update date will be Wednesday, February the 

3rd for me. So that’s two weeks into the project. 

Now let me describe what the update is on each of those dates. 

First of all, after one week of the project all of the tasks under planning will have been completed 

on schedule. And in fact task 11 and 12, Get contractor recommendations and Make contractor 

shortlist also they will have been completed on schedule. But task with ID 13, that’s Get 

contractor quotations is actually going to be ahead of schedule. And it’s going to be 50% 

complete at the end of the first week. So your first update is to get to that point, as though you 

were updating progress as of the end of the first week. In my case that’s Wednesday, January the 

27th. 

However, during the second week there is no progress at all on anything. I have the flu. I am 

confined to bed. I don’t do anything about anything. So when I come to the update for the second 

week, so in my case that’s Wednesday, February the 3rd, the end of two weeks of the project. I 

just need to reschedule everything to start the day after the end of the second week. So during the 

second week no progress at all. I’m basically going to reschedule what’s left. 

In my version 07A of the project that I’m starting with my end date is March the 4th. And you’ll 

see on my answer 07B what my end date is. You need to do the same. And just check that your 

answer is compatible with mine. 

And don’t forget of course that one option that’s open to you is to use the same dates as me and 

then you’ll be able to make a pretty good match on making sure that the shape of the project 

looks the same and that the end date comes out as the end date that I have in my 07B. 

That’s the end of this section. I’ll see you in the next one. 
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Chapter 17 – Reporting 

Video: Reporting – Part 1 

Toby: Welcome back to our course on Project 2016. 

In this section we’re going to look at Reporting in Project 2016. In fact in this section we’re 

going to look at some of the general principles of reporting and then in the next section we’ll 

look at customization and the creation of new reports in a little bit more detail. 

Now generally speaking the reporting we’re looking at applies to the currently open project. And 

if I go to the Report Tab on the Ribbon you can see I have a main group in the middle there, 

View Reports, and that’s mainly what we’re going to concentrate on in this and the next section. 

On the left there is an option Compart Projects whereby you can compare two versions of a 

project. That is out of scope for this course, although it’s a very useful facility. On the right there 

is a Visual Reports button and that gives you access to Project 2016’s Visual Reports. These 

enable you to use Microsoft Excel and/or Microsoft Visio to do detailed analysis and reporting 

on the data from your projects. If you have either or both of those products it’s a very good idea 

to get into Visual Reports, take a look at what they can do for you. But they are out of scope for 

this course, partly because you need to be familiar with either Excel or Visio to take advantage of 

them. 

Now we’re going to concentrate on the main body of reports. If you’ve used a version of Project 

before 2013 Reporting in those earlier versions was very different to Reporting now. And if you 

look at the Reporting facilities in Project 2016 having been used to one of those older versions 

they will be virtually unrecognizable to you. 

Now first of all I’m going to click on the Dashboards button, the second one along View 

Reports, click on the little arrow at the bottom. And there’s a list of five Dashboards. We’ll look 

at one or two of those a little bit later. But right at the bottom there is an option, More Reports. 

And More Reports basically shows you all of the options that you have in that View Reports 

Group because the options on the Page Selection on the left correspond to the buttons in the 

View Reports Group. 

So the first option on the left, Custom, gives you access to any custom reports that you’ve made. 

And in fact Exercise 08 is going to involve you in making a custom report. Then it gives you 

access to the Dashboards, the Resource Reports, the Cost Reports, the Reports on work in 

progress, access to some Getting Started information, and then facilities to create new reports 

and a link through to Recent Reports. That’s reports that you’ve used recently. So the first thing 

we’re going to do is to look at one of the Dashboards and we’re going to look at the Project 

Overview. Click, select and there is the Project Overview. 
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Now the first thing to point out is that your Project Overview may well not look exactly the same 

as mine. And you’ll see why during this and the next section. But let me just describe this report 

to you in the broadest terms first.  

The Report itself is made up of a number of components. And you notice that at the moment 

when I’ve opened that Report I have a contextual tab on the Ribbon. It’s one of the Report Tools 

Tabs and it’s the Report Tools Design Tab. If I click on one of the components of the Report, 

supposing I click on the chart there. I’ll select the chart and watch what happens. Not only do I 

now have the Report Tools Design Tab but I also have a Chart Tools set of tabs, a Design Tab 

and a Format Tab because that chart is a component and I have the facilities here to actually 

customize, to format that individual component. What tools I see, what contextual tabs I see 

depends on what I select. So for instance, down here at the bottom of the left hand column in the 

Project Overview I have a milestones due section and this is actually a table. If I click on it I get 

the Table Tools Design and Layout Tabs. The big orange box here saying 14%, that is actually 

also a table. And if I click on Project Overview itself I’ll see that is actually a drawing. It’s 

actually a textbox that says Project Overview.  

Now when you’re working on customizing a report sometimes you may want to customize the 

whole report, the overall design of the whole report. Sometimes you may want to work on 

individual components. And the tools you have for each component depend on what sort of 

component it is. And if you take, for example, the chart again you can work on the design and 

the format of that chart in many different ways. So for example, you can certainly do things like 

change the color scheme, the style. But you can even change what sort of chart it is. It’s currently 

a Column Chart. You could turn it into a different sort of chart. You could change what data’s 

included. You can even change the outline level that it works on. And during this and the next 

section I’m going to demonstrate some of those things.  

Going back to what I said right at the beginning of this section, once you’ve got those general 

principles there is a really huge amount that you can do in Reports to customize the standard 

reports and to create your own and to make them work in exactly the way you want or need them 

to work on your projects. 

So let’s look first at the design of the report overall. If I click away from any of the individual 

components, I’m back to just having the Report Tools Design Tab. And working from the left 

there is a Themes Group and I can change the overall Theme of the report. Click on the 

dropdown at the bottom and I have a gallery of Themes. The Theme that’s in use at the moment 

is one of my own themes. It’s called TA Theme. Let’s take one of the standard Microsoft Project 

Themes. What about Celestial? Now if we apply the Celestial Theme you notice the colors where 

there are colors change. This is things like the background colors and the headers of the tables 

and so on. But note that what we’re doing now applies to the whole report. We can also do things 

like, for example, change the fonts. So if I wanted to change to a different Theme here. Let’s find 

a different one. Let’s try Franklin-Gothic. Again you can experiment there to decide which 
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particular font you like best or you can stick with the standard font that goes with the Theme. 

You also have options here of course to do things like apply Effects and I suggest that you take 

some time to experiment with the different Themes, Colors, Fonts, and Effects. 

So that’s one aspect of the overall design of the Report. Another aspect is that you might want to 

add new components to the Report. So for instance you may want to add another chart. If I click 

on Chart here to add a chart it lets me choose a particular type of chart that I want without 

committing to a particular type of data. Let’s suppose I wanted to insert a Pie Chart related to 

something. If I click on OK to insert a Pie Chart it appears and then as you’ll see later what 

would happen next is that you would decide what data you wanted to show, how you wanted to 

format that Pie Chart, and so on. At the moment let me just delete that. We’ll come back to those 

individual components later on. 

We then have the Report Group. And one of the options there is the Organizer. We’re going to 

look at the Organizer a little bit later on in the course. It’s a very important part of Project 2016. 

If you’ve got the Report the way that you want it and you say wanted to include it into another 

document Copy Report copies your Report to the Clipboard and then you can Paste it into 

another document. If you are planning to print the report, so either to a printer or perhaps into a 

PDF or something like that you have some Page Setup options here. So let’s suppose that I said 

well I want to do this with wide margins. So you make a wide margin selection there and you say 

right I’m going to print this report out now. So you go to Print and you look at it and you say, 

“Oh actually the print doesn’t quite fit in the space.” You see how we’ve got this little border 

round. We’ve got it on my default A4 size paper. It doesn’t quite fit. So you might go back into 

this and say you know well maybe I want to go for narrow margins. And you can do things like 

set orientation, size. You can check and set page breaks. But let’s try it with the narrow margins 

now. Let’s go back and see how that would print. Oh yes that’s much better. It all fits nicely now 

with narrow margins. 

So they’re the main options when it comes to the design of the report overall. 

Just now I copied the Project Overview to the Clipboard. Let me just demonstrate dropping that 

into a PowerPoint slide. So there’s an empty slide. I can drop the Project Overview in there. Note 

that having dropped it in there I still had individual components. And if I want to move things 

around within PowerPoint I still can. So that means if I’m trying to adjust the Report to fit in 

with the rest of my presentation there’s a lot of flexibility to that. And of course I can choose a 

Theme that’s the same as the Theme in use in my PowerPoint presentation, in my Word 

document or whatever it is as well. 

So that’s the end of this section where we’ve looked at the design of Report overall. In the next 

section we’re going to look at the design and formatting of individual components. Please join 

me for that. 
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Video: Reporting – Part 2 

Toby: Hello again and welcome back to our course on Project 2016. 

In the previous section we started to look at Reports in Project 2016. And in this section we’re 

going to continue looking at Reports. And the first thing we’re going to do is to look at 

formatting some of the individual components of the Project Overview. Now as I mentioned at 

the beginning of the previous section I’m going to show you some general principles here and 

you can pretty much apply these principles to all of the standard reports, customized reports, 

etcetera in Project 2016. There is an awful lot that you can do to customize reports, make your 

own reports, etcetera. So it’d be really helpful if you can find the time to get yourself some 

practice and build up some experience of creating and customizing Reports. 

So first of all let’s look at the title here, Project Overview. If I click within that I will select the 

individual component which is actually a textbox. And when I’ve clicked in there you’ll see the 

Drawing Tools Format Tab appear on the Ribbon. Now if I select that Format Tab you can see 

the range of formatting options that’s available to me. So I can do things like change shape style, 

WordArt styles, and I can do text fill, shape fill and so on. So I can format that heading in pretty 

much any way that I want. The other thing that I can do, if I just click in there I can of course just 

change the text if I wanted to, just fix text. And then let me just adjust the width of the textbox. 

And of course if I wanted to Center that text in the box, if I right click one of the options on the 

mini toolbar lets me Center Align the text within the textbox. If I perhaps wanted to use a 

different fill color for the shape and so on. So that’s a very simple example of formatting. 

Let’s look next at the table of milestones down here. And in fact what we have there are two 

components because the heading where it says Milestones Dues, milestones that are coming soon 

is actually a textbox. Whereas the list here is a Table. And when I select that Table you see the 

Table Tools Design and Layout Tabs. Now let me first of all click on the Design Tab and I can 

of course choose or change my table style. So if I want something that’s got a little bit more 

color to it, say that one, and then I can also choose what is shown in the table.  

Now one of the key things you’ll need to choose for components in reports are which data to put 

in each component. And on the Design Tab here you can see a button, Table Data. That brings 

up the Field List Panel on the right. Let me just make that a little bit wider. And this is where you 

choose which data are shown in each of the components. Now with the Table selected if you 

look at the field list, Select Fields, we’ve got two checked boxes. There is Name and then there is 

Finish. And of course you can choose from a very, very long list of available fields that you can 

include in that Table. So let’s stick with the two fields that we’ve got here in this case but it’s 

easy to change them by checking and unchecking boxes. And let’s look underneath the field list 

because you have some very important options down there. 
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We have an option that says Filter and you can apply a filter here. So for instance if I click on the 

dropdown there are many, many filters available. One of them is Milestones due this month. So 

we can change from upcoming milestones to milestones due this month and we get a smaller set. 

But note that they’re just the ones that are due in February 2016. And that is of course the month 

when I’m recording this.  

We also have the option to group the entries in the table. And we can also choose the outline 

level. Now at the moment the outline level is set at All subtasks but you could set it at any level. 

And in fact even with just the three we’ve got here, if you move down to the checkbox below 

that you could also select to show hierarchy. Let me just check Show hierarchy. And what you 

can now see for those milestones is that for each of them the summary tasks to which it belongs 

are also shown. So you can see the specific milestones that are coming up this month within the 

structure of the project. And finally at the bottom it says Sort by no sort. And you have the 

option there of creating a custom sort or sorting simply by one of the fields that’s in the table. So 

for instance I could sort them by finish date. So that’s how you customize the data that’s shown 

in a Table in this case. But the same general rules apply to any of the components of the Report 

that contain data. 

So if you’d like a little bit of practice with adjusting the data in a Table you could practice on this 

late tasks table here. Maybe take away one or two of those columns, put one or two extra ones in. 

Or even back here in this percent complete because this is also a Table. It’s a Table with just one 

column, percent complete. But supposing I was to add another column. What about adding actual 

work? What I now get is a summary for the project of the percent complete and the actual work 

done. And then one other thing you may notice about that is why is that just giving an overall 

figure? And the reason that it’s just giving an overall figure is if you look down below the field 

list at the outline level control it says Project Summary. And we’re just showing the data at the 

project summary level. So that’s an overall figure. Supposing I wanted instead to show it at level 

one. Now apart from the fact that one there will give me a breakdown by the levels in my project 

it also demonstrates that when you change some things you may need to more drastically change 

the layout of your Report. So let me select the textbox above Milestones Due and the Milestones 

Table and using the arrow on the keyboard I’m just going to move them both down. Of course I 

may put them somewhere else on the Report altogether. But it’s as easy as that to move the 

individual components of the Report round as needed. 

So a couple of additional points to make here. One of them is that given the field list on the right 

at any time if you want to move it out of the way obviously just Close it. And then you can 

reshow it again using that Table Data button. And when you’re working on a Table which you 

very often will be apart from that Design Tab that we briefly looked at here you also have a 

Layout Tab so you can do things like change text direction, you can sort out alignment in Table 

cells, you can work out the widths of columns and the heights of rows, and so on. So you’ve got 

a very good, powerful set of Table formatting, Table Layout tools to work with as well. 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

So finally let’s look at this one other type of object. We have here a Chart. And I can still see the 

field list. I can see what’s shown on my Chart. It’s a simple Column Chart, not a particularly 

beautiful Column Chart so let’s do a little bit of work on how it looks. Chart Tools. I’ve got a 

Design Tab and a Format Tab. Let’s go to the Design Tab and let’s go for something a little bit 

prettier. What about that one? Now I’ve rather successfully there got completely incompatible 

designs and styles for all of the components on the Report but I hope you understand the reasons 

for that. 

Now what’s shown in the Chart at the moment in the Column Chart I’ve got a single figure for 

each of the level one’s in my project. Obviously those figures agree with the figures in the 

percent complete column over there on the left, the one that I just changed from being the project 

summary.  

Now supposing instead of just percent complete I wanted to show something like the actual 

work. So let me just click on Actual Work. And what I’ve now got for each of the level one’s are 

two figures. I’ve got a percent complete figure and I’ve got an actual work figure. And you can 

see how it’s put a little legend there underneath the Chart itself. 

Now if I go back up to the Chart Tools Design Tab, Add Chart Element. Legend I’ve already got 

at the bottom. Supposing I wanted to put it on the right. Now my Legend appears on the right. So 

I’ve got a pretty good, powerful set of formatting tools. That may look a little bit gray and bland. 

What about change colors? I’ve got a monochromatic set there. Let’s try those. That’s a little bit 

nicer. And then apart from the Design Tools for the Chart if I go to Format I can do things like 

format the bars, add effects to them, and change the shape fill colors and so on. So again you’ve 

got a very full set of tools there for formatting that Chart. 

Now apart from using those commands on the two contextual tabs if I right click here one of the 

options is Format Chart Area. And I get another panel on the right. So I’ve still got the Field List 

Panel so I can choose what fields are shown. But I can also do things like change fill color, set or 

change the border, and then I can go into things like adding Effects, shadow, glow, soft edges, 

and so on. As well as the actual size and properties of the Chart area. So you really do have a 

very, very wide range of formatting options there. And hopefully you can see now why I’m 

saying to you I suggest that you spend some time experimenting with all of those. 

So having shown you quite a bit there about how to format Reports let’s go back to Reports 

again. Let’s take a look at one or two of the other Dashboards. 

Now with many of these, for instance the Cost Overview, the way they’ve been setup is 

hopefully in a way that will appeal to the most people but of course you now know how to 

customize that if you need to. Cost Overview here gives you a cost figure, a remaining cost 

figure. Of course with the wedding project what’s happened so far is it hasn’t involved directly 

spending any money. So although the project is marked as 14% complete we’ve still got all of 

the remaining cost to incur. But you should be able to see now how we come up with the figures 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

that are in the Cost Status Table down there. And you can also see Charts such as this one up on 

the top right which shows progress made against cost. Now in this case once you start to look at 

these Charts and start to get an understanding of how they work the plan for the wedding project, 

you see the blue line generally way above the red line, indicates that work tends to be ahead of 

cost. And a lot of the cost comes towards the end. So early on we’re doing a lot of work without 

incurring much cost which is exactly what happens. Notice the red flat line to begin with. But 

then once we get very high up in terms of the amount of work complete then the cost starts to go 

up as we have to start paying for things, putting deposits on, paying balances, buying dresses, 

and so on. 

Each of these Dashboards is a summary in some sense. And again back to Reports. You can look 

at Project Overview, Upcoming Tasks, Work Overview, and so on. And then other reports 

include a Resource Overview which gives you resource stats, for example, for all resources. So 

you can see bride actual work. That’s the proportion of the bride’s work that’s done and the 

remaining amount. Very similar kind of figure for the groom. And then for the bridesmaids all of 

their work is remaining work because they haven’t got involved at all yet. And then you’ve got 

things like the percentage of work done by all work resources, how the work is broken down 

between the resources. So take some time to work through all of the standard Reports if you can. 

And don’t forget to refer to the Help for additional and alternative explanations of each of the 

Reports.  

One of the things that I mentioned to you before was I was going to show you how to create your 

own Report. And I’m going to do that as part of the next section where I’m also going to be 

setting you Exercise 08. So please join me for that. 
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Video: Exercise 08 

Toby: Welcome back to our course on Project 2016.  

In this section I’m going to set you Exercise 08. And in Exercise 08 you are going to create your 

own Report. Now the name of the Report will be My Management Summary. And I just want 

three things in the Report. I’ll show you my answer in a couple of minutes from now but let me 

first of all take you through the creation of the Report and how we put those three components 

into the Report. 

So first of all if I go to the Report Tab on the Ribbon and click on New Report I have a choice of 

starting from a Blank Report, starting from one with a Chart, starting with one with a Table, or 

starting with a Comparison. Now in fact since you can add any of the components of the Report 

that you might need from a blank one let’s start with a Blank Report.  

The first thing it does is to ask for a name. Now you’re going to call yours My Management 

Summary. I’m going to call this My Demonstration. Click on OK. By the way when you’re 

creating a Report, working on it, on the Design Tab in the Report Group at the bottom of the 

Manage button there there is an option to rename a Report. So if you finish up with a report that 

you want to change the name of that’s how you do it.  

So first of all I’ve got here basically a textbox. And if I want to change the wording in there I’ve 

already shown you how to do that. And if I want to format the textbox pretty easy. Select it and 

then I can, for instance, look for a Style for that textbox. Say that Style. And then I can do things 

like add Shape Effects. So for instance I could even put a bit of 3D Rotation on there if I wanted 

to or perhaps just a nice bit of Shadow. And you can just about make out the shadow there 

mainly to the left of that block. 

Now when it comes to adding the components that I want to add if for instance I wanted to add a 

Chart. Go on Chart. By default I get a Clustered Column. I can always change the type of a 

Chart. So I could, for instance, change that to a Line Graph or a Pie Chart. And say I selected a 

Pie Chart. By default I get certain data in that Pie Chart. Now look carefully at the Field List on 

the right. That’s controlled as usual by the Chart Data button. At the moment what I have in there 

is a filter that says Active Tasks. So that’s only showing me the tasks that are started but not 

completed. There is Grouping. I may or may not want Grouping. And then outline level is all 

subtasks. So that’s right down to the lowest level. Now it says No Sort. Of course you wouldn’t 

normally have a Sort with a Pie Chart anyway. So that’s a little Pie Chart. Not necessarily a 

particularly useful Pie Chart. Note that as I resize it not only will the size of the objects change 

but the layout within the Chart area changes as well. 

Now having selected the Pie Chart if I select that heading as well I can move those over to the 

left. And now what I’m going to do is to insert a Table. As usual I get a default Table. At the 

moment it’s working at the project summary level and it’s showing all tasks and it’s showing 
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name, start, finish, and percent complete. If I say wanted to remove, for example, the start date 

column. You know how to do that. Find it in the list, uncheck it and it’s removed. The other 

thing to bear in mind is that the order of the columns in the table is governed by this little section 

down here. And if I say wanted to move percent complete to the left of finish I’d click on percent 

complete, drag it up and put it into position like that. Now once again if I want to apply a filter I 

can. The group by I can and outline level I can. So if I wanted to go down to level three, for 

example, that would give me a list of the tasks at level three.  

Now having made my report it’s basically there and I can use it, open it at any time. And in a 

later section I’ll show you how you can share it with later projects. But let me now go to my 

answer to this question.  

And there is My Management Summary. As you can see I’ve got that heading Management 

Report. The Pie Chart shows the baseline cost for each of the four phases of the bathroom refit. 

Note that one phase doesn’t involve any cost so there are only three slices of pie with cost 

associated. And the completed tasks table on the right, note the heading there which isn’t 

actually part of the table of course. Has three columns, name, actual finish, baseline finish. The 

hierarchy is shown and the contents of that table are sorted by actual finish. Of course that’s 

actual finish within the higher level summary tasks and phases. So for instance within planning 

it’s in order of actual finish and then again within contractors it’s in order of actual finish. 

So that’s my answer to Exercise 08. That’s it for this section. Please join me in the next one. 
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Chapter 18 – Tracking Costs 

Video: Recording Costs 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to look at Tracking Costs on a project. And that is partly at least in 

preparation for the next section. Now earlier on in the course we did a bit of progress tracking 

and we marked three or four tasks as being complete and we did an update to the end of January 

2016. What I want to do is to sort of leap forward in time now and I’m going to leap forward in 

time to the end of April. And I’m going to pretend that April has come and gone and I’m doing 

an update on the wedding project to the end of April. 

Now first of all let’s just take a quick look at the Project Information and Statistics as they are at 

the moment. If I click on Statistics you can see the actuals in terms of duration and work. We 

have no actual cost so far. So none of the activities have involved parting with any money. Now 

that’s a very important point to bear in mind as we do the next progress update.  

Let’s go back into Project Information again and I’m going to set the current date which is in 

reality February 5th. I’m going to set it to May 5th. And I’m going to set the Status Date to the 

end of April. So I’m actually going to set it to April 30th and I’m going to click on OK and I’m 

going to do an update. Now I’m not going to take you through the process of doing this update. 

You should know how to do that by now. But I’m going to basically work on the principle that 

we’re a little bit behind schedule. Quite a few things are running a little bit late but not too bad. 

So I’ll do that and you’ll hear from me again in just a moment. 

So what I’ve done here is to record the progress. And as I said just now basically the progress is 

going to be a little behind what we intended. 

Now I want to look back now at Project Information and back into Statistics. You’ll see there’s a 

lot more work done. So if you look at duration with the baseline 190 day duration, actual 99. So 

we’ve done almost 100 days into the project, just over 90 to go. Work, well we’ve done more 

than half of the work but, and this is the surprise, the only cost we’ve incurred is $60 which you 

look at that and you think that must be wrong. Well there is a reason for this and that is that when 

it comes to actual cost there are what to me rather mystifying rules as to how actual cost works in 

Project 2016. To be fair these same mystifying rules have been around for a long time in 

Microsoft Project, but let me just summarize the rules as follows. 

Where you have a task cost that will be accrued, that will go into the books in the same way that 

the work, the resource work on a task goes into the book. I’ll show you that in just a moment. 

But where you have cost resources and what resources assigned to a task even though when the 

task is complete the cost of the work resources is accrued. Bear in mind it might have been 

accrued right at the beginning of the task but certainly when it’s complete it will have been 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

accrued. The cost of the cost resources is not accrued when you have both on a task. And what 

you have to do is to go in and manually record those actual costs.  

Now various people have come up with various ways around this, including things like setting up 

cost resources as in effect separate tasks or putting the cost against summary tasks and so on. But 

I do think all those things make things rather messy and difficult to keep track on. So what I 

intend to do is just face the fact that this needs to be done. And what I do and in my experience 

what most other people do is to go through and record those actual costs manually. 

Now to be fair it’s very often the case when you’re dealing with cost, particularly estimated cost 

as in the case of the wedding project, that you do need to go in and record what you actually 

spent anyway. So if you’d budgeted $400 for something it’s probably quite rarely that it will cost 

exactly $400. So to some extent it’s very likely you need to put the manual cost in anyway. But 

to make things just a little bit more onerous for you there are only certain ways that you can do 

this and I’m going to show you the way that I do it which is think is the way that many people do 

it. Once you get used to it it’s fine but it just take a little bit of getting used to. 

So now I’m going to go through the tasks in the wedding project where the cost of the cost 

resources should have been accrued and I’m going to record those actuals. And I’m going to do it 

in Task Usage View. 

Actually just before I do that let me quickly change the table here to Cost, just point out one 

thing to you. The $60 actual cost comes from this task, 43, Register wedding and get license. 

That’s a fixed task cost. So that’s why that $60 shows up. And where you’re dealing with a cost 

that really is a fixed cost it does show one of the advantages of using the fixed cost on a task 

approach to using a cost resource. But as I said earlier on in the course when I talked about this, 

it very much depends on the individual circumstances. 

So let’s go into Task Usage View now and what I need to show, bear in mind I’ve got these ticks 

on the left here that indicate the tasks that are complete. Let me just rearrange my columns a 

little bit. Let’s take, for example, Wedding venue. The wedding venue is a resource and if I right 

click on the details here I’m going to show Cost and I’m going to show Actual Cost. And let me 

just go along to the point where that task was happening. You notice there. That was the cost, 

$3,500 that we budgeted. But if I now point over the resource name Wedding venue and double 

click it brings up the Assignment Information dialogue. And in that dialogue I can put in the 

actual cost of the venue. And let’s assume that it’s actually come out a lot more expensive than 

we thought. So it’s another $1,000. So it’s $4,500. I’ve now recorded the actual cost of the 

wedding venue. 

And basically when you’re entering actual cost for cost resources on task that is a very popular 

way of doing it. It’s not quite the only way but it’s a very popular way of doing it. And you can 

see here how that actual cost rolls up to the task itself, the Book wedding venue task, and of 

course up to the summary task. And of course it will roll up right up to the project level. 
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Now what I’m going to do is go through the other cost resources that have been incurred 

according to the late April update and once again you’ll hear from me again when I’ve done that. 

So I’ve made sure that all of the costs incurred so far have been recorded. Generally speaking 

things have cost a little bit more than intended. And if we look at Project Information and go into 

Statistics you can see the figure is that the current cost, so this is what I still expect to pay plus 

what I’ve already paid is $34,330 against a baseline of $31,500. So we’re nearly $3,000 over 

budget already and we have a remaining $12,200 to spend. 

And finally as far as tracking costs are concerned, if we go up to the Report Tab there are a 

number of cost reports that you could try. For instance, there’s the Task Cost Overview which 

shows you, for instance in this Pie Chart on the right here, the cost distribution amongst the tasks 

based on their status. So $22,130 on the complete tasks. We have $8,000 on future tasks and then 

we have $4,200 on tasks that are currently running late.  

That’s it for this section. I’ll see you in the next one. 
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Chapter 19 – The Organizer 

Video: Using the Organizer to Manage Views 

Toby: Welcome back to our course on Project 2016. 

In this section we’re going to take a look at the Organizer. And this is a very useful feature of 

Project 2016 whereby we can manage a number of entities, including custom reports, custom 

views, tables, and also program code. If you get to the point of writing your own program code 

you can manage it using the Organizer. 

When we looked at Views earlier on I showed you how to make a Custom View. And I’m going 

to revert back to a Custom View that I made earlier in the course. And I’m going to apply it here 

to the wedding project. It’s TA Gantt Chart and click on Apply. And now you can see that 

custom View that we made earlier. 

Now if I had made that View in this project and I really like it and I think I’d really like to be 

able to use that View in other projects then how do I transfer it from this project for use in 

another project? Well the way I do it is to use the Organizer. 

Now what I’m going to do is to go into Backstage View and on the Info page one of the options 

is Organize Global Template. Click on Organizer and it brings up the Organizer dialogue.  

The first thing to note is that there are various things that I can manage with the Organizer and I 

choose between them using these tabs along the top of the dialogue. So I can manage Views, 

Reports, Modules, that’s Program Code Modules, Tables, Filters. We’ve dealt with some of these 

things earlier in the course. One of them in particular, Calendars, we’re going to be looking at a 

little bit later on. And one or two of the other things such as Groups are really outside the scope 

of the course.  

But you choose the type of entity that you want to manage using the tabs. So let’s go back to 

Views. And then you have basically two lists, a left hand list and a right hand list. And by default 

the left hand list shows you the Views in this case because I’ve got Views selected. That’s in 

what’s called the Global Template. And the Global Template is really a sort of template for your 

installation of Project. It’s a general repository for each of those types of object. So at the 

moment we’re looking at all of the Views that are in a Global Template. The right hand list at the 

moment lists the Views that are in the wedding project or I should say version 16 of the wedding 

project. 

Now below each of those lists I can choose what I want to see a list of. So for instance on the left 

where I’m currently looking at what’s in the Global Template, if I click on that dropdown you 

can see that apart from having the wedding project open I’ve got the bathroom refit Exercise 08 

version available as well. And that has different Views available to it, so the Views that are 
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available to the wedding project. Now note these are not all of the Views. These are basically 

Views that have in some way been created or customized. And of course one of the ones that’s 

available in the wedding project is TA Gantt Chart, the one that I just applied. If I select that on 

the right I can copy it into the bathroom refit Exercise 08. So let me click on Copy and TA Gantt 

Chart is now available to the bathroom refit project. So let me Close. Let me go back into the 

wedding project. As you can see, TA Gantt Chart is still applied. And let me switch now to the 

bathroom refit project. 

Now when I look at the bathroom refit project, if I go to Other Views, the list of available Views, 

one of them is TA Gantt Chart. Click on Apply and I’ve now applied that same View but this 

time to the bathroom refit project. So let’s just do an entire project to make it a little bit clearer. 

And you can see that I’ve used my customized View in a different project. 

Now what I did there was to Copy the TA Gantt Chart Custom View from one project, the 

project I created it in to another project. What I’m going to do now is to switch back to the 

regular Gantt Chart in this project and then I’m going to go back into the Organizer and I’m 

going to delete TA Gantt Chart. So I’m selecting it in the bathroom refit project and deleting it. 

Now let me close this, go back into the bathroom refit project. Once again choose Other Views. 

And do you think I’ll see TA Gantt Chart? Well in fact I do. And the reason is because not only 

do I see Custom Views that are in that project but I also see Custom Views that are in the Global 

Template. So if you like I get both lots of Custom Views, Reports, Fields, whatever it is that I’m 

looking to apply a custom version of. So strictly speaking I don’t really need to Copy something 

like TA Gantt Chart into every individual project. I can access it from the Global Template. But 

supposing I wanted to pass this project file to somebody else to use, somebody who wasn’t using 

my Global Template, i.e., somebody using a different installation of Microsoft Project. The way 

that I could pass to them a Custom View or Custom Report is to include it in the actual project 

file that I’m handing over to them. So that’s a very important point about managing and moving 

custom entities in Project 2016. 

Now if I really wanted to get rid of TA Gantt Chart altogether, let me just cancel this. Let me go 

back into the Organizer again. Let me now look at the Global Template list, click on TA Gantt 

Chart, click on Delete, say Yes. Now Close, back into the bathroom refit project, back into Other 

Views. Will I still see TA Gantt Chart this time? No, I won’t. It’s gone. 

That’s the end of this section. Please join me in the next one. 
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Chapter 20 – Saving Projects 

Video: Save As Options 

Toby: Welcome back to our course on Project 2016. 

We’ve already looked at opening, saving and closing projects throughout the course but what 

I’m going to look at in this section is a couple of additional features relating to saving projects. 

And in particular a couple of other options for the format that you can save projects in.  

Now I’ve got the wedding project here, version 16. If I want to at any time that I’m working on 

this project I can do a Save and it gets saved with the current project name, overwriting any 

previous version. But you also know that you can do a Save As. And when I do a Save As I’m 

given a number of options of where I want to save the file to. And I want to briefly talk about 

one or two of those options now. 

The top option that I have here and you may or may not have this option yourself, is the option to 

Sync with SharePoint. Now if you’re not familiar with SharePoint don’t worry too much. This 

won’t mean a lot to you. But if you are familiar with SharePoint hopefully it will. If you want to 

choose that first option what actually happens is the project is not saved as a project but it’s 

saved as effectively a SharePoint tasks list or to be more specific it’s saved in a form where 

SharePoint can look at it as a task list. And then the two ends of this synchronization that we 

setup are each able to work on the project. So somebody or some of your colleagues working in 

SharePoint can work on the tasks and the list and you can work on the project in Microsoft 

Project.  

Now of course SharePoint doesn’t have all the project management, all the scheduling, resource 

assignment, and so on facilities that Project has. But if you only need a subset of the 

functionality of Microsoft Project but you do need your colleagues to be able to see the tasks in 

this task list it’s quite possible that setting up a sync like this will work pretty well in terms of 

being able to share some aspects of the project with other people. Now as I say I’m not going 

into SharePoint in any detail in this course. So if you are interested in SharePoint be aware of 

that and I suggest you look into it, for example, using the available Help. 

Now below that I have other options, notably a couple of OneDrive options. And basically if I 

want to save this particular project to OneDrive I’m really treating OneDrive as an external, 

basically a Cloud based storage location. So I would save effectively my MPP file as an MPP file 

but in the Cloud.  

Now if you have access to OneDrive, and I’m sure that many of you have, your own OneDrive 

locations will normally be setup there. If they’re not for any reason you have an option down 

here, Add a Place, and you can setup a connection to a OneDrive location or indeed a SharePoint 

location using Add a Place. 
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Now for most of the time you may well be saving your MPP files to your current PC. And what I 

want to look at now is some of the options when you’re just saving to your current PC. So I’m 

going to do a Save As to the course files folder but this time I want to look at the options for the 

Save As type. 

Now the Save As type list has about a dozen items in it and the first four relate to Microsoft 

Project Formats. If you’re familiar with Microsoft Office you’ll know that over various versions 

the extensions for, for example, Word documents have changed. So we used to call them DOC 

files. Now we call them DOCX files. And then you have various versions like a DOT file which 

is a template. Well in Microsoft Project although the file format has gone through a number of 

versions the extension has always stayed the same for a straightforward project. So at the 

moment the extension is MPP. Before that there was an older version, an older format but that 

was also called MPP as well. And in fact there have been earlier versions also MPP, also 

different formats. So just looking at something and seeing that its extension MPP doesn’t 

necessarily tell you exactly what the format is.  

If you are working in a situation where other people that are accessing the same files as you, the 

same Project files as you have older versions of Microsoft Project you may need to use an older 

format. So for instance if you’re working in an environment where everybody was using 

Microsoft Project 2007 you may need to save your Project files in that Microsoft Project 2007 

format. But as a general principle it’s always a good idea to use the latest format if you can.  

Now notice that apart from the current format and that one previous format there are also the 

template versions of each of those. You can save a project as a template or you can save it as a 

Project 2007 template. And the extensions of those files are MPT. 

In order to be able to work on a Microsoft Project file you need a copy of Microsoft Project, that 

is if you want to work on it with full functionality. If on the other hand what you want to do is to 

distribute the information in the file with a reasonable level of detail but in a form that other 

people without access to Microsoft Project can look at the document that you’re giving them and 

get information but without having a particular piece of software to open it up with then one very 

good and very flexible option is to save your Project file as a PDF file. 

Now if I choose to save the wedding project as a PDF file, select PDF extension here. I’m going 

to save it to the course file. When I click on Save I’m given the Document Export Options 

dialogue. I can choose either the range, that’s all of the tasks in the project or a date range. I’m 

going to choose all on this occasion. And I can choose whether to include certain non-printing 

information such as the document properties and whether I want the document to show markup 

or not. Ignore the last option, PDF Option. That’s to do with the standard, the compliance 

standard for the particular PDF document that you’re going to produce. Let’s click on OK. And 

here is the resulting PDF file open in Adobe Reader.  
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If I go to the File Menu in Adobe Reader and look at Properties. We did select to include the 

properties of the document. And you can see, for example, the author there in the document 

properties. And of course have the options within Adobe Reader of, for example, changing the 

page display. And although it’s not the most convenient way of reading a document like this but 

this does represent a good and flexible way of distributing information about a project to people 

that don’t have Microsoft Project. And of course the added advantage here is that they can’t 

change your project either and move tasks around in time, etcetera. 

And finally let’s look at a couple of the other options for Save As types. XPS files you may be 

aware of as Microsoft’s version of PDF. That’s somewhat grossly oversimplifying it but I think 

that summarizes it accurately enough for our current purposes. And then you have the option to 

save the project as an Excel workbook. Now I’m not going to go through this in detail but 

basically if I choose that option, click on Save, it takes me through an Export Wizard. And as 

you can see from the first page there this wizard automatically maps fields in Project to the 

appropriate export format and then allows you to verify the results. Basically what you can do is 

to take the information that’s in your project and export it to an Excel workbook and possibly do 

further processing within Microsoft Excel. This is very often a good approach if you have some 

particular type of analysis, particularly graphical kind of analysis or statistical analysis. Being 

able to export to an Excel workbook is a very good option. Now as I say I’m not going to go 

through that now. I do suggest you experiment with it. But for the moment I just wanted to make 

you aware of the fact that this exists. 

Now amongst the other Save As options we have saving as Tab Delimited Text, saving as a 

CSV, a Common Separated Value file, and saving in XML format. I’m not going to demonstrate 

any of those on the course. But if you’re familiar with those formats I do suggest you give them a 

try. 

That’s the end of our brief review of the other Save options within Project 2016. And that’s the 

end of this section. Please join me in the next one. 
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Chapter 21 – Project Security 

Video: Password Protect an MPP File 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to take a look at a couple of aspects of security in Microsoft Project. 

And the first of them is to see how to password protect an MPP file. Now in order to demonstrate 

this I’m going to save a new version of the wedding project. So we’re currently on wedding 

version 16. I’m going to save this as wedding version 17. And what I’m going to do is to do a 

Save As. Now in doing this as I just said I’m going to create a new version, Wedding 17. I could 

do exactly what I’m going to do now with Wedding 16 and what would actually happen if I did 

that is that I would password protect Wedding 16 itself. And what that would do would be to 

overwrite the current version which is not password protected with a version that is password 

protected. But I am going to save this as I said as Wedding 17. And to do it what you do is click 

on the Tools dropdown next to the Save button before you click Save, select General Options 

and you have the Save Options. Ignore the first checkbox about always creating a backup. That’s 

an interesting one actually. You can every time you save a version you can save a backup copy 

so that if you ever need to go back you can go back to the backup copy. But we’re dealing with 

passwords now. And then you can put no passwords, one password or two passwords on the file. 

At the moment it has no passwords and it has no password protection so anybody can open the 

project, anybody can change it.  

If I put a protection password on then somebody would need to know that password in order to 

be able to open the file. If I put a Write reservation password on then what that means is that in 

order to make changes to the project somebody would need to know the write reservation 

password. Now I’m going to put both passwords on at that moment. The first one I’m going to 

put on is pa55wd. That’s like Password. Now obviously the password as I type it is not echoed. 

And then the Write reservation password is t0bya%. Now I’m not putting any really fancy 

passwords on here. I normally use considerably more complex passwords than that. But if you 

want to try opening Wedding 17 yourself from the course files they’re the two passwords to 

remember, pa55wd, all the letters are lowercase, and then t0bya%, and again all the letters are 

lowercase. 

I’m then going to check the box that says Read only recommended. And what that will do is that 

if somebody tries to open this file what Project will do is to recommend that they open it Read 

only, that they don’t try to open it in a mode where it can be changed. But you’ll see that in just a 

moment. 

So having entered those two passwords click on OK. It’s going to ask me to reenter each of the 

passwords to make sure that I’ve entered it correctly, or if you like to make sure that I’ve entered 

what I thought I entered. So I’m going to put in pa55wd, click on OK, and then the Write 
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reservation password is t0bya%, click on OK, click on Save. Then I’m going to Close Wedding 

17. And now let’s see what happens when I try to reopen it. 

So I’m accessing Wedding 17 from the Recent Files list. Now note first of all I get the Read only 

recommended message. Now on this occasion when it says, do you want to open the file as read 

only I’m going to say no, I want to be able to change this. So first of all it asks me for the 

password, the general password which is pa55wd, click on OK. Now it asks me for the Write 

access password. Note the option there to click on Read only if I changed my mind and want to 

open it read only. Click on OK. But I now have full access to Wedding 17. 

If I wanted to clear the password all I need to do is to do Save As again and basically clear out 

those password fields. 

The second aspect of Project security that I want to briefly talk about is the fact that it is possible 

for somebody to damage your computer system by running program code, macro code from a 

Microsoft Project file. And if you receive a Microsoft Project file from somebody and open it in 

Project and it has some macro code in it you need to be careful about whether you want to 

actually allow that code to run or note. Now as I mentioned earlier on in the course we don’t 

cover macro programming. And if we were covering it I’d explain this in more detail. But at the 

moment in order to protect yourself one of the most fundamental things to do is to check that you 

have a particular setting at the best default setting.  

Now if you go into Backstage View and into Project Options the last page there is the Trust 

Center. And in the Trust Center there is a Microsoft Project Trust Center section. Just read what 

it says there. The Trust Center contains security and privacy settings. These settings help keep 

your computer secure. We recommend you do not change these settings. Well I’m really asking 

you to check the settings yourself here. 

If you go into Trust Center Settings the setting I need you to check is Macro Settings. And the 

default setting, the second one there, Disable all macros with notification. Basically says if you 

open a Project file and it has some macros in it what Project will say is I’m not going to run 

those macros but it will tell you there are macros. It will say there are macros in this project. Do 

you want to allow me to run them? Now if the project comes from somebody you trust, maybe 

somebody who sent you a project and you know there’s macro code in it and you need that 

macro code to do something then you’ll say, “Yep. I’m fine with that. You can run those 

macros.” If you’ve got the project file from a source that you don’t trust or you’re not even quite 

sure where the Microsoft Project file comes from you might say, “No, no. I want to look into 

this” and say don’t run the macros. 

Now if you do get into programming Microsoft Project at some later stage then you will need to 

look at these other macro settings and decide whether one of those becomes more appropriate. 

But at the moment if you’re not planning to do any macro programming that second setting is the 

recommended one and is almost certainly the right one for you. 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

That’s it for this section. I’ll see you in the next one. 
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Chapter 22 – Project Templates 

Video: Saving Your Project as a Template 

Toby: Welcome back to our course on Project 2016. In this section we’re going to take a look at 

Templates. 

You’ve already seen these thumbnails many times before. I’m on the New screen here. And I can 

choose from one of these available Templates and use that as a starting point for a project. I 

spoke to you earlier on in the course about how you can search for online templates. And I do 

suggest that you experiment with some of these templates. If I were to choose one of these, let’s 

say Residential Construction, click to select it, read the description, decide I’m going to use it, 

click on Create. I’ve got a very good starting point for a project plan for a residential 

construction. One aspect of this template, and in fact it’s quite a common aspect of these 

generally available templates now, is the way in which the timeline is used effectively to show 

phases in a project. And I think that the way in which the timeline has been used in this particular 

project to give you a good overview and in effect show how the main phases in this residential 

construction relate to each other and link together is a really effective use of the timeline. And 

that in turn is a good explanation of the value of looking at the templates that are available and 

seeing the ways in which various people have set their projects up and used features like the 

Timeline. 

Now what I’d like to mainly look at in this section is how you can use one of your own projects 

as a Template. And the example I’m going to use is the wedding plan. Let’s suppose I’ve got the 

wedding plan to a point where I’m really quite happy with it and although I appreciate that every 

wedding is different there is enough content in that wedding plan which is common to many 

weddings to think it will be a really good starting point for planning somebody else’s wedding. 

Now what I’m going to do then is to save the wedding plan as it is now as a Template and I’m 

going to show you how you can then make that Template available for use in future projects. 

So I have here version 18 of the wedding plan. I’ve removed the passwords that I put on in 

version 17. And we’re going to save this version as a Template for future wedding projects. 

Before we do that though it’s very important to establish the folder in which our personal 

templates are going to be stored. Now there’s a bit of a long and complicated story behind this 

for me. I’m not going to go into it now. But the point I need to make is that the way that I’m 

going to do this is a perfectly reasonable way of doing it but there are other ways of dealing with 

where to store personal templates. 

So first of all what we’re going to do is to go into Options, back to the Save page, and we’re 

going to look at one of the options that I haven’t talked about before and that is Save Templates. 

You will almost certainly, particularly if you have a new installation of Project 2016, have 

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

nothing in this box, Default personal templates location. And in order to be able to use personal 

templates effectively you need to specify a folder. Now there is a standard folder that you can 

specify here and I’m going to point that out to you right at the end of this section. But for the 

moment and for the purposes of this demonstration what I’m going to do is to use the course file 

folder as my personal templates folder. So I’m going to browse to the course files folder, click on 

OK, and the name of the folder now appears in that Default personal templates location entry on 

the Save page in Project Options. So click on OK. Having established my personal templates 

folder what I’m now going to do is to do File, Save As. If I change the Save As type to Project 

Template it automatically goes to my personal template folder. Now what am I going to call this 

template? I’m going to call it My Wedding Planner.mpt, click on Save. And I get the Save As 

Template dialogue.  

Now although I’m saving the current version of that plan as a template there are certain things in 

it that Project suggests I might want to remove. For instance, do I want to keep the values of all 

Baselines? Well this is going to be used planning future projects and therefore the Baseline for 

the current wedding plan isn’t really going to be of much use so I’m going to remove that. And 

I’m also going to remove the second item there, Actual values. No actuals related to the current 

project would apply to a future project. The next two items, Resource Rates and Fixed Costs, I’m 

going to leave those in the Template. Obviously I’m going to need to check them whenever I use 

this Template in the future to make sure they haven’t changed. But they’re a good guide and I 

suggest to keep those in for the moment. Of course I could always resave the Template later and 

remove those if they were proving to be obstructive. The last option relates to publishing to the 

Project web app which is outside the scope of this course so I’m going to ignore that for the 

moment and click on Save. And as you can see from the header up there I now have a Template, 

SSI My Wedding Planner.mpt. Let me Close that. 

So I’m now at some future point in time and I want to create a new wedding plan so I’m going to 

go to New. Once you’ve established a personal template folder on the New page you will see this 

pair of options, Featured and Personal. And whereas the Featured gives you a list of the featured 

templates which are basically the ones available from online and Microsoft. The Personal one 

now points at your personal template folder. And there is my single personal template at the 

moment. If I click on that to select it and then click on Create I’ve now got a new project based 

on my Template. No Baseline, no Actuals but Resource Rates, etcetera inherited from the 

version 18 of the wedding plan as was. And I can now start working on a new wedding. 

Now there’s just one other thing to point out here. I mentioned earlier on in this section about the 

personal template folder and also the fact that there’s more than one way of doing this. There is a 

recommended location for storing personal templates. And if I just go back into File, Save As for 

a moment you can actually see on here what that location is for me on my device. It’s 

C:>Users>>TobyA, that’s my Windows Username, 

AppData>>Roaming>>Microsoft>>Templates. And certainly in relation to Project 2016 and 
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Windows 10 the recommended location for you would be the same as that, obviously replace 

TobyA with your Windows Username. 

There is also a Help topic which will help you to identify and setup this location. The topic is 

Where are my Custom Templates? And if you work your way through that it’s pretty 

straightforward. There’s even a Microsoft Fix it facility that’ll help you to find that 

recommended location. 

That’s the end of this section. Please join me in the next one. 
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Chapter 23 – Calendars 

Video: Calendars – Part 1 

Toby: Hello again and welcome back to our course on Project 2016. In this section we’re going 

to start to look at the very important topic of Calendars.  

Now generally speaking I tend to cover Calendars usually earlier on in courses on Microsoft 

Project but an understanding of Calendars and how to use them I think benefits from knowing 

quite a bit already about how scheduling works, how resource assignments work and so on. So 

on this occasion I’ve left them till a little bit later on in the course and hopefully this will give 

you better ability to understand just how important Calendars are. Having said that when you’re 

using Microsoft Project making sure that your Calendar or Calendars are setup is actually one of 

the things that you should do very early on in the work on a project. And you’ll see this as I 

explain the use of Calendars from now on. 

And one of the things you may want to do after going through at least part of this section is to 

take a look at the Calendars for the wedding project and for the bathroom refit. But we’re going 

to start a completely new project, a blank project now. And we’re going to use a very different 

Calendar for this particular project.  

Now the project is going to be a project to do some work on a road in a town. So there’s some 

resurfacing work to do. We’ve got to drill up the road. We’ve got to prepare it for surfacing. 

We’ve got to surface the road and then we’ve got to put everything back together again. 

Now as a building job and one which should be done as quickly as possible so as to keep the 

disruption to residents as short as possible we’re going to be operating from relatively early in 

the morning until relatively late in the evening. So this particular project is definitely not an 

office hours project. 

So I’ve created the new project. I called it Road Fix 01. And on the Project Tab I’m going to 

click on Change Working Time. And that brings up a dialogue, Change Working Time dialogue, 

that explains the current working time, if you like the current Calendar for this project. Now the 

settings are the default ones in Project 2016. Unless you’ve changed them yourself it’s very 

likely that you’ll find that on your installation the working time for both the wedding project and 

the bathroom refit are set the same as this.  

Now let me explain this dialogue because there’s quite a lot in it. In the middle you have 

basically a month by month calendar. You can use the little arrows on the right to step through 

the months. And on any particular month the gray background are the nonworking days. So you 

see the legend on the left? So Sundays and Saturdays are nonworking days. Working days are the 

days with a white background. So Monday to Friday as you’d expect. If I select a day such as 

February 17th, that’s the day on which I’m recording this, the working times for that day are 
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shown over on the right here, Working times for February 17th, 8 a.m. to 12 p.m., 1 p.m. to 5 

p.m. That’s an eight hour working day. And the figures here are based on the default work week 

on the Calendar Standard.  

Now also over on the left on the legend you can have Exception days. I’ll talk about those a bit 

later. And you can also have a Nondefault working week. So you can setup a particular week as 

being say different working hours to other weeks. At the bottom you have a couple of tabs. On 

one tab you can indicate any exceptions. Exceptions would include things like public holidays. 

And you can also define what a work week is in this Calendar.  

Now we’re looking at a Calendar called the Standard Calendar. And for this project this is the 

Project Calendar. So you have actually three calendars by default. You have Standard, you have 

Night shift, and 24 hours. If I wanted the 24 hour Calendar to be the calendar for this project I 

could make it the calendar for this project. And that involves around the working, seven days a 

week. And it would be straightforward to set that up as the calendar for this project. If I wanted a 

Night shift only project I could do the same. And the working hours there, 12 a.m. to 3 a.m., 4 

a.m. to 8 a.m., 11 p.m. to 12 a.m. So there are your three default Calendars. 

Now we come to a very important point. Let’s suppose that generally speaking your projects do 

run during office hours, if you like. So the standard calendar is the one that’s closest to your 

hours of work. And let’s suppose that 8 to 12 and 1 to 5 is fine for you in terms of working 

hours. Then clearly you can use this Standard Calendar as your basic Project Calendar for many 

or all of your projects. If on the other hand the Standard Calendar is never right for you and you 

work say 9 to 1 and 2 till 6 or maybe you do a seven hour working day or something like that. 

You may want to change the Standard Calendar to fit in with your own standard hours of work. 

But if that’s not the case, if in fact on each of your projects the hours of work tend to be different 

then I strongly suggest that you don’t change either the Standard, the 24 hour or the Night shift 

Calendars. You leave those as they are. And that for each project you create a new calendar or 

some new calendars to deal with that project.  

So what we’re going to do on this occasion is we are going to create a new calendar for the road 

fix project because the hours of work are going to be much longer than the standard and also 

because it’s a rather unusual project from the point of view of hours of work for me anyway. So 

I’m going to choose the option up here on the right, Create New Calendar.  

Now when I create a new base Calendar I can give it a name of my choosing. I’m going to call 

this, this is my Building Calendar. I can either create it as a new base Calendar which means I 

can just enter everything from scratch or I can make it a copy of an existing one. Well I’m going 

to make it a copy of the Standard Calendar because although I’m going to change the hours quite 

a bit some of the features of the Standard Calendar are fine, such as the fact that we’re not going 

to be working on weekends. So click on OK and I now have my new Building Calendar. 

Currently the settings in it are exactly the same as in the Standard Calendar. 
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So the first thing that I need to do is to change the standard work week. You see there the Work 

Week Tab is selected and at the moment it just says Default work week. If I click on Details it 

will give me the details of what the standard working week is. Notice the radio buttons here, Use 

Project default times for these days. So I can select individual days of the week. So Sunday there 

is no work. You see there are no figures in there. Monday 8 till 12, 1 till 5, Tuesday, etcetera. I 

can set any one of the days to nonworking time if I select it. And I can also set days to different 

specific working times.  

Now what I’m going to do on this occasion is I’m going to change the working hours for all of 

the working days Monday to Friday. So click on Monday, Tuesday, Wednesday, Thursday, 

Friday. Each of these days currently has the default working times from 8 a.m. until 12 noon and 

then from 1 p.m. until 5 p.m. I’m going to change those working times and I’m going to set them 

to the longer working times of 7 a.m. to 1 p.m. and 2 p.m. to 8 p.m. So that’s a twelve hour 

working day. So having done that click on OK and my working days have changed for all days. 

That’s the standard working week now is five days of twelve hours. Now in a moment I’m going 

to look at some exceptions. But before I do I’ve got another very, very important thing to point 

out. 

And that is that if I click on Options here it takes me into Project Options to the Schedule page. 

And there is a section there that we looked at briefly earlier on in the course, Calendar options 

for this project. Now one of the things in Project 2016 that you need to be wary of is that 

although we’re now setting up quite an unusual calendar and this calendar is going to be used in 

our project together with some other specific variations that we’re going to look at in the next 

section. Setting up the calendar alone is not enough to make sure that all of our calculations in 

Project 2016 for this project are going to work correctly because there is a set of options in 

Project, the ones that we’re looking at now, which are used for a number of calculations. And it’s 

very important that you have those options set to tie in with the Project Calendar. So for instance, 

one of them here, Hours per day, is still set at 8. And if we leave that set at 8 then we’re going to 

find some inconsistencies in the calculations that Project does. 

Now it’s important to recognize that although we’ve got a Project Calendar setup as a standard 

twelve hour day that doesn’t mean necessarily that everybody working on the project will be 

working on the basis of a twelve hour day. And what we need to tell Microsoft Project is when 

you’re doing your calculations in Reports, in scheduling and so on what number of hours per day 

should be, if you like, the standard number that you base your calculations on. And we need to 

increase that from eight to twelve. Note that it’s only for this project, Road Fix 01. This is not 

going to affect the hours per day for any other project. So I need to be clear that the hours per 

day on this project, the standard hours per day are twelve hours. And therefore the standard hours 

per week are 60. I’ll leave the days per month as 20 but I’ll also change the default start time. So 

if any tasks where we don’t specify a start time the default start time is 7 a.m. And I’ll change the 

default end time. And again if we don’t specify an end time for a task it defaults to 8 p.m. I’ll 

leave the starting day for the week as Sunday and the fiscal year starting in January. Now it is 
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very, very important that those are set to the values that you want to apply throughout the 

project, even though as I say individual tasks and as we’ll see individual resources may not all 

correspond to those figures. 

Now having set up our standard working week in the building calendar let’s now look at 

exceptions. It’s very important not only that you get the working week setup and the working 

hours setup correctly, that you also schedule in any relevant exceptions before you start planning 

a project.  

Now an exception that I want to setup here is Easter Monday. This project is going to run either 

side of the Easter holiday this year. So let me go to March, Easter Monday is on March 28th. And 

I’m going to put in here as the name of the exception. It defaults to the date I’ve selected. Note 

how the indicator for that day now shows it as an exception day. And I need to make sure that 

that’s indicated as a nonworking day. If I click on Details it’s nonworking. Note that if instead of 

nonworking I say wanted it to be a half day I could change that and just show it as say a half day 

working. But I want it to be a nonworking day.  

Now by default when you setup an exception it’s actually setup as a recurring exception. But in 

doing that what Project 2016 does is to set it up to only recur once. So you have here a 

recurrence of daily every one day but it starts on March 28th and it ends after just occurring once. 

So you only get Easter Monday once. 

If I click on OK. If on the other hand I wanted to setup Christmas. So let me go to December 

25th. It’s actually a nonworking day this year anyway but that doesn’t matter. Let’s set it up. 

Again it defaults to the selected date. If I go into Details, now it’s a nonworking day. I can say I 

want it to recur yearly but not after just one occurrence. I can say let’s schedule it to go on until 

well 2025 say. Now I don’t think fixing this road is really going to take that long. But now that’s 

set up as a recurring exception from Christmas Day this year to Christmas Day 2025. 

So what I would normally do now is to set up any other exceptions. When I’ve finished with the 

exceptions click on OK. Let me now go to the Project Information option and change my Project 

Calendar from Standard to Building. Click on OK and I’m now using the Building Calendar as 

my project calendar. 

That’s it for this section. Please join me in the next one. 
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Video: Calendars – Part 2 

Toby: Hello again and welcome back to our course on Project 2016.  

I’ve added the basic tasks that are needed for the road fix project. We’re of course using that 

Building Calendar with a twelve hour working day. And I’ve scheduled the fix to take two 

weeks. We start out with marking out the site, preparing equipment and so on. There is a main 

task roughly in the middle there, ID 7, Drill and clear, the one that’s selected at the moment. 

Then we have the surfacing work, the clearing up and so on.  

Now I’m sure if you’re a road builder, road layer then you know that there’s a lot more involved 

than that. But I really just want to demonstrate the use of Calendars here so I’ve tried to keep this 

as straightforward as possible.  

Now the first thing to point out is that when I added the resources, the work resources to this 

project, let’s just go to the Resource Sheet. Each of them by default gets the Building Calendar 

as their base calendar. And for each of them not only could I choose one of the other calendars if 

it was more appropriate to them but I could actually create individual calendars for them. Having 

said that I don’t actually need to create individual personal calendars for each of the work 

resources because as you’ll see I can setup exceptions for each work resource such as their own 

holiday, vacation time, perhaps their own days off to go to the dentist or the doctor or whatever. I 

can set those up within the existing structure and framework for Calendars. As I say I’ll 

demonstrate that to you in a little while. 

Now if I go back to the Gantt Chart one of the things I haven’t mentioned before is that if I take 

an individual task like that middle one, Drill and clear, let’s just open that up. There is an option 

to have a Task Calendar. Not only can you have a Project Calendar but you can have Resource 

Calendars as I pointed out just now, you can have Task Calendars. A task can have its own 

calendar. And the first example I want to show you here is an example of where a task has its 

own calendar. And what I’m going to do here for the sake of relative simplicity is to say that the 

noisiest part of this particular job is that drilling and clearing operation. And given that the 

Building Calendar goes from 7 in the morning till 8 in the evening in order to get the permission 

to do this work we’ve been told that we have to restrict our hours of work on this particular task 

to just eight hours a day instead of twelve hours a day. Now what that will almost certainly mean 

in terms of the project of course is that the elapsed time on the project will be longer. But let’s 

first of all look at how we apply a different calendar to that task. 

Now at present that task is covering four working days. We have two people working on it 

twelve hours a day. So that’s a 96 hour task. And we’re going to need to restrict it to eight hours 

a day. The resources themselves, Jeremy and Max are available for the full twelve hour day so 

the problem is not with them. The problem is with the task. So it’s important to apply the 

restriction on hours to the task.  
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Now you might say well why not just use the Standard Calendar? That’s eight hours a day. And 

that would approximately work. The trouble is that the lunchtime break in the Standard Calendar 

is not at the same time as the lunchtime break in our Building Calendar. And therefore although 

we would be showing eight hours a day of work in the Standard Calendar the resources are 

scheduled to take their break from 1 o’clock till 2 o’clock and 1 o’clock to 2 o’clock is working 

time in the Standard Calendar. So what I’m going to do is to create what I’m going to call a 

Quiet Time Calendar which is just an eight hour a day calendar but based on the Building one. 

So I’m going to cancel the Task Information for the moment. I’m going to go into Change 

Working Time. I’m going to say Create New Calendar. I’m going to call it Building Quiet Work. 

I’m going to make a copy of Building, click on OK. And then what I’m going to do for this new 

calendar is to go into the working weeks, look at the details. I’m going to select Monday to 

Friday and I’m going to say that this one is going to be. And there we are. I’ve set it at 9 till 1 

and 2 till 6 Monday to Friday. So click on OK, click on OK again. Now I’m going to open up the 

Drill and clear task and I’m going to select as Calendar Building Quiet Work. Now watch 

carefully what happens to task 7 when I do this. Of course it gets extended. And instead of being 

a four day task it’s now a six day task. And of course that has pushed the end of my project out 

to the Tuesday of the following week. 

So that’s really quite bad news for the project but Exercise 09 I’m going to set you in the next 

section is going to be our attempt to fix this particular problem. Before we do that though we’ve 

got one other little bit of bad news and that is that Max is going to need to take Wednesday of 

next week off. He’s got to go to the hospital so he can’t work next Wednesday. So let’s set Max 

up with a day off next Wednesday. 

Now in order to do that if I go into Change Working Time and look at the For calendar at the top 

here. If I click on the dropdown one of the options indicates the individual work resources 

calendars. Now as I mentioned earlier on the individual resources have not been given their own 

calendars. I could create a calendar for each of them if I wanted to. But if all I’m dealing with is 

exceptions such as holidays, vacations or medical appointments and so on then I can do that as 

individual exceptions. So first of all let’s select Max and let’s setup an exception for Max. Now 

on my dates next Wednesday is the 24th, select that. It’s a full day off. I can check the details. As 

I mentioned earlier it’s a recurring exception that happens only once so click on OK. Click on 

OK and of course that’s made things just a little bit worse now because without Max there to 

work on drilling and clearing the projects gone a little bit further back still.  

We’ve got a bit of a problem there. Everything’s running into that third week. But fixing that 

problem is what Exercise 09 is all about. So please join me for that. 
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Video: Exercise 09 

Toby: Hello again and welcome back to our course on Project 2016.  

In the previous section I mentioned Exercise 09 a couple of times and this is what I’m going to 

set you in this section. 

Now in the previous section we had a problem. We’d set up the road fix project. But because of 

the need to restrict hours of work on the noisiest part of the job, the Drill and clear task, to hours 

just eight hours a day from 9 till 1 in the morning and from 2 to 6 in the afternoon. The project 

has run over into a third week which we didn’t really want to happen. In addition, one of the key 

resources on the project, Max, has to go to the hospital next Wednesday, Wednesday in the 

second week. And allowing for that and the restriction on time for work we’re running two and 

bit days behind where we’d like to be. 

Now we’re going to resolve that on the basis of the very good news that we’ve been given 

permission to work over the weekend. So this is the weekend which is spanned by the Drill and 

clear task. We can work those same restricted hours, 9 till 1 and 2 till 6 on both Saturday and 

Sunday. So what you need to do is to change the working time so that working on that Saturday 

and that Sunday are allowed. Now beware because in effect you have if you like two calendars 

involved there. The Project Calendar is the Building Calendar and that is the calendar of course 

that Jenny and Max are working to. But there is also a Task Calendar and that is the Building 

Quiet Time Calendar. And even though that was built from the Building Calendar that’s the one 

that dictates when work on that task is allowed to happen. So bear that in mind. And what you’re 

looking to achieve is a situation where work is being done over that weekend. 

Now I’m starting you off with file Exercise 09A. That’s in the exercise folder. That’s the one 

you’re going to start with. And my answer is Exercise 09B. And I’m going to talk about my 

answer in just a moment. But just before I do one other thing. If you find it more convenient to 

use dates which are nearer to the date when you’re working through this course that’s fine. When 

you open 09A you can change the start date for the project. Just change it to whatever the 

preceding Monday from where you are now is. And then the idea is you’re trying to make this 

project fit into a two week period, start on a Monday and finish on the Friday at the latest. Now 

of course if you make that change then that’s going to affect any other dates that you’re setting 

up within the project. 

So anyway that’s the job is to get that weekend working going. Now if you get that weekend 

working sorted out you should find that Max’s day to go to the hospital is actually not going to 

cause a problem. We’re still going to be able to finish on the Friday. So there is a little challenge 

for you. 

Now let’s take a look at one aspect of my answer. 
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Now here is my answer in 09B. And as you can see it starts on a Monday and it finishes on a 

Friday. But the point I want to make to you, a very important point is this. Once we’ve got that 

weekend working going here, there’s Saturday and Sunday and you see both Max and Jenny are 

doing eight hours on Saturday and eight hours on Sunday. Bear in mind that on Monday they’ll 

again come in on that task and they’ll do eight hours work on that. But bear in mind that each of 

them also has other time on Monday. Bear in mind that they are still working on a twelve hour 

calendar. And both Jenny and Max do work on other tasks on Monday. And that helps to pull the 

whole schedule back into our original timescales. In addition, if you look at Max’s day off on 

Wednesday, his day at the hospital on Wednesday, obviously he’s not doing any work on that 

day. But the work he needs to do on the Edges and paving task he can still finish on Thursday in 

time for him to contribute enough hours to complete the Finish and clear task so that the whole 

project is finished on the Friday. 

So a couple of very important points there about a situation where a Task Calendar is if you like 

a subset of a Project Calendar. And how even though people may be restricted on the hours they 

can work on one task they may be able to work on something else. 

So that’s it. That’s Exercise 09. That’s the end of this section. Please join me in the next one. 
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Chapter 24 – Scheduling Issues 

Video: Task Inspector 

Toby: Hello again and welcome back to our course on Project 2016. 

In this and the next couple of sections I’m going to look at some tools for scheduling that we 

haven’t really looked at in any detail in the course. I’m going to give you a little bit more 

information about them. And then I’m going to leave you to try those out for yourself. To resolve 

scheduling problems, scheduling issues in your own projects. 

Now the first one that we’re going to look at is the Task Inspector. And I did mention the Task 

Inspector once or twice earlier on. I want to look at it in a little bit more detail in this section. 

And in order to do that I’m going to introduce one or two typical scheduling problems into the 

bathroom refit project just to show you how the Task Inspector can help you to resolve them. 

Now in doing this I’m going to demonstrate one or two other aspects of scheduling issues and 

how to resolve them. And in particular I’m going to look at some of the issues that may affect 

manually scheduled tasks. So what I’m going to do is I’m going to go to the Fit equipment task 

here and say I really do want to make sure that that task happens from Thursday, March 3rd to 

Tuesday, March the 8th. So I’m going to change it from being an auto-scheduled task to a 

manually scheduled task. And then Project 2016 won’t auto-reschedule it if changes earlier in the 

schedule affect it. So let’s go up to the Task Tab and click on the Manually Schedule button. 

That particular task is now manually scheduled. You notice how its appearance is different in the 

Gantt Chart. It’s now got a manually scheduled style of bar. 

Now let’s assume that the earlier work in the project runs into a problem and the task Gut 

existing bathroom actually instead of taking two days takes four days. So I’m going to increase 

that from two days to four days, click elsewhere. And I’ve now got a problem, the Planning 

Wizard. This action will cause a scheduling conflict. Task 66 of the bathroom refit project has a 

task constraint or is linked to a task that cannot move. Now I’ve already set the refit complete to 

must finish on March the 11th. And as a result the constraint of the link cannot be set. Now what 

I’m going to do here given the options, Cancel, avoid the conflict and continue, Allow the 

conflict, is I’m going to say Continue and allow the conflict. Click on OK. And I now have a 

scheduling conflict. 

Now in effect the scheduling conflict has now a number of components because in moving the 

Fit tiles, Fit flooring and Paint tasks two days to the right if you like they now cause a resource 

overallocation against the Fit equipment task. 

Now the first thing I want to do is to look at that Fit equipment task, the manually scheduled one. 

That couldn’t move and that’s really why we finished up with this resource overallocation.  
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On the Task Tab in the Tasks Group there is an Inspect button. And on the bottom of that a little 

dropdown arrow. One of the options is Show warnings. And this will show for manually 

scheduled tasks any warnings. And in this case it will show it in the form of a sort of squiggly 

line under the date. And that red squiggly line under Tuesday, March the 8th is saying we can’t 

really achieve that date with the current schedule. We’ve been pushed back. Now although this is 

a manually scheduled task and Project 2016 can’t actually reschedule it it’s that end date that 

Project 2016 cannot now achieve. 

Now in order to resolve this issue let me just right click on that task. The top option on the menu 

there is Respect Links. And we can actually say to Project 2016 okay I know this is a manually 

scheduled task but what I want you to do is to respect the link to its predecessor tasks. Watch 

what happens if I click on Respect Links. It does reschedule the task for me. Now that’s not the 

same as saying that we’ve resolved the overall problem, the overall delay caused by the two day 

overrun on Gut existing bathroom. But it does mean that the problem with the Fit equipment task 

in terms of achieving its previous manually scheduled end date has been resolved because 

Project 2016 has actually moved it to a new manually scheduled end date. It’s still a manually 

scheduled task but we’ve effectively given Project 2016 permission to move it. 

Now let me undo that and let me again right click on that task. And now let me say Fix in Task 

Inspector. 

Now what the Task Inspector gives me is a whole load of information about the task and the 

problems that we have with it. But also some options for how to resolve the problems. So 

starting at the top in the panel on the left, the Task Inspector Panel. It says Resources are over-

allocated due to work on other tasks. And the resources that are over-allocated are contractor. 

And in addition the task may need to be delayed by two days. Now of course given a 

combination of problems it may be that solving one problem solves another. It then suggests 

possible actions. Respect Links is one of them. That’s what we did manually with that selection 

just a moment ago. And also we can change the task to being an auto-scheduled task. And then it 

will be auto-rescheduled in the same way that any other auto-scheduled task would be.  

Then we’re given a body of information about the task. It’s a manually scheduled task. There’s 

its start date. There’s its finish date. We’ve given details of its predecessor tasks. And then 

there’s a checkbox at the bottom, Show warnings and suggestion indicators for this task. I close 

the Task Inspector just by clicking on the Close button. And let me just finally talk then about 

these warnings and so on. 

When a problem is detected you have the option of showing a warning about that problem. You 

also have the option of getting Project 2016 to make suggestions about how you might fix the 

problem. Now you can enable and disable warnings and suggestions using these two options 

here. At the moment both warnings and suggestions are enabled.  

http://www.simonsezit.com/


Learn Project 2016 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 

One of the other things that I can do is to ignore a problem and say to Project 2016 okay there’s a 

problem flagged here with Fit equipment. I’m going to deal with that later on. I’m not worried 

about it. I’ve already figured out a way of dealing with it that I don’t need to tell you about it. I 

can just say Ignore problems for this task and then any warnings of course go away. If at any 

later time I want to see what problems I’m ignoring back to that same button again, Show ignore 

the problems, and I’m back to making the problem in that particular task visible again. 

So that’s an example of how to use the Task Inspector to help you to resolve a scheduling issue.  

That’s the end of this section. Please join me in the next one. 
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Video: Task Paths 

Toby: Hello again and welcome back to our course on Project 2016. 

In this section we’re going to look at another technique that can be very useful when resolving 

scheduling issues in Project 2016. And that is to use Task Paths.  

Now before I show you how to use Task Paths I should point out that I’m using what is in effect 

the default color scheme in my Gantt Chart here. And the use of Task Paths does often involve 

the identification of and differentiation between quite subtle differences of color. So if you have 

your Gantt Chart setup in a particular way and possibly an inconvenient way you may want to 

change the coloring of your Gantt Chart. Also if you have any issues with your recognition of 

color you may find Task Paths can be a little bit difficult to use. But as I say I’m using pretty 

much the default setup here. So as you follow this section you should get a good idea of whether 

the color identification requirements to use Task Paths will cause you a problem or not. 

So what are Task Paths all about? Well let’s suppose that you’re dealing with a long, fairly 

complex project with many, many tasks in it and you’re looking at a particular task and you’re 

wondering what is actually affecting that task. Let’s take Second fix plumbing here. I can look at 

the relevant column in the table and see what its immediate predecessors are, 52 and 59. But 

throughout the project which tasks are overall the predecessors of this one? Which tasks affect it 

in any way?  

Now if you go to the Format Tab in Gantt Chart Tools one of the options in the Bar Styles Group 

is a Task Path button. And if you click on the bottom of that, the dropdown. If you click on 

Predecessors to highlight predecessors it will highlight all of the predecessors of that particular 

task. Now note in this case, Second fix plumbing, one of its predecessors is actually listed after it 

in the Project Tasks. So that’s 59, Paint. But other than that its predecessors are before it in the 

list and you can see there are quite a few of them.  

The next question is which of its predecessors actually drive it? So which ones actually 

determine when it’s happening? Now again if I go back to that same Task Path button I can click 

on Driving Predecessors and that will identify the predecessors that are currently driving its 

scheduling. What we mean by that is that these are the predecessors if, if they were delayed 

would cause a delay to this task as well.  

Now noting the color of its predecessors look here at the color of its driving predecessors. And 

these are effectively a sort of red or perhaps orangey-red color. Note for example that First fix 

plumbing is actually not a driving predecessor. There is a delay. Although it is a predecessor 

there is a delay that is caused by the scheduling of other predecessors so it’s not a driving 

predecessor. 
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That means that if First fix plumbing were delayed by a certain amount it wouldn’t necessarily 

affect Second fix plumbing. Of course there is a point where a delay to First fix plumbing, 

moving it to the right by more than a certain amount would cause a delay in the Second fix 

plumbing. But we’re not at that point at the moment. 

Now having looked at its predecessors and its driving predecessors we can also look at its 

successors and the tasks that it is a driving predecessor for. And these are called its Driven 

Successors. 

So let me go back to the dropdown button. Let’s get rid of Predecessors and Driving 

Predecessors and instead let’s look at Successors. Now this is where the subtle difference in 

color becomes a little bit more difficult to detect. For example, task 61, Fit equipment, is now a 

sort of lilacy-purple sort of color. You should be able to distinguish its color in the video from 

the blue of, for example, Paint but it might be quite difficult. But what about Driven Successors? 

Which ones are directly driven by Second fix plumbing? Fit equipment is one of those. And you 

can see that color difference I think more clearly than you could with just the successors color. 

If you wanted to see all of the predecessors and successors it’s not a problem. You can switch the 

whole lot on now. 

Now note throughout this I’ve kept Second fix plumbing as the selected task. If I now clicked on 

First fix plumbing I would see its driving predecessors, its predecessors, its successors, and its 

driven successors. And in fact several of the tasks in my schedule don’t have driven successors. 

But if I click on Paint I’ll see that Paint has quite a few driven successors because many other 

tasks are basically triggered by completion of the painting work. 

Now if at any time you want to clear the highlighting associated with those four options there is a 

Remove Highlighting button at the bottom. 

And that’s it. That’s Task Paths. Please join me in the next section. 
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Video: Team Planner 

Toby: Welcome back to our course on Project 2016. In this section we’re going to look at the 

use of the Team Planner.  

Now although the Team Planner can be used with auto-scheduled or manually scheduled tasks its 

primary use is associated with manual scheduling and with manual resource assignment. It’s 

actually a very quick and straightforward way of sorting out a schedule for a project and for 

assigning resources to scheduled tasks and so on, which can be very manual but for the same 

reason can also give you pretty much total control over everything that’s happening in your 

project. 

If you’ve ever seen somebody create a schedule using Microsoft Excel, in some ways it’s quite 

similar to using Microsoft Excel. It’s not a technique that I personally use very much because I 

tend to use Microsoft Project in quite an automatic kind of way but I know many people who do 

their scheduling manually using the Team Planner and it works for them very well. 

You may have noticed that Team Planner is one of the options at the right hand end of the Status 

Bar. So let’s switch for this bathroom refit project. And there is Team Planner. Now I’m going to 

create a new task in this project and I’m going to assign it to one of the resources in order to 

demonstrate the basic features of Team Planner. But let me first of all take a little tour of what’s 

here already. 

In the lower half of the display are the unassigned tasks, the tasks that aren’t assigned to any 

members of the team at the moment. So using the scroll bars I can just take you around some of 

the many tasks that are not currently assigned to anybody. You may remember me pointing out 

to you very early on in the course that the early tasks in this project were ones I was doing 

myself and therefore I didn’t bother to assign them to me. 

In the top half you have the assigned tasks and you also have a list of resources on the left so you 

can see who each task is assigned to. Now, for instance, if we look at electrician we can see the 

electrician’s tasks over here. And that gives us a pretty good idea of what the electrician’s 

schedule is like. Similarly for our three contractors. We can see what the three contractors are 

scheduled to be doing. 

Now in fact in Team Planner View you can insert tasks and you can do many of the things that 

you can do, for example, in Gantt Chart View. But what I want to do in this particular case is I 

want to switch back to Gantt Chart View because I want to add a task in a particular place within 

the structure of my project and then I am going to schedule it and assign it using the Team 

Planner View. And the task I’m going to assign is a new electrical task. We’ve decided to have a 

sauna and we’ve got some additional sauna electrics to do. So I’m going to select task 50, do an 

Insert Task there and I’m going to put, that’s my task. And I’m going to set it as a manually 
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scheduled task. Note where it appears in the Gantt Chart by default. It’s inserted with a default of 

today’s date. 

So back into Team Planner View and if I scroll down. So there’s my task. And I’m going to 

assign it to the electrician. And I’m going to assign it to the electrician on a day that the 

electrician is already busy. So on that Friday. I’m going to drag it up onto that Friday. And you’ll 

see from the red coloring on the left that the electrician is now over-allocated. 

Now I have a number of ways that I can deal with this. If I’m going to do manual scheduling and 

manual allocation to resource I’m going to get this problem from time to time. Let me just put 

that back. Let me undo that. And let me go to the Team Planner Tools Format Tab on the 

Ribbon. And one of the options there is Prevent Overallocations. So let me select that so that it’s 

highlighted. Now let me try to drag that up to that same day and see what happens. And what in 

fact happens is that Project 2016 prevents overallocations by rescheduling First fix electrics and 

Second fix. And in fact it can do that without an overall detrimental effect on the project. So on 

this occasion that manual allocation has worked without causing an overallocation. 

Now let me just talk in broad terms about Team Planner View again.  

In effect there are four areas of this view. The area that has the scheduled and assigned tasks, this 

area, is the area where you’re looking at your schedule with the schedule tasks that have been 

assigned to resources. Below that is an area of tasks which are scheduled but which haven’t yet 

been assigned to resources. Now if I undo the last piece of scheduling that I did that Sauna 

electrics task has moved from that upper section where it was scheduled and assigned down to 

the lower section where it was scheduled but hadn’t yet been assigned. I can drag the task to one 

of two other areas. This area where it’s assigned to the electrician but it not yet scheduled. So it’s 

in the unscheduled tasks. Or down to this area. So in that lower left hand area we have a task but 

it’s not been scheduled yet and it’s not been assigned to a resource yet. So basically what you’re 

doing is moving between those four areas but aiming to finish up with everything in the top right 

hand area. 

The other thing to point out here is that at any time if you’ve got a task like this you can double 

click on it and it brings up the Task Information dialogue so you can do all the normal things like 

assign start and end dates. You could change it from manually schedule to auto-schedule if you 

wanted to. But also do things like change its priority, look at any of those advanced settings, 

etcetera. 

So that’s a brief overview of the things that you can do in Team Planner View. That’s it for this 

section. Please join me in the next one. 
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Chapter 25 – Conclusion 

Video: Additional Topics and Closing 

Toby: Hello and welcome to this final section in our course on Project 2016.  

In this section I want to briefly talk about a few very important topics that we haven’t covered in 

this course.  

And the first of those topics is the facility within Project 2016 to combine projects into a master 

project and this is often referred to as Project Consolidation. And this can be particularly 

valuable when you’re either working with other project managers on projects that are perhaps 

part of a program or in particular when you’re working with other project managers or indeed on 

other projects that you look after yourself. The way you’re required to share a pool or resources, 

so the availability of resources, the workload, overallocation issues and so on those are shared 

between many projects and not just one as they have been in this course. 

Another important area in Project 2016 is the area of customization. I showed you early on in the 

course how to customize the content of the Quick Access Toolbar and briefly talked about 

customizing the Ribbon. But you can customize many other things, some of which I did mention 

during the course such as creating your own custom views, custom tables, custom fields and so 

on. And this is a way that you can really develop the facilities within Project to suit your very 

specific requirements. 

In the course I briefly referred to the facility to export Project data to Excel to do further analysis 

and reporting. That’s another very valuable and powerful area in the use of Project 2016. And 

you also have facilities in Project 2016 for visual reporting using either Microsoft Excel or 

Microsoft Visio.  

And one very extensive part of Microsoft Project 2016 that we haven’t covered is the facility to 

write your own program code, to create your own functions and ways of processing the data 

that’s in your projects using VBA, Visual Basic for Applications. Even if you’re a little bit wary 

of programming you can pick up VBA relatively quickly and you can at least save yourself a lot 

of time and reduce the change of making errors in repetitive tasks, etcetera by learning some 

straightforward VBA programming, macro programming in Microsoft Project. 

And even in areas of Microsoft Project where we spent quite a lot of time, for example on 

Resource Information and Task Information there’s still a lot more to learn. For instance, if 

you’re dealing with costs for resources you can have not only different rates of cost for a 

resource so they can charge different rates for different types of work but you can put in change 

dates, increase dates. You can schedule a rise in a cost of a resource say at the beginning of a 

financial year. So there’s plenty more to find out about even in the areas of the course that we 

covered quite extensively. 
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So I hope that you not only enjoy using Project now but you learn more and more about it and 

become more and more proficient and able to save yourself a lot of time when you’re managing 

your projects using this very powerful tool from Microsoft. But for now that’s it from me. I hope 

you enjoy the course as much I’ve enjoyed preparing it for you and delivering it to you. And I 

hope to see you again online sometime soon. My name’s Toby. That’s it. Bye for now. 
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